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Preface

Thank you for your selection of Fuji Electric Programmable Controller MICREX-SX Series.
This User’s Manual explains the details of how to use the MICREX-SX Series Personal computer loader software package 
SX-Programmer Standard V3. After learning basic operations, use this manual to check the detailed functions.
For the basic operations, refer to <Introduction> (FEH597).
Also read the related manuals shown below.

Special Notes
1)		This product cannot read programs created by SX-Programmer Expert (D300win).
				(There is no compatibility with each other.)
2)		The PLC model names displayed in the loader screen in this manual may have been increased on the loader screen of the 		
				latest version according to addition of new models. The company name displayed in the loader screen may have also been 		
				changed according to changes in organization structure.

Notes
1. This manual may not be reproduced in whole or part in any form without prior written approval by the manufacturer. 
2. The contents of this manual (including specifications) are subject to change without prior notice. 
3. If you find any ambiguous or incorrect descriptions in this manual, please write them down (along with the manual No.  
    shown on the cover) and contact FUJI. 

* In addition to the above manuals, the following Fuji Electric Co.,Ltd.site offers various manuals and technical documents 		
		associated with MICREX-SX series.
							URL  http://www.fujielectric.com

Title Manual No. Contents
User’s Manual Instructions,  
MICREX-SX series SPH

FEH588 Explains the memory, language and system definitions of the 
MICREX-SX series SPH.

User’s Manual Hardware,  
MICREX-SX series SPH

FEH201 Explains the system configuration, hardware specifications 
and operations of modules in the MICREX-SX series SPH.

User’s Manual Instructions,  
MICREX-SX series SPB (SX-mode) Standard

FEH430 Explains the memory, language and system definitions of the 
MICREX-SX series SPB.

User’s Manual Hardware,  
MICREX-SX series SPB

FEH401 Explains the system configuration, hardware specifications 
and operations of units in the MICREX-SX series SPB.

User’s Manual Board Controller, 
MICREX-SX series

FEH423 Explains the system configuration, hardware and software 
specifications, and operations of the board controller.

User’s Manual SX-Programmer Standard V3 
<Introduction>

FEH597 Explains basic operation of SX-Programmer Standard V3.

Replacement Manual, 
MICREX-F with SX <Introduction>

FEH059 Explains the outline and procedure of replacement of 
MICREX-F series PLC with SX series PLC.

			* Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation of the U.S.A.
			* Pentium is a registered trademark or trademark of Intel Corporation of the U.S.A.



Safety Precautions

Be sure to read the “Safety Precautions” thoroughly before using the module.

Caution : Incorrect handling of the device may result in minor injury or physical damage.

Even some items indicated by “Caution” may result in a serious accident.
These safety instructions provide important information. Be sure to strictly observe them.
The items to be cared most are shown below:

 Do not use parts which are found to be damaged or distorted when unpacking the unit because use of such parts may 
cause failure or malfunction.

 Do not apply shock to the product by dropping or falling, etc. because to do so may cause damage to or failure of the 
product.

 Do not bring a floppy disk close to magnetized objects because magnetism may cause failure.
 The product CD is a CD-ROM. Never reproduce it using a audio CD player.
 Large sound volume may cause damage to the ear or audio equipment.
 Perform disk check periodically. Use of damaged floppy disk or hard disk may cause failure or malfunction of created
 data and system.
 Be sure to attach and lock certainly the connector of the loader cable because failure to do so may cause malfunction.
 Do not get dust at connectors because dust may cause malfunction or failure.
 Insert the CD-ROM, loader connector, etc. into the right direction because failure to do so may cause malfunction or 
 failure.
 Fully check safety before modifying the program during operation, performing forced output, activating or deactivating
 the equipment, or performing other operations because failure to do so may cause mis-operation resulting in damage to
 the equipment or accident.
 Do not turn off the power during loader operation (during access to hard disk or floppy disk, during communication with
 the PLC) because to do so may cause loss of data, failure or malfunction of the product, damage to the equipment, or 

accident.
 Use the equipment in a software operation environment described in the manual because failure to do so may cause
 failure or malfunction.
 Upgrade the software according to descriptions in the manual.
 When unplugging the loader cable or power cable, do not hold the cord because to do so may cause failure or 
 malfunction.
 Operate the loader in a stable place where there is no risk of dropping because failure to do so may cause accident.
 When discarding this product, handle it as industrial waste.
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Revision

* The manual No. is printed at the bottom right of the cover of this manual.

Printed on * Manual No. Revision contents

Sep. 2009 FEH598 First edition
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Section 1  Overview

1-1	 Special Notes
(1)	 There is no compatibility with SX-Programmer Expert (D300win).
Projects created by SX-Programmer Expert (D300win) can be read neither by SX-Programmer Standard (this loader) nor from 
the MICREX-SX main unit. When online connection to SX_CPU created by D300win is made, an error message appears.

System definition 
 
 
 
 
Program 

� Module registration 
� CPU memory size 
� CPU running definition 
etc. 
 
� Program 
� User FB (function block) 
� User function 

Project 

In the system definition, modules and the memory size of the CPU are registered, which are closely related to addresses 
that are used in the program. When downloading a project, the program must match the system definition. Therefore, when 
downloading a new project to the PLC, be sure to download the program and system definition at the same time and reset the 
system.

Be sure to check both.

(2)	 Cautions in creating, changing or loading a project
In the MICREX-SX series, a PLC program created by a user is called a “project.” A project consists of “system definition” and 
“program (user application)” as shown in the figure below.
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If no expansion FBs have been downloaded in the computer, the following message appears.

In this case, the program can be uploaded, however, the expansion FB has no contents. If you execute [Conversion] menu > 
[Conversion All]. an error occurs. Click [Project] menu > [Import] > [Program] to import the expansion FBs manually.
For CSV interface FB and PID FB in which a structure is used, you also need to import structure definition. Click [Project] menu 
> [Import] > [Array/Structure] to import array definition.

<Steps to follow in changing a project>

Operation Step to follow

Changing both system definition and program Download both the system definition and program, and reset the PLC system.  

Changing system definition only Download both the system definition and program, and reset the PLC system.  

Changing program only Download the program, and start the PLC system. 

Note:		Changing “no equipment” setting of a module in the module registration is also regarded as a change of system definition.

(3)	 Cautions in uploading a program that includes an expansion FB
When uploading a program that includes an expansion FB provided by Fuji Electric (FBs beginning with “_” such as _C_free and 
_MHCNTR), you need to download the expansion FBs to the computer that is used for upload in advance.
You can install the standard expansion FBs using the installation CD of Standard. Or alternatively, you can obtain the data for 
installation from Fuji Electric website (Fe Library).

If a program includes an expansion FB, the following dialog box appears. Click the [Yes] button to import the expansion FB.
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1-2	 Basic Connection Configuration
You can use a computer as a program loader for MICREX-SX Series by installing this software in it.

1-2-1	 Connecting to SPH Series

MICREX-SX SPH series

SX-Programmer

USB cable (supplied with NP4H-CVU)

2m

0.3m

Personal computer

Using commercially available printer

* Commercially available USB cable
 Can be used only with a CPU module 
 that has a USB interface.

* Power for operation of the converter is 
supplied from the personal computer.
Power consumption    5V DC: 40mA or less

Converter

Dedicated loader cable
Type: NP4H-CVU (converter + USB cable)

NP4H-CB2 (PLC connection cable)
Both of NP4H-CVU and NP4H-CB2 are necessary.
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1-2-2	 Connecting to SPB Series

MICREX-SX SPB series / Board controller

SX-Programmer 

Note: To use the SPB in SX-mode, the software version of the SPB must be V**. 10 or later.

Personal computer

Using commercially available printer

USB cable (supplied with NP4H-CVU)

2m

0.3m

* Power for operation of the converter is 
supplied from the personal computer.
Power consumption    5V DC: 40mA or less

Converter

Dedicated loader cable
Type: NP4H-CVU (converter + USB cable)

NW0H-CA3 (PLC connection cable)
Both of NP4H-CVU and NP0H-CA3 are necessary.
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1-3	 Installation
1-3-1	 Personal computer operating environment required for Standard loader

Item Specification

Personal computer IBM-AT compatible equipment

CPU Intel Pentium III 800MHz or higher (2GHz or more is recommended.)

Hard disk 200 MB or more

CD-ROM drive Required at the time of installation (quadruple speed or more is recommended.)

Memory capacity 512MB or more (1GB or more is recommend.)

Mouse At least one of USB mouse, serial mouse, bus mouse, and PS2 mouse is supported.

Keyboard 106 keyboard

Display Resolution: 1024 x 768 dots or more

Operating system (Note 1)

Any of the following Microsoft Windows  
-Microsoft Windows 2000 
-Microsoft Windows XP (32 bits) 
-Microsoft Windows Vista (32 bits) 
-Microsoft Windows 7 (32 bits): Supported by V3.0.3.34 
-Microsoft Windows 7 (64 bits): Supported by V3.0.4.10 
-Microsoft Windows 8 (64 bits): Supported by V3.0.9.10

Other software   (Note 2)

Microsoft Internet Explorer version 5.01 or later 
Microsoft.NET Framework2.0 runtime library  
Microsoft.NET Framework English Language pack 2.0 
Adobe Reader

Note 1:		Update the OS to the latest version (adjustment of Service Pack etc.)
Note 2:	 	.NET Framework is necessary to use the “failure analysis” function.
										  It is contained in the product CD-ROM.
												For Windows 8, “.NET Framework3.5” is also necessary. Download and install it from the following Microsoft website.
																https://msdn.microsoft.com/en-US/aa496123
Note 3: 	With Windows XP/Vista/7/8, users who have no administrator’s privilege can not access any folder that requires 		
												administrator’s privilege. When multiple users may use the same computer, Standard loader should be installed in a 		
												folder that can be read, written or deleted by any account other than administrator’s privilege.
Note 4:		With Windows 8, the touch monitor cannot be used. Use a mouse.
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1-3-2	 Installation
Standard loader is provided in a CD-ROM that includes the installation program. When you insert the CD-ROM into the CD-
ROM drive with the personal computer turned ON, the following screen appears automatically.

<Notes on installation>
Note 1:		If [.NET Framework2.0] has not been installed in the destination personal computer, [.NET Framework2.0] is automatically 	
												installed.
												It takes a few minutes or sometimes more than ten minutes to install [.NET Framework2.0]. 
												(The time required for installation depends on the performance of the personal computer used.)
Note 2: 	If the installation screen does not appear after inserting the CD-ROM, click the [Start] button of Windows, select [Run], 	
												enter “x:\autorun.exe” (x indicates the drive into which the CD-ROM is inserted), and then click the [OK] button. 
Note 3: 	If Standard V2 has already been installed and started, finish it before installation.

�� Click “Install the English version.”
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*	“Standard V3 (Monitor)” is a monitoring tool for maintenance people. This software cannot change a program.
			When installing StandardV3 into Windows2000 computer, execute “Windows Installer 3.1 Setup” on the screen above before 	
			installing StandardV3.

�� Click “Standard V3 Setup.”

<FYI>
“FLEX-PC(Standard V2) Setup”: 
				Software for StandardV2 (MICREX-SX series) and FLEX-PC (NB/NJ/NS series PLC, SPB N mode)
							For the details of StandardV2 loader operations, refer to the user's manual FEH590.
							For the details of FLEX-PC loader operations, refer to the user's manual FEH403.
“MICREX-F PLC Programmer Setup”: Software for MICREX-F series PLC
							For the details of loader operations, refer to the user's manual FEH147.

�� On the following screen, click “Standard V3” to start installation. Follow the direction that appears on the screen.
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1-4	 Difference between old and new versions
1-4-1	 Difference of file’s compatibility between old and new versions
This subsection explains the compatibility with the old version of standard loader (V2) 
The followings are the main points.

<Offline Project>
“Offline Project” corresponds to the project files saved in computer. 

•	The project files created by V2 can be opened by V3.
				The project files created by or saved in V3 cannot be opened by V2.
				The following lists the extensions of files.

Compressed file Non-compressed file

V2 Zpj Spj

V3 Zpj3 Spj3 (Note 1)

				Note1: If you check “Support non compressed project file” in [Options] setting, this extension is effective.

•	You can newly create a user function (FCT) in V2, however not in V3. Functions created in V2 can be opened and edited in 		
		V3. When creating a new document, substitute FBs (function blocks). 
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<Online Project>
“Online Project” corresponds to project files saved in the PLC.

•		A project created by V2 and transferred to the PLC can be read by V3.
•		A project created by V3 and transferred to the PLC cannot be read by V2. However, if the project uses a new editing function 	
			of V3, the display on V2 is as shown below.

1)		The number of condition contacts before word instructions
				The number of condition contacts that can be described in a word instruction is seven on V2 and nine on V3 at the maximum.
				If you create a circuit that has more than seven condition contacts in a word instruction by V3 and load it to the PLC, the 		
				circuit automatically becomes a returning line when read by V2.

Circuit created by V3

Read the circuit by V2

2) 	Condition contact before user FB
You can write a condition contact before a user FB in V3, however cannot in V2. If a circuit that has condition contacts before a 
user FB is read from PLC by V2, the circuit causes an error. The program (POU) including such a circuit cannot be transfered to 
the PLC by V2. Use V3.

Circuit created by V3

Read the circuit by V2
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1-4-2	 Main difference of function between old and new versions
This subsection explains the difference of the function between old and new versions of Standard loader.
The followings is the main point.

(1)	 The number of project files that can be opened at the same time
You can open multiple project files in the old version (V2), however, can open only one project file in the new version (V3). 		
When you need to open multiple files at a time, startup several pieces of loader software. 
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1-5	 Configuration of Loader Screen
1-5-1	 Screen configuration elements
This subsection explains configuration elements of the loader screen.
The the loader screen mainly consists of the main menu bar, tool bar, instruction jog bar, project view window, document window 
and each message windows.

Main menu bar

Message window

Status bar

Instruction jog bar

Document
window

Project view 
window

Tool bar

Name Function detail

Main menu bar This bar is used to perform main operations to the loader.

Tool bar Commands used frequently in the main menu are registered as icons.

Instruction jog bar This bar is used to switch the instruction group and choose an instruction for the chosen group.

Project view window This window structurally displays each constructing element of a project (system definition, program, 
and device).

Document window This window is a space to display a program and a data worksheet.

Message window
This window displays messages, for example, program information, conversion error information, 
cross reference. You can change the arrangement by using your mouse and display multiple 
windows side by side.

Status bar This bar displays messages about the type of PLC, program usage, PLC status, and other 
supplemental information depending on the situation.
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1-5-2	 Changing screen layout
You can change the layout of document window, message window and project window following the procedure below.

(1)	 Displaying a program and data monitor screen on the document window at the same time.
�� To display a program, double-click the program instance under the program folder in the project view.

				To display data monitor screen, click [Online] menu > [Data monitor] > [Data monitor]. 
				To switch the display between the program and data, click the tab that you want to display.

Tab

Program instance
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�� To display a program and data one above the other, click and hold down the left mouse button on the “Data monitor 1” tab. 		
				The “Docking indicator” appears. The screen is reversely displayed.

Click and hold down the left mouse button here.

Docking indicator

Move the mouse pointer here.

��While holding down the left mouse button, move the mouse pointer to the lower button of “Docking indicator.” The lower half 	
				of the screen is reversely displayed. (The contents of the selected tab will appear on the reversely displayed part.)
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�� Release the mouse button, and the “Data monitor 1” worksheet is displayed on the lower half of the screen. (Docking display)

* Function of each button on “Docking indicator.”

Docking at the top

Docking at the rightDocking at the left

Docking at the bottom

Release docking
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(2)	 Adjusting the layout of message windows
�� To display a message window,click [View] menu > [Message window], and then select an arbitrary message window.

				Open message windows are displayed as a list at the bottom left of the screen .

Message window list
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�� Click and hold down the left mouse button on an arbitrary item of the message list. The “Docking indicator” appears, and the 	
				screen is reversely displayed. The following procedure is the same as that of the screen layout change of the project view 		
				window.  

Click and hold down the left mouse button here.

Move the mouse pointer to this button.
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1-5-3	 Auto-slide function
The auto-slide function can be set for the project window or device monitor window. If the auto-slide function is enabled, the 
window automatically shows and hides according to the mouse pointer position.

Put the mouse pointer here 
to show the hidden window.

Move the mouse pointer 
out of the window to hide it 
automatically.
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The auto-slide function is disabled by default. To enable this function, use the push-pin icon at the top left of the window as 
described below.

When the auto-slide function is disabled, 
the push-pin icon faces to the bottom.
Click the push-pin icon.

The push-pin icon faces to the left.
The auto-slide function is enabled.
To disable, click the push-pin icon.

When the auto-slide function is enabled, 
if you move the mouse pointer out of the 
project view window and click, the window 
automatically hides.
If you move the mouse pointer on the 
project view icon, the project window 
automatically shows.
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This section explains all the functions that can be used from the main menu shown below.
•	File menu a File processing commands
•	Edit menu a Ladder editing functions
•	View menu a Program window display mode setting functions
•	Project menu a Project editing functions
•	Online menu a Online functions
•	Conversion menu a Program conversion and check functions
•	Tools menu a Utility tools functions
•	Window menu a Window display options
•	Help menu a User's manual and version information

2-1	 File Menu
The “File” menu contains the following commands:

•	New project a Opens a new project file.
•	Based on an existing project a Creates a new project based on an existing project.
•	Open a Opens an existing project file.
•	Close a Closes the open project.
•	Save a Overwrites the open project window.
•	Save As a Saves the current project with a filename.
•	Page Setup a Sets up the page format for printing.
•	Print a Prints the program and documentation information.
•	Print Preview a Displays the print preview in the screen.
•	Resent Projects a Displays the recently used project.
•	Create Short Cut a Creates a shortcut to start up the loader software and open a project file at the same time.
•	Exit a Exits the loader.
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2-1-1	 File Menu - New project
This command is used to open a new file.

�� Click [File] menu > [New project]. The following dialog box opens.
				To change the display mode, click the [Display switch] button, and then select “Large icon” or “Small icon” mode.

�� Select the type of a CPU and click the [OK] button to create a new project.

<Large icon mode>

<Small icon mode>

The “Display switch” button
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2-1-2	 File Menu - Based on an existing project
This command is used to create a new project based on an existing project. An existing project is opened as a new project file. 
(Therefore, the existing project is not affected.)

�� Click [File] menu > [Based on an existing project]. The following dialog box opens.
				On this dialog box, select a file type and a project file to open.
				When you select a file and click the [Open] button, the project opens in offline mode.

<Type of file>

Type of file (extension) Usage

V3 zipped Project (*.Zpj3) V3 zipped project file.

V3 unzipped project (*.Spj3)
V3 project file, which consists of multiple files and folders.  
When you open a file, specify this project file. 
To make this type available, perform option setting.

V2 zipped Project (*.Zpj) V2 zipped project file.

V2 unzipped project (*.Spj) V2 project file, which consists of multiple files and folders. 
When you open a file, specify this project file.

SX Template (*.Sxt) Template type for V2 project.
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2-1-3	 File Menu - Open
This command is used to open an existing project file.
	*	Only one file can be opened at the same time. To open multiple projects in a computer at the same time, start up multiple 		
			pieces of loader software and open project files in each software.

�� Click [File] menu > [Open]. The following dialog box opens.
				On this dialog box, select a file type and a project file to open.
				When you select a file and click the [Open] button, the project opens in offline mode.

<Type of file>

Type of file (extension) Usage

V3 zipped Project (*.Zpj3) V3 zipped project file.

V3 unzipped project (*.Spj3)
V3 project file, which consists of multiple files and folders.  
When you open a file, specify this project file. 
To make this type available, perform option setting.

V2 zipped Project (*.Zpj) V2 zipped project file.

V2 unzipped project (*.Spj) V2 project file, which consists of multiple files and folders. 
When you open a file, specify this project file.

MICREX-F program (*.Ldx) MICREX-F program file. 
If you select this file, Standard loader automatically converts the project to SX.

FLEX-PC program (*.Fxl) FLEX-PC program file.
If you select this file, Standard loader automatically converts the project to SX.

FUJILOG-UK program (*.Prj)

Fujilog-uk (or uK-mini) program file.
A program can be loaded from FUJILOG-uK (or uK-mini) and saved as a file using 
“FUJILOG utility” software supplied with StandardV3. 
If you select this file, Standard loader automatically converts the project to SX.

FLEX-PC (T type) program (*.Pma)

FLEX-PC (T type) program file.
A program can be loaded from a T-type CPU and saved as a file using MS-DOS version 
T-type loader or “WinFN-T” loader by SINWA Electric Corporation. 
If you select this file, Standard loader automatically converts the project to SX.
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2-1-4	 File Menu - Close
This command is used to close an opened project file.

�� Click [File] menu > [Close]. The currently opened project is closed.
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2-1-5	 File Menu - Save
This command is used to overwrite the contents of the currently open project.
When the project is newly created or loaded online, it has no project name. In this case, the “Save As” dialog box appears to 
save with a name.
(Refer to “2-1-6 File Menu - Save As.”)	



2-7

Section 2  Menu Reference

2-1-6	 File Menu - Save As
This command is used to save the currently open project with a name.

�� Click [File] menu > [Save As]. The following dialog box opens.
				Select a folder, enter a file name, and then click the [Save] button to save the project file.
Note:		The file name can be up to 32 byte characters. Symbols ‘:’, ‘.’, ‘*’, ‘?’, ‘“’, ‘<’, ‘>’, ‘|’ cannot be used for the file name.  		
									Space characters cannot be used, either.
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2-1-7	 File Menu - Page Setup
This command is used to perform all settings about printing in the page setting dialog box.

2-1-8	 File Menu - Print
This command is used to open the print menu dialog box.

2-1-9	 File Menu - Print preview
This command is used to open print preview dialog box.

* For more details of the print function, refer to Section 4.
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2-1-10	 File Menu - Recent Project
This command is used to display up to 10 projects that you have most recently used since the loader software was installed. The 
projects are listed in the order in which they were used. When you open a project on the list, the file name is listed as the latest.

�� Click [File] menu > [Recent Projects]. The recent project history is displayed as a list. Click a project from the list to open it.

�� Alternatively, you can open the recent project by clicking the drop-down list beside the “open folder” icon.
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2-1-11	 File Menu - Create Short Cut
This command is used to create a shortcut to start up the loader software and open a project file at the same time.

<Options>
•	Include the communication setting:

							Creates a shortcut file that includes information on the communication setting set in the loader.
•	Set the read-only attribute:

							Specifies the attribute of the shortcut file as “read-only.”
•	Load from PLC:

							When this option is unchecked, a project in the loader is read. When checked, a program in the PLC is read.
•	Destination:

							Select the CPU No. of the PLC. For a single CPU system, select CPU 0. For a multi-CPU system, select a destination CPU.
•	Load in Zip File:

							Reads a zip file at the same time when reading a program. A zip file includes information such as tags. You can select any 	
							of the following three options.

•	 Zip File: Reads a zip file in the PLC.
•	 Tag Project: Reads a tag project in the PLC.
•	 Project: Reads the tags that a project in the loader includes. Click the [Browse] button to select a project in the loader.

2-1-12	 File Menu - Exit
This command exits the loader software.
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2-2	 Edit Menu
The “Edit” menu contains the following commands.

•	Undo a Cancels the circuit edit operation last performed.
•	Redo a Performs the canceled operation again.
•	Cut a Moves a selected circuit to the clip board.
•	Copy a Copies a selected circuit to the clip board.
•	Paste  a Pastes the circuit of the clip board in the program.
•	Find a Searches for an address or a tag for the active program.
•	Replace a Replaces an address with another one for the active program.
•	Go to a Moves to a specified line or section number.
•	Insert Row a Inserts a row above the cursor position. 
•	Delete Row a Deletes the row on the cursor position.
•	Insert Column a Inserts a column above the cursor position.
•	Delete Column a Deletes the column on the cursor position.
•	Insert Returning a Inserts a return of a line.
•	Line Comment a Adds or modifies a line comment.
•	Instruction List a Displays the currently using mnemonics.
•	Multi operation input wizard a Used for multiple numeric data operation in ST language.
•	Split Program a Splits a program into two programs.
•	Open Device Editor a Opens the screen to edit tags of the memory devices such as M, L, X, and Y in a batch and check the 

				use status of the devices. You can also open this screen by double-clicking the “Device” icon in the project view. 			 
				For more details, refer to “Appendix 8-2 Device.”

•	Copy to ladder library a Saves a part of the program as a library.
•	Paste from ladder library a Opens and pastes a library program on the currently created program.
•	Book marks a Sets book marks on the program.
•	Grid a Sets the grid line on the simulation panel.
•	Align a Aligns multiple items on the simulation panel.
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2-2-1	 Edit Menu - Undo / Redo
(1) 	Undo
This command is used to cancel the editing operation performed last.

�� Click [Edit] menu > [Undo]. The system is restored to the status that took effect just before the last editing operation.
				Alternatively you can execute this function with the [Undo] button on the main tool bar or pressing the <Ctrl> + <Z> keys.

(2) 	Redo
This command has the opposite function of the [Undo] command in [Edit] menu.

�� Click [Edit] menu > [Redo]. The system is restored to the status that took effect just before the last editing operation.
				Alternatively you can execute this function with the [Redo] button on the main tool bar or pressing the <Ctrl> + <Y> keys.

		*	The operation history is deleted when you close the project file or change the PLC model.
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2-2-2	 Edit Menu - Cut / Copy / Paste
These commands are used to perform “cut,” “copy,” and “paste” operations in units of programs (instances) or ciurcuits.  

<“Cut” or “Copy” of a program>
�� Select a program instance in the project view, and then click [Edit] menu > [Cut] or [Copy.].

				Alternatively, you can execute “cut” or “copy” with the right-click menu or the following shortcut keys, <Ctrl> + <X> for cut and 	
				<Ctrl> + <C> for copy.

<“Paste” of a program>
�� Select a program instance in the project view, and then click [Edit] menu > [Paste].

				Alternatively, you can execute “paste” with the right-click menu or the shortcut key, <Ctrl> + <X>.

*	For more details of “Cut,” “Copy,” and “Paste” of a circuit, refer to FEH597 “2-4-2 Cutting, copying, and pasting a circuit.” 
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2-2-3	 Edit Menu - Find
(1) Find - Find / Find Output Device / Next in the Find command
These commands are used to search for a specified address or tag for the active program. 

�� Click [Edit] menu > [Find] > [Find]. 
				Alternatively, you can execute this function with the shortcut key, <Ctrl> + <F> or the “Find button” icon      . 
				The “Find Device” dialog box opens.

<Options>
•	Find what:

							Enter an address or a tag name to find. If you execute the “Find” command while selecting a contact or a coil, the 	address is 	
							automatically entered. You can search for an address by specifying the range such as “M0-M10.” 
							To search for a page by SECTION instruction, enter Nxxx (xxx = section No.)

•	Look in:
							Choose “Active Program” or “All Programs.”
										“Active Program”: Searches the currently open program.
										“All Programs”: Searches all programs.

•	Origin:
							Choose “Entire Scope” or “From Cursor. This option is enabled when “Active Program” is selected for “Look in.”
										“Entire Scope”: Searches from the top of the currently open program
										“From Cursor”: Searches from the current position.

•	Search up:
							Scrolls up from the current cursor position to search. When this option is unchecked, it scrolls down to search. 
							This option is enabled when “Active Program” is selected for “Look in.”

•	Find the overlapped device in bit/ word:
							The scope of search includes the bit/ word/double-word devices that has the specified address.
							For example, when you enter M0 (bit) in the “Find what” box, the scope of search includes WM0 (word), DM0 (double word) 
							including M0. 
							When you enter WM0 (word) in the “Find what” box, the scope of search includes M0 to MF (bit), DM0 (double word).

•	Find the area of block transfer instructions:
							The scope of search includes data with many words such as the area of block transfer instructions. 
        This option can is enabled only when word/ double word is entered in the “Find what” box.

•	Find output device:
							The scope of search is only the devices used as an output instruction (coil or forwarding destination of transfer instruction).

•	Report find result window:
							This option is enabled when “All Programs” is selected for “Look in.” When the search is complete, the “Find Result” 		
							window opens on the lower side of the screen. 
							If “Clear Previous Report” is checked, the previous search results are cleared and only the latest result is displayed.



2-15

Section 2  Menu Reference

��When the entered address is found, the line is displayed by scrolling it to the top of the program window. The “Find Device” 		
				dialog box is automatically folded and moved to outside of the project view window.

Click the [Find] button to 
search the next address.

Click this button to display the 
“Find Device” dialog box in detail.

�� [Edit] menu > [Find] > [Find Output Device] command is used to search only output devices. The same operation is performed
				when you execute [Edit] menu > [Find] > [Find] and select “Find Output Device.”

�� [Edit] menu > [Find] > [Next] command is used to search the next address after executing the “Find” command.
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(2)	 Find - Find Instruction
This command is used to search for a specified instruction.

�� Click [Edit] menu > [Find] > [Find Instruction]. 
				The “Find Instruction” dialog box opens.
				Enter an instruction in the “Find what” box or select an instruction from “Assortment” and “Instruction List,” and click the [Find] 
				button.	
				If “Clear Previous Report” is checked, the previous search results are cleared and only the latest result is displayed.

��When the search is complete,  the “Find Result” message window appears.

Double-click on the list of the find result 
to display the corresponding instruction.
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2-2-4	 Edit Menu - Replace
This command is used to replace an address.

�� Click [Edit] menu > [Replace]. The “Replace Device” dialog box opens.

<Options>
•	Find what:

							Enter an address or a tag name to replace. If you execute the “Replace” command while selecting a contact or a coil, the 		
							address is automatically entered. You can search for an address by specifying the range such as “M0-M10.”

•	Replace:
							Enter an address with which the found address is replaced. If you specify the range, only the starting address is specified 		
							here.

•	Look in:
							Choose “Active program” or “All Program.”
										“Active Program”: Searches in the currently open program.
										“All Programs”: Searches in whole program.

•	Origin:
							Choose “Entire Scope” or “From Cursor.”
										“Entire Scope”: Replaces from the top of the program in the currently open program.
										“From Cursor”: Replaces from the current cursor position.

•	Search up:
							Scrolls up from the current cursor position to replace. If this option is unchecked, it scrolls down to replace.
							This option is enabled when “Active Program” is selected for “Look in.”

•	Find the internal bit/ word address:
							When you specify a word/double-word address as a replacement device, the scope of replacement includes bit/ word 		
							devices including the word/double-word device.										        
							For example, when you enter WM0 (word) in the [Find what] dialog box, the scope of replacement includes M0 to MF.
							When you enter DM0 (double word) in the “Find what” dialog box, the scope of replacement includes M0 to M1F (bit), WM0 	
							to WM1 (word).

•	Replace with tag:
							When the address is replaced, the tag is also replaced at the same time.

•	Change NO/NC contacts:
							Switches NO and NC of the specified address. 

<Buttons>
•	Find:

							This button is used to replace with confirming the corresponding address to replace one-by-one. Click this button to search 	
							for the corresponding address to replace. Also when you do not replace the found address and move to the next, click this 	
							button.

•	Replace:
							When you click this button while the cursor is put on the found address, the replacement is executed.

•	Close:
							This button closes the dialog box.

•	Replace All:
							This button replaces the addresses in a batch. This button is enabled only when the scope of search is “Active Program.”
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2-2-5	 Edit Menu - Go to - Go to Line / Go to Section 
These commands are used to jump the cursor to a specified line or section instruction in a currently active program.

�� Click [Edit] menu > [Go to Line].
				The following dialog box opens. Enter a line number, and then click the [OK] button. The cursor jumps to the specified line.
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2-2-6	 Edit Menu - Insert Row / Delete Row, Insert Column / Delete Column
Insert Row a This command is used to insert a row in a circuit.
Delete Row a This command is used to delete a row in a circuit.
Insert Column a This command is used to insert a column in a circuit.
Delete Column a This command is used to delete a column in a circuit.

For more details, refer to FEH597 “2-4-3 Inserting and deleting a row” and “2-4-4 Inserting and deleting a column.”

2-2-7	 Edit Menu - Insert Returning
This command is used to create a returning line when 12 or more contacts are connected in series in a row.
For more details, refer to FEH597 “2-4-5 Inserting a return.”
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2-2-8	 Edit Menu - Line Comment
This command is used to put a comment on each line. 

�� Put the cursor on a line, and then click [Edit] menu > [Line Comment]. The “Line Comment Editor” dialog box opens.
				Enter a comment, and then click the [OK] button. The line comment is inserted above the cursor.
				Up to 32767 comment lines can be inserted.

*	To edit a comment line, double-click the comment line to open the “Line Comment Editor” dialog box.
		To delete a comment line, put the cursor on the comment line, and then click [Edit] menu > [Delete Row].
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2-2-9	 Edit Menu - Instruction List
This command is used to display a circuit of the cursor position in the instruction list.

�� Put the cursor on a circuit to display in the instruction list, and then click [Edit] menu > [Instruction list].
				The Instruction list for the circuit appears.

* You can edit the program in Instruction list mode.
* In Instruction list mode, instructions and operands constituting the ladder circuit are listed. The tag is not displayed.
*	To change the instruction code or operand, move the cursor and directly change it.
*	To enter an instruction, directly enter an instruction name.

�� Edit the program and click the [OK] button, or [Cancel] button to close the dialog box and return to the normal ladder display.
Note: If you change the circuit so that it cannot be displayed by Ladder, an error message appears.
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2-2-10	 Edit Menu - Multi operation input wizard
This command is used for multiple numeric data operation in ST language.
For more details, refer to Appendix 6-3-2.
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2-2-11	 Edit Menu - Copy to ladder library, Paste from ladder library 
These commands are used to save the selected circuit as a library in a file, and paste it from the file to a program.

(1) 	Copy to ladder library
This command is used to save the selected circuit as a library in a file. 

�� Select a circuit to register in the library. To select the circuit, put the cursor on the starting position (the top left) and scroll 		
				down the project window. Then, while pressing the <Shift> key, click on the ending position. The circuit selected and reversely 
				displayed. (Make sure to click on the line No. not inside the line.)

Put the cursor on the starting position.

While pressing the <Shift> key,
click on the ending position.
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�� Click [Edit] menu > [Copy to ladder library].
				The “Copy to Ladder Library” dialog box opens. Enter a file name, and then click the [Save] button.
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(2) Paste from ladder library
This command is used to open a library file and paste it in a program.

�� Put the cursor on the program, and then click [Edit] menu > [Paste from ladder library].
				The “Paste from Ladder Library” dialog box opens. Select a file name, and then click the [Open] button.

�� The circuit is pasted.
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2-2-12	 Edit Menu - Book marks
This command is used to set a book mark on a circuit of the cursor position. After setting a book mark, you can search for the 
book marked circuit or show only the book marked circuit (Ladder filter function).
The book mark is effective until the program is closed.

(1) Book marks - Toggle book mark
This command is used to set a book mark on a circuit of the cursor position. If a book mark is already set, the book mark is 
deleted.

(2) Book marks - Previous book mark / Next book mark
•	Previous book mark: 

							Moves to a book mark that is set above the cursor. If there is no book mark above the cursor, a book mark is searched from 	
							the bottom.

•	Next book mark:
							Moves to a book mark that is set below the cursor. If there is no book mark below the cursor, a book mark is searched from 	
							the top.

(3) Book marks - Clear book marks
This command is used to clear all the book marks in the active program.

(4) Book marks - Filter
This command is used to display only a book marked circuit.
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2-2-13	 Edit Menu - Grid
This command is effective only with the simulation panel and used to change Grid show/hide and set the Grid width.

<Options>
•	Show grid: 

							Check this option to show the grid . Uncheck to hide.
•	Snap to grid: 

							Check this option to adjust parts such as a switches and lamps on the simulation panel to the grid. If you move or resize 		
							parts while this option is checked, they are automatically adjusted to the grid.

•	Grid setting: 
							Set the grid size by dot.
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2-2-14	 Edit Menu - Align
This command is effective only with the simulation panel and used to align multiple parts such as switches and lamps that are 
arranged on it.

<Options>
•	Left: All selected parts are aligned to the left.
•	Center: All selected parts are aligned to the center.
•	Right: All selected parts are aligned to the right.

•	Top : All selected parts are aligned to the top.
•	Middle: All selected parts are aligned to the middle.
•	Bottom: All selected parts are aligned to the bottom.

2-2-15	 Edit Menu - Split Program
This command is used to split a program (POU) into two programs. Use this command when the size of the program exceeds 
the maximum capacity of one POU. This function is only for the ladder language.
When you execute this command on an arbitrary position in a program, the line of the cursor position and the following lines are  
cut and another program is newly created.
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2-3	 View Menu
The View menu contains the following commands:

•	Status Bar a Switches the display of the status bar ON/OFF.
•	Tool Bar a Switches the display of the tool bar ON/OFF.

•	Project View a Displays the project view window.
•	Instruction Jog a Displays the instruction jog bar.
•	Find Result a Displays the find result.
•	Cross Reference Window a Displays the cross reference window.
•	Message Window (Output/Error/Information) a Displays the message window.
•	Paste result a Displays the result of program conversion.

•	Tag Rows a Sets tag rows to display.
•	Address Rows a Sets address rows to display.
•	Monitor Data Rows a Sets monitor rows to display. 

•	Display Tag / Display Description a Switches between tag display and description display on a program

•	Default a Displays default of monitor data.
•	Integer a Displays monitor data in integer.
•	Hexadecimal a Displays monitor data in hexadecimal.

•	Display Grid Lines a Shows or hides the grid lines on a ladder circuit.

•	Program No a Shows or hides program Nos. the project view window.
•	Sort Program a Arranges the display order of the programs in the “Unassigned Programs” and the “Function Blocks.” The

				“Unassigned Programs” and the “Function Blocks” are on the project view window. The display order in “Program” is not 		
				changed.

•	Zoom a Changes the zoom setting of displayed lines.
•	Synchronize zoom rate a Changes the zoom rates of multiple ladder circuits that are simultaneously opened in synchronization. 
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2-3-1	 View Menu - Status Bar / Tool Bar 
These commands are used to show or hide the “Status Bar” and the “Tool Bar.”

�� To show or hide each item,
				click [View] > [Status bar] or
				click [View] > Tool Bar] > [Standard], [Online], [Window], [Break point], [Condition monitor], or [Sampling trace].

Tool bar

Status bar



2-31

Section 2  Menu Reference

2-3-2	 View Menu - Project View / Instruction Jog 
The Project View and the Instruction Jog are displayed by default.
These commands are used when you close the displays and want to reopen them.

�� To display each item, 
				click [View] menu > [Project View] or
				click [View] menu > [Instruction Jog].

Project View

Close button

Instruction Jog
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2-3-3	 View Menu - 
	 Find Result / Cross Reference Window / Message Window / Paste Result 
These windows are automatically opened when the operation is done such as a search or cross reference creation.
These commands are used when you close the displays and want to reopen them.

�� To display each item,
				click [View] menu > [Find Result],
				click [View] menu > [Cross Reference Window],
				click [View] menu > [Message Window” and “Output],
				click [View] menu > [Message Window” and “Error],
				click [View] menu > [Message Window” and “Information], or
				click [View] menu > [Paste Result].

(1) Find Result
This command is used to display the find result of “Find Instructions” and “Find Address” (when the scope of search is “All 
Programs”).

Double-click on the find result list to display  
the corresponding address instruction.

(2) Cross Reference Window
This command is used to display the result of the cross reference creation.

Double-click on the cross reference list to 
display the corresponding address/instruction.
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(3) Output
This command is used to display the result of the program conversion.

(4) Error
This command is used to display the error list if there is an error after program conversion.

Double-click on a row of the error list to
display the corresponding error line.

(5) Information
This command is used to display the result of the program conversion and the list of information such as the number of program 
steps and the number of timers/counters being used.
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(6) Paste result
This command is used to display the result of pasting a MICREX-F or FLEX-PC program using the conversion function.
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2-3-4	 View Menu - Tag Rows / Address Rows / Monitor Data Rows
These commands are used to change the number of rows of tags (or Descriptions), addresses, and monitor data.

�� To change the number of rows of each item, execute any of the following procedures.
				Click [View] menu > [Tag Rows] > Hide, 1 Row, 2 Rows, 3 Rows or 4 Rows.
				Click [View] menu > [Address Rows] > 1 Row, 2 Rows, 3 Rows, 4 Rows or 5 Rows.
				Click [View] menu > [Monitor Data Rows] > 1 Row, 2 Rows, or 3 Rows.

*	For a Tag (or Description), up to 8 characters can be displayed per row. The characters exceeding the specified number of 		
		rows are not displayed.

*	For Monitor data, up to 8 digits can be displayed per row.
	 To monitor data exceeding 8 digits, select 2 Rows or 3 Rows for “Monitor Data Rows.” If data exceeding 8 digits is displayed in 	
		a row, the last decimal is displayed as “~.”

<Example of one-row display>

<Example of two-row display>
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2-3-5	 View Menu - Default/ Integer/ Hexadecimal
These commands are used to change the representation of monitor data.

•	Default a 	Represents monitor data in a specified format by the operand automatically.
																			For example, multiply instructions has the following three types.
   																			 MUL: Integer format (with sign) [INT] / double-precision integer (with sign) [DINT]
   																			 MUL_UAI: Integer format (without sign) [UINT] / double-precision integer (without sign) [UDINT]
  																				 MUL_R: Integer format (double-precision floating-point format) [REAL]
																		When you use MUL or MUL_UAI, monitor data is represented in an integer number.
																		When you use MYL_R, monitor data is represented in a double-precision floating-point number.

•	Integer a 	Represents monitor data in a signed decimal number independently of the data format of the operand.

•	Hexadecimal a Represents monitor data in a hexadecimal number independently of the data format of the operand.
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2-3-6	 View Menu - Program No.
This command is used to show or hide program Nos. in the project view window.
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2-3-7	 View Menu - Sort Program
This command is used to change the display order of the programs in “Unassigned Programs” and “Function Blocks” on the 
project view window.
Since programs in “Program” relate to the execution order (they are executed from the top), the display order is not changed. 

The programs can be sorted in any of the following four orders:
•	Sort by Name in Ascending Order a Arranges alphabetically by program name in ascending order.

																								    The order is number (1,2,3...) and alphabet (a to z).
•	Sort by Name in Descending Order a Arranges alphabetically by program name in descending order.
•	Sort by Number in Ascending Order a Arranges by program No. in ascending order.
•	Sort by Number in Descending Order a Arranges by program No. in descending order.
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2-3-8	 View Menu - Zoom
This command is used to change zoom rate of the active window.

�� Click [Edit] menu > [Zoom].  The following dialog box opens. Select a zoom rate, and then click the [OK] button.

* To specify the zoom rate, select “Customize”, and then enter a zoom value in the text box. Range: 10 to 400%.
  	If you select “Auto,” the display is automatically adjusted to window size.
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2-3-9	 View Menu - Display Tag / Display Description
These commands are used to show or hide tags and descriptions on a program. The tags and descriptions cannot be displayed 
at the same time.
If you select [View] > [Tag Rows] > [Hide], neither tags nor descriptions are displayed.

2-3-10	 View Menu - Display Grid Lines
This command is used to select whether or not to display the grid lines (borders of cells) on a ladder program.

2-3-11	 View Menu - Synchronize zoom rate
When multiple ladder programs (or multiple ST ladder programs or data monitor screens) are simultaneously opened, the zoom 
rates can changed in synchronization.
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2-4	 Project Menu
The “Project” menu contains the following commands:

•	Local Device Setting a Sets a device only effective for specific programs.   
•	Model Change a Changes settings of the PLC type.
•	Security a Sets a password to protect contents and sets read only.
•	Verify a Verifies the program displayed on the PLC or loader and the project saved as a file in the computer.
•	Import a Reads the project information (such as a program, tag, line comment, system definition) saved as a file by the 		
		“Export” command. 
•	Export a Saves an open project information (such as a program, tag, line comment, system definition) as a file.
•	Cross Reference a Creates a cross reference.
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2-4-1	 Project Menu - Local Device Setting
This command is used to set a device only effective for specific programs.  

�� Click [Project] menu > [Local Device Setting]. All programs in the project are displayed. Select a program to be specified as a 	
				local device setting and click the [Edit] button.

�� The “Modify” dialog box opens. To set the range of the local device, set “Start Address” and “Data Size.”

*	The non-retain memory and retain memory can be specified as a local device. The range starting from the Start Address to the
		address determined by Local Area (the number of words) can be specified as a local device for the currently open program. Only 
		an even number can be specified for the start address and local area.
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2-4-2	 Project Menu - Model Change
This command is used to change the PLC model currently assigned to the resource of the project file.

�� Click [Project] menu > [Model Change]. The “Model Change” dialog box opens. Change the PLC model and PLC memory 		
				capacity, and then click the [OK] button.

(1) When “Initialize system definition” is unchecked
�� The model change confirmation dialog box appears. Click the [Yes] button to change the model. After model change, the 		

				system	definition screen opens. Close it, and model change is done. 

(2) When “Initialize system definition” is checked
�� The following dialog box appears.

�� Click the [Yes] button to initialize the system definition. After initialization of the system definition, the system configuration 		
				definition screen opens. Close it, and model change is done.

* If you change the model, “Memory allocation setting” is initialized.
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2-4-3	 Project Menu - Security - Protection Programs
This command is used to set a password on a specific program and protect it from being opened.
If you set protection, the password is retained in the project file until you cancel it. To open the program, the correct password is 
required. This command can protect both project files saved in computer and transferred to the PLC.
* The program cannot be opened. However, tag names can be read or written. (Except the following devices)
    T0 to T8191, TR0 to TR8191, C0 to C8191, F

<How to protect a program>
�� Click [Project] menu > [Security] > [Protection Programs]. The following dialog box opens. 					   

				Check the program to protect and click the [OK] button.

“All function” button is shown only 
when the project contains a function.

�� The password entry dialog box appears. Enter a password, and then click the [OK] button. 

* Set a password from 1 to 20 characters using hexadecimal numbers (0 to 9, A to F, case insensitive).

�� The following dialog box appears. Click the [Yes] button to set protection.
				When protection is set, the project becomes unconverted. To load the project to the PLC, execute [Conversion] > [Conversion 
				All] after setting protection.
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You can check whether the program is protected on the project view window. The protected program is shown with a key mark 
and cannot be browsed or changed.

<How to release protection>
�� Click [Project] menu > [Security] > [Release protection program]. The password entry dialog box opens. Enter the password 	

				and click the [OK] button. 

�� The protection has been released.

�� Password setting is complete.

�� The following dialog box appears. Click the [Yes] button to release the protection.
				When protection is released, the project becomes unconverted. To load the project to the PLC, execute [Conversion] > 		
				[Conversion All] after releasing the password.
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2-4-4	 Project Menu - Security - Read Only
This command is used to set a password on a specific project and protect it from being changed. (Read Only)
If you set protection, the password is retained in the project file until you cancel it. To write the password-protected project, the 
correct password is required. This command can protect both project files saved in the PC and transfered to the PLC.

<How to set Read Only>
�� Click [Project] menu > [Security] > [Set Read Only]. The following dialog box opens. Enter the password and click the [OK] 		

				button.

��When you change the program and save it as a file or transfer it to the PLC, the password entry dialog box appears. Enter 		
				the password and click the [OK] button.

* Set a password from 6 to 32 characters using hexadecimal numbers (0 to 9, A to F, case insensitive) and special characters
		(+, -, =, /).

�� The dialog box to promote conversion appears. Click the [Yes] button to set the password.
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<Release Read Only>
�� Click [Project] menu > [Security] > [Release Read Only]. The following dialog box opens. Enter the password and click the 		

				[OK] button.

�� The dialog box to promote conversion appears. Click the [Yes] button to convert the project.
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2-4-5	 Project Menu - Verify
This command is used to compare the currently open project with the project file saved in the PC.

�� Click [Project] menu > [Verify]. The following dialog box opens. Click the [Browse] button, select a project file, and then click 	
				the [OK] button. After returning to the "Verify" dialog box, click the [Verify] button.
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�� Verification result is displayed.

Verification result 
White			: Common
Orange	: Modified
Gray					: Not exist
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Explanation of Icon 

System Definition
Program
Common
Modify
Filter character string
Filter
Update the latest status

Icon Explanation

System Definition Used to show/hide System definition in the "Data Type" column.

Programs Used to show/hide Circuit in the "Data Type" column.

Common Used to show/hide Common in the "State" column.

Modify Used to show/hide Modified in the "State" column.

Filter line strings Used to enter a filter keyword.

Filter Enter a filter keyword, and then click this button to filter the list. Only the items that 
includes the entered keyword are shown. Click this button again to cancel the filter.

Update the latest status Used to verify one more time
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�� Double-click a row displaying “Circuit” to display the mismatched line.

1) [Vertical disposition] button

3) [Scroll Synchronization] button

4) [Select Mismatch] bar

*	This screen is only for confirmation of mismatched lines (only display). They cannot be edited here.
		Mismatched lines are displayed in light orange.
		In a mismatched line, a mismatched spot is indicated in dark orange in units of addresses or instructions.		

2) [Open Editor] button
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1) [Vertical disposition] button
Click this button to show the verification source project and destination file side by side vertically.
When you click the button again, the projects are shown one above the other horizontally.

2)		[Open Editor] button
Click this button to open the program in the verification source project.

3)		[Scroll Synchronization] button
When this button is turned ON, you can scroll both source and destination program windows together.
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4)		[Select Mismatch] bar
When there are multiple mismatches, double-click the orange part of the bar to display the mismatch spot.
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2-4-6	 Project Menu - Import
This command is used to import the followings created in another project to the currently open project.
(1) Program, (2) System Definition, (3)Tag Project, (4) Tag, (5) Line Comment, (6) Initial Value, (7) Array/ Structure, 
(8) Simulation (9) Instruction List
*	(9) Instruction List is dedicated to FLEX-PC (T type) users and used for data linkage with CAD manufactured by SINWA 		
		Electric Corporation. 

(1) 	Program
•	Programs, function blocks and functions registered in another project file are imported. 
•	When a function block (or a function) is called in the program, it is also automatically imported. When the "Program Protection" 

				is set in the program or function block (or function), it cannot be imported.
•	If the import destination has the same program name as the import source, it is overwritten. If program types (program /		
		function / function block) are different, the import is not done.
•	If the import source and destination have the same program No., an unused program No. is assigned to import the program. 	
		However, if there is no unused program No., the import is not done.

�� Click [Project] menu > [Import] > [Program]. The following dialog box opens. Click the [Browse] button.
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�� Select an import source file and click the [Open] button.

�� Select an import source file and click the [Import] button.

*	When importing FBs starting with "_" that are offered by Fuji Electric (e.g. _Cfrp2.Zpj) including standard expansion FBs, make 	
		sure to click the [Check The Hierarchy Under] button to select and import all the items.
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�� The confirmation dialog box appears. Click the [OK] button to start the import.
•	When there is no program to be overwritten

•	When there is a program to be overwritten

�� The following dialog box appears when the import is complete. 
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(2) 	System Definition
•	System definition registered in another project file is imported. The system definition of the currently open program is 		
		overwritten.
•	If the import source and import destination have a different CPU, the memory allocation setting is initialized.

�� Click [Project] menu > [Import] > [System Definition]. The following dialog opens. Select an import source file, and click the 		
				[Open] button.

�� The confirmation dialog box appears. Click the [Yes] button to start the import.

��When the import is complete, the system definition is displayed. Confirm the contents, and then close the system definition.
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(3)	 Tag project
Tag project file is imported to the currently open project.

�� Click [Project] menu > [Import] > [Tag project]. The following dialog box opens. Select an import source file (*.Tpj), and click 		
				the [Open] button.
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(4) 	Tag
•	A tag file (*.csv or *.txt) exported from another project file is read and added to the currently open project. If a tag has been 		
		already registered in an address, it is overwritten by the read tag.

�� Click [Project] menu > [Import] > [Tag]. The “Import Tag” dialog box opens.

1) 	Set a tag file name to import. Click the [Browse] button and select a tag file.

2) Select a target program.
•	All tags: Global devices (M, L, X, Y, SM) of all programs are imported.
•	Selected tag: Programs can be individually selected. Only one program can be selected.

				If you select <Common>, global devices (M, L, X, Y, SM) of all programs are imported.
				If you select a specific program, local devices (T, C) of that program are imported.

�� Select items to import, and then click the [Import] button. When the import is complete, the following dialog box appears.

1) 2)
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(5) 	Line Comment
•	This command is used to edit all created line comments in a batch. (for example, when replacing line comments in Japanese 	
		to in English). Export the line comment file (*.TXT, *.csv) from a project file, edit it in the text editor, and import it to the project.

�� Click [Project] menu > [Import] > [Line Comment]. The following dialog box opens. Click the [Browse] button.

��When the import is complete, the following dialog appears.
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(6) Initial Value
•	An Initial value file (*.CSV) exported from another project file is read and added to the currently open project. If an initial value 	
		has already been registered in an address, it is overwritten by the read initial value.

�� Click [Project] menu > [Import] > [Initial]. The following dialog box opens. Select an import source file and click the [Open] 		
				button.

��When the import is complete, the following dialog box appears.
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(7) 	Array / Structure
Array/Structure definition in another project is imported.
For more details, refer to Appendix 4-5.
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(8)	 Simulation
•	Contents of a simulation folder registered in another project file (simulation panel, AFB) are imported. Only StandardV3 files 	
		can be selected. If there is a folder that has the same name in the import destination, the name is automatically changed and 	
		the import is done.

�� Click [Project] menu > [Import] > [Simulation]. The following dialog box appears. Click the [Browse] button and select an 		
				import file.
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�� Files in the simulation folder of the import source are listed. Check items to import and then click the [Import] button.

��When the import is complete, the following dialog box appears.
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2-4-7	 Project Menu - Export
This command is used to export the followings from the currently open project.
(1) Tag Project, (2) Tag, (3) Line Comment, (4) Initial Value, (5) Cross Reference, (6) Device Information, (7) Ladder Data,
(8) Instruction List
*	(8) Instruction List is dedicated to FLEX-PC (T type) users and used for data linkage with CAD manufactured by SINWA 		
		Electric Corporation. 

(1) 	Tag Project
Tag and line comment data are exported in the text format (tag in csv file). Exported data can be edited by a text editor or excel.

�� Click [Project] menu > [Export] > [Tag Project].  The following dialog box opens. Enter a tag project name, and then click the 	
				[Save] button.

Folder

Tag projet name.tpj

Tag project name.files

TAGFILE.CSV

LCOMMENT.TXT

Program name.CSV

Program

Program name

..Common (Global) Tag file

..Program (Local) Tag file

..Line comment file

Tag and Line comment files are created as shown below.
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(2) 	Tag
•	Tag information is exported as a tag file (*.CSV or *.txt) from the currently open project file.

�� Click [Project] > [Export] > [Tag]. The following dialog box opens.

1) Select a program to export
•	All tags: Global devices (M, L, X, Y, SM) of all programs, and local devices (T,C) of each program are exported.
•	Selected tag: Programs can be individually selected. Only one program can be selected.

				If you select <Common>, global devices (M, L, X, Y, SM) of all programs are exported.
				If you select a specific program, local devices (T, C) of that program are exported.

2) Set a tag file name. Click the [Browse] button, select a storage folder, and enter a file name.

3) Select target devices.
•	All address: All devices with a tag are exported.
•	Input/Output address: X and Y devices with a tag are exported.

  			Export unassigned address: All the X and Y devices that are defined by system definition are exported.
•	Memory address: Devices with a tag except X and Y devices are exported.

�� Select items to export, and then click the [Export] button. When the export is complete, the following dialog box appears.

1) 2)

3)



2-67

Section 2  Menu Reference

(3) 	Line Comment
•	This command is used to edit all created line comments in a batch. (for example, when replacing line comments in Japanese 	
		to in English). Export the line comment file (*.TXT, *.csv) from a project file, edit it in the text editor, and import it to a project.

 Click [Project] menu > [Export] > [Line Comment]. The following dialog box opens. Enter a file name, and then click the [Save] 
				button.

��When the export is complete, the following dialog box appears.
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(4) 	Initial Value 
•	Initial value information is exported as an initial value file (*.CSV) from the currently open project file.

�� Click [Project] menu > [Export] > [Initial Value]. The following dialog box appears. Enter a file name, and then click the [Save] 	
				button.

��When the export is complete, the following dialog box appears.
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(5) 	Cross Reference
•	Cross reference information is exported as a cross reference file (*.CSV) from the currently open project file.

�� Click [Project] menu > [Export] > [Cross reference]. When a cross reference is not created completely, the following dialog 		
				appears. Click the [Yes] button.

�� The following dialog box opens. Select a folder to save a cross reference file, enter a file name, and then click the [Save] 		
				button.

��When the export is complete, the following dialog box appears.
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(6)	 Device Information
Device information of the currently open project is saved as a file.
This information is used for:
1) Device information for POD (UG/MONITOUCH series) to share devices with Standard loader.
				* For the POD operations, refer to the manual of POD.
2) Device information for Communication middleware.
Note:		This device information file can be used in the UG series loader (Type: UG00S-CW) version 3.2.2.1 or later.

�� Click [Project] > [Export] > [Device Information]. Enter a file name, and then lick the [Save] button.

Folder 
Project name.ini 

Project name 

CONFIG 
CONFIG.ini 

Res.lst 

C 

Configuration 
ioarea.ini 
sysdef.def ioarea.ini 

*.bdf 
*.def 

dataarea.ini 
ocires.ini 
Global_Variables.vb 
Sysdef*.bdf 

RES 

Configuration 

R 

Resource 

dataarea.ini 
PATHID.TXT 
*.lst 
*.bdf 

Resource 

Communication middleware 
device information 

POD device information

PPEAREA.INI 
tyllist.typ 

�� Device information files are created. Device information consists of multiple folders and files as shown below.
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(7) 	Ladder Data
Ladder data information used for POD (UG/MONITOUCH series) ladder monitor function is exported as a file.

�� Click [Project] menu > [Export] > [Ladder Data]. The following dialog box opens. Enter a file name, check a program name to 	
				export, and then click the [Export] button. 

�� Ladder data file are created. Ladder data consist of multiple folders and files as shown below.

Folder

Ladder

RasMsg

SysDef

LD<Program name>.GRD

LD<Program name>.GRD
TB_GLOBAL.TBL
TB_<Program name>.TBL

TB_<Program name>.TBL
TB_IOMAP.TBL
TG_GLOBAL.CSV
TG<Program name>.CSV

TG<Program name>.CSV
CMT.TXT
SYSDEF11.DEF
FU_APL.DEF
FU_SFB.DEF
FU_UFB.DEF
FU_UFC.DEF

SYSDEF01.DEF
CLOG081.CSV

Country number

Program type Monitor (Export) Yes/No

Standard FB No

Password protected program No

ST program No

AFB No

Other programs Yes

When the export is complete,
the following dialog box appears.
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Double-click this cell to sort.

						[Filter] button: Click this button to display the following dialog box. Check items to filter, and enter an address to display with 	
						filtering or select an item. And then, click the [OK] button. Only the items meeting the conditions are displayed. 

Double-click an arbitrary row to display the corresponding line

						[Update] button: Click this button to update the cross reference display.

						[Trace Back] button: When multiple rows in the cross reference are double-clicked, the corresponding circuits are displayed 	
						in order. Use this button to return to the previously selected row.

						[Trace Forward] button: This button has the opposite function of the [Trace Back] button.

2-4-8	 Project Menu - Cross Reference
This command is used to create a cross reference of the currently open project.
A cross reference shows the addresses used in the program, tag names corresponding to them, types of read and write, 
instruction words, program names, and line Nos.

�� Click [Project] Menu > [Cross Reference] > [Create Cross Reference]. The Cross Reference window opens. 
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2-5	 Online Menu
The “Online” menu contains the following commands.

•	Communication Setting a Makes communication setting with the PLC.
•	Simulation Mode a Performs offline simulation of the PLC.
•	PLC Operation (Run/Stop, Load) a Performs various kinds of operations to the PLC.
•	Monitor a Performs online monitoring of the PLC.
•	Load the changed program into PLC a Used when you edit circuits during online operation
•	Data Modify a Changes device memories.
•	Break Point a Makes a break point setting.
•	Condition Monitor a Makes a condition monitor setting.
•	Sampling Trace a Makes a sampling trace setting.
•	Program Operation a Enables or disables the programs loaded to PLC
•	Task Execution Time Measurement a Measures time of task execution.
•	Data Monitor a Performs the device monitoring.

The following three commands have been removed in the version V3.0.6.24 because they may cause a fault depending on the 
usage.

•	Read Data a Reads a device condition saved as a file in the computer to a loader.
•	Save Data a Saves a device condition on a loader as a file in the computer.
•	Load Data to PLC a Transfers the device condition saved as file in the computer to PLC. 

<Description>
Only the device memories whose data are being monitored are read from the memory of the PLC by the "Save Data" command.
Device memories that are not being monitored are saved as zero.
If the data saved here is written to the PLC by the "Load Data to PLC" command, zero is written to the memory area that is not 
being monitored. Depending on how the system is operating, your important data may be deleted. For this reason, the above 
commands have been removed in the version V3.0.6.24.
When you want to save data, alternatively use the SX control utility function described in Appendix 1.
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2-5-1	 Online Menu - Communication Setting
This command is used to make communication settings with the PLC.

(1) Direct communication with connected PLC
�� Click [Online] menu > [Local Device Setting]. The "Communication Setting" dialog box opens. Click the [Setting] button.

�� The [setting] dialog box opens. Select a type of the communication port.

 			 * SPB supports only "COM port."
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<In the case of COM port>
Select "COM port" to connect to a CPU loader port using a dedicated cable by Fuji Electric or to connect via a general purpose 
communication module.
Set the port number of the loader according to the port number of the computer.

When connecting to a loader port, you do not need to 
change the above settings.

<In the case of USB>
Select "USB" to connect to a USB port built-in the CPU.
When you install a loader software and use the online tool with a USB for the first time, the requirement screen of the USB driver 
appears.
The USB river (ScUsb.inf) is stored in “/Driver/MICREXSX”, in the Install folder of the loader software.
For more details of USB driver installation, refer to "Appendix 9 USB Driver Installation."

* Dedicated cable:
		For SPH:
 		  Combination of NP4H-CVU and NP4H-CB2 (USB connection) or
		  Combination of NW0H-CNV and NP4H-CB2 (RS-232C connection)
		For SPB:
 		  Combination of NP4H-CVU and NW0H-CA3 (USB connection) or
		  Combination of NW0H-CNV and NW0H-CA3 (RS-232C connection)



2-76

Section 2  Menu Reference

<In the case of Ethernet>
Select "Ethernet" to connect to the Ethernet port built-in the CPU or connect via an Ethernet module. 
Set the IP address and port number of the connection partner.
The default settings are as follows. Partner IP address: 192.168.0.1, Partner port No.: 507.
The order is “Target IP address”, a space, and “Target port No.”
				Example: 192.168.0.1 507 (Integer value)

<In the case of Modem>
Select "Modem" to connect via a modem. Install the modem driver to be used first. Then select it from the list and enter the 
telephone number to connect.
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Parameter setting of the communication board differs according to the board type as show below. 
1)		SX bus board
				There is no parameter.
2)		PCI bus P-link board
				“Communication partner point P station No.”
				Example: 15 (decimal notation)
3)		PCI bus PE-link board
				“Communication partner point PE station No.”, “Own No.”
				Example: 63 0 (decimal notation)
4)		ISA bus PLC board
				There is no parameter.
5)		PCI bus PLC board
				There is no parameter.
6)		PCI bus FL-net board
				“Partner IP address”, space, “Own IP address”
				Example: 192.168.250.5 192.168.250.1 (decimal notation)
7)		FL-net board (LAN board)
				“Partner IP address”, “Own IP address”, “A = IP address”, “B = IP address”
					(Enter a space between each address.)
				Example: 192.168.250.5 192.168.250.1 A=192.168.250.1 B=192.168.250.2 (decimal notation)
				*	Parameters other than “Partner IP address”, “Own IP address” can be omitted.
				*	The allowable ranges of the node number (host address) in the “Own IP address” is 1 to 64.
				*	Be sure to make “Own IP address” agree with the IP address in the LAN board.
				Note:	The LAN board is only supported by NP1L-FL1. NP1L-FL2 and FL3 do not support the LAN board. 
												To connect to NP1L-FL2/FL3, use an FL-net board.

��When the setting is done, click the [OK] button to return to the previous screen. Click the [OK] button to close the 			 
				"Communication setting" dialog box.

<In the case of communication board>
Select "communication board" to connect via a board that supports the extended slot of the computer.
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(2) 	Loader network communication
<Overview>
In a link system using the P/PE-link module, FL-net module, Ethernet interface module, and general-purpose communication 
module (RS-485) of MICREX-SX series, you can perform remote operations (e.g. program download/upload, monitor, test 
functions) from the loader connected with one CPU module to the CPU modules in 3-layer SPH system.
You can also perform remote operations from the loader connected with another CPU module. The maximum number of remote 
operation routes is two (at the time of simultaneous operation).
In addition, in a simplified CPU link using a communication adapter (RS-485) of SPB series, you can perform remote operations 
from the loader connected to the basic unit with station No. 0 to another basic unit.  (one layer and one route only)
*	A loader network using the simplified CPU link is supported by all types and all versions of basic units/communication adapters.

<Applicable versions>
To perform remote operations with a 3-layer 2-route loader network, use a communication module with the following software 
version.

* Setting of “(1) Direct communication with connected PLC” is necessary even when using loader network communication.
		The loader network communication setting is explained below.	

Module Version

CPU module

SPH300 Software version V38 or later

SPH2000/3000 All versions

SPH200 Software version V37 or later

Communication
module

P-link module Software version V33 or later

PE-link module Software version V33 or later

FL-net module Software version V30 or later

Ethernet module Software version V30 or later

General-purpose communication 
module (RS-485) Software version V30 or later
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<Loader network setting>
�� Click [Online] menu > [Communication Setting]. The "Communication Setting" dialog box opens. Click the [Setting] button.

�� The "Setting" dialog box opens. Select a module type to be used,  local SX bus station No. (or CPU No.) and SX bus station 	
				No. (or address) of the connection partner, and then click the [OK] button.

�� The following dialog box appears. Click the [OK] button.



2-80

Section 2  Menu Reference

�� The first level setting of the loader network is now complete.
				To access the next level CPU, click the [Setting] button and perform communication settings.



2-81

Section 2  Menu Reference

The buttons of loader network setting

4)

2)

3)

1)
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1) [Communication test]: Performs communication test in the set loader network. 

•	When the communication is established successfully, the following dialog box appears.

•	When the communication fails, the dialog box shows the route where the communication fails, as shown below.
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2) [Enhanced setting]: Makes settings of the time out interval of loader network communication and communication data size.

3) 	[Registration]: Registers the setting of loader network communication with a name.

4) [Load/ Delete]: Loads or deletes the setting of the registered loader network communication.

Set the time out and data size according to the network type to be used. Confirm your network type, and set the following 
values. You usually do not need to pay attention since the loader automatically sets the optimum values when the network is set.

Network Timeout (ms) Data size (byte)

P-link 11,000 200

PE-link 11,000 200

Ethernet 11,000 492

RS485 11,000 492

FL-net 11,000 492

LE-net 11,000 104

Simplified CPU link 11,000 492
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2-5-2	 Online menu - Simulation mode
This command sis used to simulate PLC operation in offline mode.  For more details, refer to Appendix 3.
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2-5-3	 Online menu - PLC Operation (Run/Stop, Load)
This command is used to perform various PLC operations such as Run/Stop PLC, Write/Read Program, and failure diagnosis.

2-5-3-1	PLC operation buttons
The followings explains the functions of the buttons.

(1) 	Batch operation / Individual operation
•	Batch operation:	All the CPUs in an SX-bus system (in the same configuration) are controlled.  

																						  Check this option to control all the CPUs in a multi CPU system in a batch. [Run], [Initial Run], [Stop], and 		
																						  [Reset] commands are effective.

•	Individual operation: One CPU to which the loader is connected is controlled. All the commands are effective.

(2) 	Stop
This button is used to stop the working CPU. This function is available only when the CPU key SW is set at TERM.

(3)	 Run
This button is used to start a stopping CPU. This function is available only when the CPU key SW is set at TERM.
A CPU in fatal fault cannot be started by this button. The non-retain memory is cleared at start-up.

(4)	 Initial Run
This button is used to initial-start a stopping CPU. This function is available only when the CPU key SW is set at TERM. A CPU 
in fatal fault cannot be started by this button.
The difference from "Run" is that not only the non-retain memory but also the retain memory is cleared at start-up. The retain 
memory is not cleared in normal use. Therefore, this button is disabled by default to avoid using it by mistake. To use this 
function, click [Tool] menu > [Option]. On the "Options" dialog box, select "Online, and then check "Permit the use of Initial Run." 

(5)	 Reset
This button is used to reset the CPU. The CPU needs to be reset (or switched ON/OFF) when you create a new program and 
download it to the PLC, or edit system definition and download programs to the PLC. This command is available only when CPU 
key SW is set at TERM.
*In a redundant system or a multi CPU system, do not perform reset operation when CPU 0 is disconnected.

PLC operation button

Failure diagnosis button
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(6) Load to PLC
This button is used to transfer the contents of the currently open project to the PLC. Be sure to execute conversion before the 
transfer.

The "Load to PLC" dialog box consists of the following options. Use the default settings normally. However, to use "Tag Project," 
"FB Parameter data," and "Module driver," the conditions explained below need to be satisfied.
•	Program:

						Programs in the project view window. Unassigned programs are not loaded.
•	Clear retain memory area:

						The retain memory in the CPU is cleared. Normally, do not select this.
•	Clear FB/SFB variable:

						Variables held in FB (function block) and SFB (system FB such as a counter FB, or Integral timer FB) are cleared. Normally, 	
						do not select this.
						In SPH200, this option is disabled since the FB/SFB variables are forcibly cleared by the PLC when the program is loaded 	
						to the PLC.
•	System definition:

						System definition in the project view window
•	Zip file:

						Zipped program name / Tag / Line comment / System configuration are transferred.
									Program name: Program name shown in the project view window
									Tag: Device tag
									Line comment: Line comment in a program
									System configuration: Module name defined in system definition
•	Tag project:

						A tag project is loaded to the user ROM in the PLC. (Enabled when a user ROM is attached to the CPU.)
•	FB parameter data:

						This option is enabled when a PID FB is used.
•	Module driver: 

						This option is enabled when an Ethernet / ADS-net / PC card / LON WORKS module is used.
				*	When you connect the loader to a general-purpose module (NP1L-RS*) and perform the download via it, the module driver 	
						cannot be loaded. (A general-purpose module does not support the download of a module driver.)
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(7) 	Load from PLC
This button is used to read the contents of the PLC.

The "Load from PLC" dialog box consists of the following options. Use the default settings normally.
•	Load in ZIP File: 

						A ZIP file (Program names, tag names, line comments, and system constructions) is read.
										Zip file: Check this option to read a zip file from the PLC.
										Tag project: Check this option to read a tag project file saved in the user ROM attached to the CPU. (Enabled when a 		
										user ROM is attached to the CPU and a tag project is saved in it.)
										Project: Check this option to read a zip file stored in a project file (*.Zpj3) saved in the computer.
•	Reflect Real Structure: 

						Uncheck this option to read a program from a working system.
						For example, when you purchase a new CPU and have not loaded system definition yet, or when you have executed 		
						memory	clear, no system definition exists in the CPU. If a CPU without system definition is started, the CPU automatically 		
						recognizes the modules connected to the SX bus system and creates system definition. To read the contents of the PLC in 	
						such a condition, check this option.
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(8) 	Verify with PLC
This button is used to compare the currently open project with the contents of the PLC.
"Tag project" is enabled when a user ROM is attached to the CPU.

�� The verification result is displayed.

The verification result is classified by color.
			White: Common
			Orange: Modified
			Gray: Not exist

For more details of verification, refer to "2-4-5 Project Menu - Verify."
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(9) 	Clear
This button is used to clear the contents of the PLC.

Select the items you want to clear.
To clear all the contents of the PLC, check "Resource initialization." Even if a password or read only is set, the contents can be 
cleared.
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(10)	 User ROM
This button has the following three functions: Verify, Security, and Export user ROM File to Text File.
This button is enabled when a user ROM is attached to the PLC.

(10) -1		Verify
This command is used to compare the currently open project with the contents of the user ROM attached to the PLC.

�� The verification result is displayed.

The verification result is classified by color.
			White: Common
			Orange: Modified
			Gray: Not exist

For more details of verification, refer to "2-4-5 Project Menu - Verify."
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(10) -2 	Security
This command makes the user ROM attached to the PLC read-only.

For more details of read only setting, refer to "2-7-1 Tools Menu - User ROM Utility."
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(10) -3			Export user ROM File to Text File
The contents of the file (data) written into the user ROM attached to the PLC by F_WRITE FB are outputted as a text.

�� Attach a user ROM card to the CPU module and establish access to the user ROM (UROM_LED lights up). 
				In the following dialog box, set the items below. 
						"User File": Enter the file name in the user ROM.
						"Text File": Click the [Browse] button and specify the folder to save and the storage file name.
				Then, click the [Export] button.
* Up to 20 histories regarding the export source and exported files are stored.

��When outputting a text file is complete, the following dialog box appears. To check the content of the text file, click the [Yes] 		
				button.

<Text file format to output>
The file format to output is shown below. Use your text editor to show it.
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(11) 	Password
This button is used to set a password.
The password has the following two functions.
1)		To set a program as read only
2)		To set access level, and limit each operation (Run/Stop, Load, Edit working program) depending on the set access level. 
For more details, refer to the "Appendix 5."
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(11) 	Calendar
This button is used to show the calendar build-in PLC and make settings of it. 

When you open the "Calendar" dialog box, the current date and time of the PLC is displayed.
Click on the part of "year/month/day/hour/minute/second," the display is inverted. Enter a value or click the up and down button 
on the right to select a value, and then click the [Set] button. The date and time is set in the PLC.
Click the [Synchronizes with PC] button to set the date and time in synchronization with your computer.

Even if the PLC is disconnected, this date and time is retained and updated by the PLC battery. 
The setting range is 1970/01/01 00:00:00 to 2069/12/31 23:59:59.
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(13) 	Redundancy Control
This button is used to replace a CPU to be connected and switch between a working CPU and a standby CPU in a redundant 
system.

(14) 	Execution time
This button is used to measure the execution time and execution cycle of a program. For more details, refer to "2-5-11 Task 
execution time measurement."
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2-5-3-2	Failure Diagnosis button
When you click this button, the "Failure diagnosis" dialog box opens. The failure diagnosis function displays the failure status of 
the PLC.



2-97

Section 2  Menu Reference

•	System configuration display section a Displays the system configuration in a tree form. A mark is displayed on the icon at 		
		failure positions. (Fatal fault: , Nonfatal fault: , Fatal and nonfatal faults: 
•	Diagnostic information display section a Displays the system RAS and detailed RAS as text data.
•	Configuration display selection a Choose “Bus connection composition” or “User definition composition.” The default setting 	
		is “User definition composition.”
•	History information selection a Choose “Current RAS”, “1 previous generation”, “2 previous generations”, or “3 previous 		
		generations.” The default setting is “Current RAS.”
•	[File save] a Saves the RAS information file.
•	[File view] a Displays the RAS information file.
•	[File delete] a Deletes the RAS information file.
•	[Check configuration]

				a Checks whether the module configuration registered in the system definition matches the actual configuration and 		
								indicates the mismatch items.

•	[Failure analysis]	 a Analyzes the status of the PLC system and displays error description, location and remedies.
•	[Close] a Closes the Failure diagnosis dialog box.
•	[Help] a Displays Help of the failure diagnostic function.

Configuration display selection History information selection 

System configuration display Diagnostic information display 
(System RAS, detailed RAS) 

RAS information file operation 
[Check configuration] button 

[Failure analysis] button 

Performs a text search in the [Contents] box.

(1) 	Display overview
The "Failure diagnosis" dialog box consists of the system configuration display section and the diagnostic information display 
section.
The system configuration display section shows in which module a failure occurred in visual form.
The diagnostic information display section shows failure information in detail.
The display contents are refreshed (updated) automatically at fixed intervals.
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(2) System configuration display section
The system configuration display section has the following two modes, selectable from the "Configuration" combobox.

1) 	User definition composition
System configuration information that is set in the system definition and then loaded to the PLC by the user is displayed in a tree 
form.
Data is displayed by loading the system configuration information from the CPU.

2) 	SX Bus connection composition
Actual configuration of modules connected to the SX bus is loaded from the CPU and displayed in a tree form.
Only modules directly connected to the SX bus are displayed in order of the SX bus station number.
For the CPU and processor link module, the SX station number and the CPU number are displayed.

<Display specifications>
•	If a system fault is detected, a mark corresponding to the degree of the fault is displayed on the icon.  
		(Example: Fatal fault: , Nonfatal fault: , Fatal and nonfatal faults: )
•	Icon display for modules is the same as that for the system definition.
•	“Base board” and “Power supply” are not displayed.
•	The default setting of the configuration display selection is “User definition composition.” If “User definition composition” does 	
		not exist (if the system definition has not yet been downloaded), “SX bus connection composition” is displayed.
•	At the time of initial display, the CPU module (CPU number: 00) is selected.
•	If communication is disconnected during RAS information display, a blank is displayed.

Configuration display selection

System configuration display
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(3)	 Diagnostic information display section
The failure diagnostic display section displays detailed fault information for the module selected in the system configuration 
display section.

<Display specifications>
•	The display contents are grouped by tabs. The items of each tab depends on the selected module.
•	The starting tab is “System RAS,” which displays the system RAS information in the CPU module (CPU number: 00) at the 		
		time of initial display.
•	The tabs are displayed in one or two rows depending on the module.
•	If communication is disconnected during RAS information display, a message saying “Communication error” appears.
•	“Current RAS”, “1 previous generations”, “2 previous generations”, or “3 previous generations” is selected depending on the 	
		RAS history. The default setting is “Current RAS.”

<	History display>
•	When the previous RAS (“1 previous generation”, “2 previous generations”, or “3 previous generations”) is selected as RAS 		
		history, the fault history data is loaded from the CPU and then displayed.
•	If there is no history data (all 0s), the following display results.

						<Message data display items>
												RAS with “message + value”: Same display as the case where there is history data.
												RAS with “message only”: “No data” is displayed.
						<Binary data display items>
												Displays all 0s.

<Search function>
•	The text search combobox and the search start button are provided at the bottom of the diagnostic information display 		
		section, allowing text search for the contents currently displayed in the diagnostic information display section.
•	The search start position is the row at the current cursor position in the diagnostic information display section. When the  		
		cursor is not displayed, it is the top position.
•	The search direction is Downward only. The cursor move to the row containing a matched character string.
•	Each item name of the selected tab is automatically inserted in the “Text Retrieval” list box, making it easier to jump to each 		
		item.
•	When search character strings are entered, up to five search character strings are memorized, allowing you to perform 		
		search again using a previously used search character string even after activation of failure diagnosis next time. When the 		
		number of search character strings exceeds five, the oldest one is deleted.

History information selection 

Diagnostic information display 
(System RAS, detailed RAS) 
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(4)	 RAS information file operation
The information in the Failure diagnosis dialog can be saved in a disk file. The RAS information file can be displayed and 
deleted. Each operation can be performed using each file operation button in the Failure diagnosis dialog box.

1)		File save
This button is used to save the data displayed in the Failure diagnosis dialog in a file.

�� Click the [File save] button on the "Failure diagnosis" dialog box. The "Save RAS File" dialog box opens.
�� Specify the target location and each item and then click the [Save] button. The data are saved in the specified file.

<Preservation item>
Specify the data to be saved using “System configuration information”, “Diagnosis details”, and “Dump list of system memory.”
By default, “User definition” is selected for “System configuration information” and “Selection module” is selected for “Diagnosis 
details”.

•	System configuration information  
					The contents in the system configuration display section are saved. Select "All," "User definition," or "SX bus connection 		
					composition."
•	Diagnosis details  
					The contents in the diagnostic information display section are saved. Select "All modules," "Selection module," or "Only the 	
					display data."
•	Dump list of system memory  
					System memory data are saved as hexadecimal text data.
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2)		File view
This button is used to display the contents of a RAS information file.

�� Click the [File view] button in the "Failure diagnosis" dialog box. The “View RAS file” dialog box opens.
�� Specify a target RAS information file and then click the [View] button. The specified RAS information is displayed.

3) 	File delete
This button is used to delete a RAS information file.

�� Click the [File delete] button in the "Failure diagnosis" dialog box. The “Delete RAS file” dialog box opens.
�� Specify a target RAS information file and then click the [Delete] button. The specified RAS information file is deleted.
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(5)	 Configuration check function
If the system configuration registered in the system definition does not agree with the actual configuration, a fatal fault occurs in 
the system, which cannot start to run. In this case, a “System configuration error” message is displayed on the system RAS. To 
operate the SX system normally, it is necessary to match the system definition with the actual configuration.

�� Click the [Check Configuration] button on the "Failure diagnosis" dialog box. The "Check Configuration" dialog box opens.
�� On the dialog box, the contents of the module registration in the system definition and the actual configuration are displayed. 	

				If there is a mismatch between them, the mismatch spot is displayed in red.

4)		Format of save file
The file name and data formats for RAS information files are shown below.
The file name is “****.RAS” (**** is specified by the user) and data are all text data.
Data are saved in order of the configuration information data and the diagnostic information data.

<Save data>

System configuration type "SX bus connection composition" or "User definition"

Configuration information data

Tree information title "** tree information **"
Row 1 data
Row 2 data
:
:
Last row data

Diagnostic information data
(for each tab information)

Diagnostic information title "** Diagnostic Information **"
RAS history (Current, 1 previous generation, 2 previous generations, and 3 previous
generations)
1st tab name
Data in the 1st tab
2nd tab name
Data in the 2nd tab
:
:
Last tab name
Data in the last tab
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Module configuration registered in the system definition Actual module configuration

*	The above example shows that a module that has not been registered in the system definition exists in the actual configuration.

<Differences of SX bus station numbers between user definition composition and bus connection composition>
If the SPH system is reset when a system configuration error occurs due to a configuration definition mistake or module failure, 
etc., numbers beginning with 1 are assigned to the SX bus stations in their connected order on “bus connection composition” box.
Note that if the CPU or power supply is reset due to a system configuration error after arbitrary SX bus station numbers are set 
as shown in the figure below, the SX bus station numbers of “user definition composition” do not match those of “bus connection 
composition”.

In the example below, different SX bus station numbers are displayed as follows:
			DC/AC input 16 points	 User definition composition: 10 	  	Bus connection composition: 1
			Relay output 16 points	 User definition composition: 20 	 	Bus connection composition: 2
			Sink-type output 16 points	 User definition composition: 30 	 	Bus connection composition: 3
			Ethernet module				    User definition composition: 1   	 	Bus connection composition: 4

Mismatch configuration

<Measures>
1)		To match “user definition composition” with “bus connection composition”, it is recommended to assign SX bus station 		
				numbers in their connected order.
2)		Even if an error occurs in the system during operation, “user definition composition” matches “bus connection composition” 		
				until the system is reset. Perform failure diagnosis before resetting the system.
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(6)	 Failure analysis function
This function automatically analyzes the status of the PLC system from the system memory and RAS information in the CPU 
and displays the error description, cause, remedies and location.
Note:		This function can be used only with SPH300 series of CPUs. 

1)		Example of displaying failure analysis results

Click the tab to change over the window.

Error description display area
All the errors detected in the PLC system are displayed.
By clicking each error description, the remedies, fatal failure 
information and failure position of the error are displayed.

Remedy display area
The probable causes and remedies of the error selected on 
the “error description display area” are displayed. 

Fatal failure information display area
If the error is a fatal failure, its name, cause and time of 
occurrence are displayed.
If the error is a nonfatal failure, this area is not displayed.

Failure position display area
The failure position is displayed.
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2)		Display specifications of the failure analysis screen
�� Click the [Failure analysis] button to perform failure analysis and display the result.
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Display color and example Description
Backgorund color: yellow, Text color: black This module is disconnected. (or fatal failure has occured.)

Backgorund color: yellow, Text color: black This module is registered in the system definition, however, does not exist
in the actual configuration.

Backgorund color: gray, Text color: blue This module exists in the actual configuration, however, is not registered
in the system definition.

Note 1:		If two or more fatal failures occur, only the description of the first detected error is displayed on the “fatal failure” tab 		
												window.

<Display specifications of the failure analysis screen>
1) 	Icon

If two or more errors occur at the same time, description of all the 
errors are displayed in the “error description display area.” 
In the “Remedy display area” and “Fatal failure information/failure 
position display area,” information about the currently selected 
error is displayed.

2)		Display color

Icon Description

Fatal failure has occurred.

Nonfatal failure has occurred.

Both fatal and nonfatal failures have occurred.

Set as "no equipment" in the system definition.
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3)		Automatic execution of failure analysis
If an error occurs in the system, failure analysis can be automatically executed by simply clicking the [Failure diagnosis] button.
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<How to set>
�� Click [Tool] menu > [Option].  The "Options" dialog box opens.

				Select "Online" from the category, and check "Show the failure analysis automatically."
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2-5-4	 Online - Monitor
This command is used to monitor the PLC online. During online monitoring, you can check the ON/OFF status of PLC contacts 
and coils, and the usage of the device memory.

* During the monitoring, you cannot edit the program by default. To edit a program that is being monitored, click [Tool] menu > [Option].  
		Then, on the "Options" dialog box, select "Online" from the category, and check "Allow editing of being monitored."



2-110

Section 2  Menu Reference

2-5-5	 Online menu- Load the changed program into PLC
This command is used change a PLC program partly online (online program change function). This function is available when 
you open the same project as the PLC and make a change to the program. Only the changed program is loaded to the PLC. 
A program can be changed either when the PLC is working or stopped. The CPU key SW must be set at TERM.

If you have performed any of the following operations, the "Load the changed program into PLC" command cannot be used.
•	Changing the system definition
•	Changing the task property
•	Adding/removing the task
•	Adding a program to the task
•	Adding an unassigned program to the task
•	Moving a program under the task to Unassigned Programs
•	Changing a program name
•	Changing a program number
•	Changing a function block number
•	Adding/changing/removing a function block parameter
•	Deleting a program
•	Deleting a function block
•	Adding/changing/deleting an initial value
•	Importing an initial value
•	Adding/changing/deleting Array, Structure definition

Note 1:	When you execute the “Load the changed program into PLC” command for SPH300 CPU, an available program space 	
											of 8192 or more steps is required in the CPU.
											When you execute the “Load the changed program into PLC” command for SPH200 CPU, an available program space 	
											of 4096 or more steps is required in the CPU.
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2-5-6	 Online menu - Data modify
This command is used to modify data memory of the PLC online. Data memory can be modified either when the PLC is working 
or stopped. The "Data modify" command has the following two functions: [Data modify] and [Force ON/OFF].

•	[Data modify]: 
				This function is mainly used to change the internal memory data.
				Input address data cannot be changed by this command.
				Output address data can be changed by this command. However, this command can be executed only once. When the CPU 	
				is working and the output address is used as a coil or specified as a transfer destination in the program, it is overwritten by 		
				program operation. This is also true for the internal memory.

Example of data modification (Bit) Example of data modification (Word)
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•	[Force On/Off], [Forcible setting cancel], [Forcible setting all cancel]: 
				These commands are used to forcibly set ON or OFF an I/O memory, or cancel the forcible ON/OFF setting. The status of the 	
				forcible ON/OFF is cancelled by canceling operation from the loader, turning ON/OFF the CPU power, and resetting the CPU.
				It is not canceled by stopping and starting the CPU. 
				Forcible ON/OFF setting of the internal memory is not possible.

Example of Forcible setting

*	SPB, Board (SPB) does not support the force On/Off function.
*	In SPH300, if you check "ON" for "Compulsion setting hold state," the forcible ON/OFF setting is not canceled by turning ON/		
		OFF the CPU power or resetting the CPU. To cancel it, the canceling operation from the loader is necessary.
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<Data format to be entered into new value>

Data type Input range Input example

BIT (BOOL) ON, OFF ON, OFF

INT -32768 to 32767 INT#123, 123

DINT -2147483648 to 214748647 INT#123, 123456

UINT 0 to 65535 UINT#123

UDINT 0 to 4294967295 UDINT#123456, 123456

REAL -2128 < N <= -2-126, 0, 2-126 <= N < 2128 1.23, 1.3E-5

TIME 0ms to 4294967295ms
0ms to 49d17h2m47s295ms TIME#10s, 10000

DATE 1970-01-01 to 2106-02-07 2000-12-31, DATE#2005-04-01

TOD 0:00:00 to 23:59:59 17:15:00, TOD#12:12:12

DT 1970-01-01 to 2106-02-07-6:28:15 2005-2-14-12:23:00, DT#2005-11-03-00:10:03

STRING Impossible to input -

WORD H0000 to HFFFF H1234

DWORD H00000000 to HFFFFFFFF H12345678
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2-5-7	 Online- Break Point
The break point function is used to stop execution of the PLC under specified conditions. There are two types of break points: 
[Break point] and [Condition break point]. In SPH200/300, only one point can be set (either of the two types of break points). In 
SPH2000/3000, up to 32 points can be set (total of the two types of break points). After stopping the PLC, you can execute the 
program step by step using "Step Execute" function. You can also restart the program from the stop position.
To use the break point function, set the CPU key switch at TERM, and load the program to the PLC if it has been changed after 
connected online. 
When you perform any of the following operations, the break point is canceled.

•	Stopping the PLC (SPH300 only)
•	Setting the CPU key switch to any position other than TERM
•	Turning ON/OFF the CPU power or resetting the CPU

<Functions of break point>

*	When a specified device is executed, a judgment on the condition is made.

Function Specification SPH200
/300

SPH2000
/3000

Multi-point breakpoint Up to 32 points of break points can be set for one project. X a

Logical concatenation of break stop 
condition 

For one device, up to 4 points of break stop conditions by a 
specified value of data can be concatenated with AND or OR. X a

Break point After an instruction set as the breakpoint is executed. a a

Condition
break 
point

Bit (BOOL) data match 
(=1, =0)

=1: When the specified bit (BOOL) data is turned ON
=0: When the specified bit (BOOL) data is turned OFF a a *

Rising/falling edge of
bit (BOOL) data

Rising edge: When the specified bit (BOOL) data is changed from 
                     OFF to ON.
Falling edge: When the specified bit (BOOL) data is changed from
                     ON to OFF.

a a *

Data comparison match When the specified data meets the specified conditions
Comparison conditions (=, <>, <, >, <=, >=) a a *

Reading/writing to data 
(READ/WRITE)

After reading to the specified data
After writing to the specified data a X
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<The buttons concerned with Break Point>
The buttons concerned with break points are shown below.

Break point

Condition break point

Step execution

Step in to function block

Execute from stopping direction

Break point window

•	[Break Point]:
						This button is used to set a break point for the instruction at the cursor position.

•	[Condition Break Point]:
						This button is used to set a break point for the address at the cursor position with a condition.

•	[Step Execute]:
						This button is used to execute the program stopped by the break point step by step. FB contents are not executed step by 		
						step, but in a normal way. 

•	[Step in to function block]: 
						This button is used to execute the program stopped by the break point step by step. FB contents are also executed step by 	
						step.

•	[Execute from the stopping direction]:
						This button is used to restart the program stopped by the break point from the stop position.

•	[Break point window]:
						This button is used to open the "Breakpoints" window.
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<Break Point>
A break point targets instruction positions. The cursor position at the time of execution of this function becomes a break point. 
The instruction specified as a break point changes its back color to pink to indicate the break point.

�� Place the program window into a monitoring state and select a device to be set as a break point. Then, click [Online] > [Break 	
				point] > [Break point] to set a break point (the background color is pink.).  Program execution will be stopped at the break 		
				point. (the background color is turned into yellow)
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<Word/double-word data>

<Condition break point>
Devices that can be set as a trigger point is the I/O memory, standard memory, retain memory, system memory, user FB memory, 
and system FB memory (T, C, TR).

�� Place the program window into a monitoring state and select a device to be set as a break point. Then, click [Online] menu > 	
				[Break point] > [Condition break point]. The following dialog box opens. Select a stop condition, and then click the [Set] button 	
				to set the condition break point.

<Bit (BOOL) data>

You can check the registration status of break points on the "Breakpoints" window.

Select stop condition from the following:
 =1, =0, rising or falling

Select stop condition from the following:
=, <>, <, >, <=, or >=.
As comparable data, 10 digits, 16 digits, word address, or double word 
address shown on the list can be set . 
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<Condition break point for SPH2000/3000>
In SPH2000/3000, when a device at the specified line position is executed and it is set as a stop condition, the execution is 
stopped. Even if there are many same devices (M0) as shown below, the break condition is that M0 is ON when the specified 
line position "Line Number 5 - 1" is executed.
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<Logical concatenation of break points> (for SPH2000/3000 only)
In SPH2000/3000, up to four points of break stop conditions by a specified value of data can be concatenated with AND or OR 
for one variable.

<Concatenation setting example>
The following explains how to set a break condition to stop the program when the device “WM2” is 1000 or 2000<=WM2<=3000.

�� First, set the condition of "WM50=1000", "WM50>=2000", and "WM50<=3000".

�� Link "WM50>=2000" and "WM50<=3000" by AND condition.
				Click "WM50>=2000" and "WM50<=3000" while pressing the <Ctrl> key. While selecting these two click the [AND] button.

�� "WM50>=2000" and "WM50<=3000" are linked by AND condition.

�� Link ("WM50>=2000" and "WM50<=3000") and "WM50=1000" by OR condition.
				Click ("WM50>=2000" and "WM50<=3000") and "WM50=1000" while pressing the <Ctrl> key. While selecting these two, click 	
				the [OR] button.

AND button

OR button
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�� ("WM50>=2000" and "WM50<=3000") and "WM50=1000" are linked by OR condition.
				Check the box of this line.

�� The break point is set.

�� The following dialog box appears. Click the [Yes] button.



2-121

Section 2  Menu Reference

<Canceling break point>
To cancel a break point, uncheck the box on the "Breakpoints" window.
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<Step Execute>
This function is used to execute a program in units of instructions, starting from the break point. 
There are two types of step execute buttons.

 [Step execute]: By clicking button, instructions of a program are executed one by one. When a user FB is on the step 		
						execute position, the FB contents are not executed one by one, but in a normal way.

 [Step in to function block] : By clicking button, instructions of a program are executed one by one. When a user FB is on step 	
						execute position, the FB contents are also executed one by one.

<Execute from the stop position>
This function is used to restart execution of a program stopped by a break point from the stop position. The program restarts 
from the current condition. 
When the break point is not canceled and the break condition is met, the program is stopped again.
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2-5-8	 Online - condition monitor
The condition monitor function is used to capture up to 512 points of devices based on the specified trigger point condition. 
Although the monitoring is stopped, the program continues working. Register an address to capture first, otherwise, condition 
monitor results cannot be displayed. 
To use the condition monitor function, set the CPU key switch at TERM, and load the program to the PLC if it has been changed 
after connected online.
When you perform any of the following operations, the condition monitor is canceled.

•	Setting the CPU key switch to any position other than TERM
•	Turning ON/OFF the CPU power or resetting the CPU
•	Stopping the monitoring.
•	Switching between working and standby CPUs.

<Available monitoring stop conditions>

	* When a specified device is executed, a judgment on the condition is made.

Function Specification SPH200
/300

SPH2000
/3000

Multi-point condition monitoring stop For one project, up to 32 points of condition monitoring stop
points can be specified. X a

Logical concatenation of monitoring
stop conditions 

For one device, up to 4 points of monitoring stop conditions by a 
specified value of data can be concatenated with AND or OR. X a

Monitoring
stop
condition

Program address stop After an instruction set as the breakpoint is executed. X a

Bit (BOOL) data match
(=1, =0)

=1: When the specified bit (BOOL) data is turned ON
=0: When the specified bit (BOOL) data is turned OFF X a *

Rising/falling edge of
bit (BOOL) data

Rising edge: When the specified bit (BOOL) data is changed    
                     from OFF to ON.
Falling edge: When the specified bit (BOOL) data is changed 
                     from ON to OFF.

a a *

Data comparison match When the specified data meets the specified conditions
Comparison conditions (=, <>, <, >, <=, >=) X a *
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<The buttons concerned with condition monitor>
The buttons concerned with condition monitor are shown below.

Execute condition monitor

Finish condition monitor

Stop on the cursor position

Condition stop

Monitor device registration

Condition monitor window

•	[Execute condition monitor]: 
							This button is used to execute condition monitor.

•	[Finish condition monitor]: 
							This button is used to exit from condition monitor.

•	[Stop on the cursor position]: 
							This button is used to set a trigger of condition monitor at the cursor position.

•	[Condition stop]: 
							This button is used to set a condition for the address at the cursor position and stop by the condition.

•	[Monitor device registration]: 
							This button is used to register a device to monitor during the condition stop.

•	[Condition monitor window]: 
							This button is used to open the "Condition Monitor" window.

Follow the procedure below to execute condition monitor.
1) 	Monitor device registration
2) 	Trigger setting (Finish on the cursor position, or condition stop)
3) 	Condition monitor execution
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<Monitor device registration>
Up to 512 points of devices can be registered.

�� Place the program window into a monitoring state and select a device to register.
				Click [Online] menu > [Condition monitor] > [Register device], and then the monitor device is registered.
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<Stop on the cursor position>
This button is used to make settings so that the monitoring is stopped when the instruction at the cursor position is executed.

�� Place the program window into a monitoring state and select a device to stop monitoring.
				Click [Online] > [Condition monitor] > [Trigger setting] > [Cursor Position Stop]. The monitor stop device is set.
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<Word/double-word data>

<Condition Stop>
The device which can be set as condition stop is I/O memory, standard memory, retain memory, system memory, user FB 
memory, and system FB memory (T, C, TR).

�� Place the program window into a monitoring state and select a device to stop monitoring.
				Click [Online] menu > [Condition monitor] > [Trigger setting] > [Condition stop]. Then, the condition stop is set.

<Bit (BOOL) data>

* With SPH2000/3000, up to 32 trigger points can be specified. In addition, as with break points, up to 4 triggers can be logically 	
		connected for one device. Follow the same procedure used for break points.

Select stop condition from following:
 =1, =0, rising or falling

Select stop condition from the following:
=, <>, <, >, <= or >=
As comparable data, 10 digits, 16 digits, word address, or double-word 
address shown on the list can be set .  

You can check the registration status of condition stop on the "Breakpoints" window.
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<Condition monitor execution>
�� Place the program window into a monitoring state, and then click [Online] menu > [Condition monitor] > [Condition monitor 		

				execute]. The condition monitor is set on waiting for a trigger. When the trigger is approved, the monitoring is stopped.

The bar is displayed in purple. "Condition monitor [Hold]" is displayed on the status bar.

* When the monitoring is stopped, the status (ON/OFF, device data) of the devices registered for condition monitor is only 		
		shown. The status of other devices is not displayed.
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<Condition monitor stop>
��While the condition monitor is working, to finish the condition monitor and return to the normal monitor, click [Online] menu > 	

				[Condition monitor] > [Terminate condition monitor].
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2-5-9	 Online - Sampling Trace 
This function is used to sample and display the status of a specified device (memory address).
Note:		The sampling trace function is supported by the following CPUs.
											NP1PS-117, NP1PS-117R and NP1PS-74R: software version V61 or later
											NP1PS-245R: software version V64 or later
											SPH2000/3000: all versions

<Devices for sampling trace>
The following device can be specified as a sampling device.

<Number of points which can be registered>
Up to 32 points of devices can be registered for sampling trace, counting a bit, a word, and a double word as one point.

<Operating procedure>
(1)		To register sampling device

�� Click [Online] menu > [Sampling trace] > [Sampling trace]. The [Sampling trace] dialog box opens. 
				First, specify a device for the sampling trace. Right-click on the area surrounded by a dashed line shown below, and select [Add 
				sample target].

Bit Word Double word

Input memory X WX DX

Output memory Y WY DY

Non-retain memory M WM DM

Retain memory L WL DL

System memory SM WSM DSM

Timer T – T

Counter C C –

*	The devices M, L, and SM can be registered on this dialog box. For other devices, X, Y, T, and C, refer to <Registration 		
		procedure during online monitor> explained below.
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�� The address entry box is displayed on the bottom. Enter a device address to sample, and press the <Enter> key.
				Then, the tag entry box appears. Enter a tag name, and press the <Enter> key. (The tag names is optional.) 
				This tag is different from the tag entered on a program and used only for sampling trace.
				The list to select the data type appears. Select the data type and press the <Enter> key.

* When you trigger sampling trance by the status change of a device, also register the device. When using a manual trigger, the 	
		registration is not necessary.

�� The device for sampling trace is registered. Following the above procedure, add and register other devices for sampling as 		
				many as you need.
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<Notes on registration of a sampling trace device>
The devices M, L, and SM can be registered even offline. You need to register other devices, X, Y, T, and C during online monitor. 
In addition, the address of the device must be used by a program.
Registration procedure during online monitor is explained below.

<Registration procedure during online monitor>
�� Place the cursor on a device to register as a sampling trace during online monitor, right-click on it, and then select "Register 	

				Device to Sampling Trace" from the menu.
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(2)	 Trigger condition setting
�� Check a device to set for trigger condition. Check "Trigger condition" and select a device address and condition from the list. 	

				(This setting is not necessary when using a manual trigger)

Only one trigger condition can be set.
With SPH2000/3000, up to 4 points of conditions can be combined by AND, OR condition.



2-134

Section 2  Menu Reference

<Trigger conditions>

<Comparison data>
When the trigger condition is specified only with a comparison operational expression (only with word/double-word data), set a 
comparison data in the comparison data field based on the following table.

Function Specification SPH300 SPH2000
/3000

Logical concatenation of trigger
conditions

For one device, up to 4 points of sampling start conditions by a
specified value of data can be concatenated with AND or OR. X a

Trigger
condition

Bit (BOOL) data match
(=1, =0)

=1: When the specified bit (BOOL) data is turned ON
=0: When the specified bit (BOOL) data is turned OFF a a

Rising/falling edge of
bit (BOOL) data

Rising edge: When the specified bit (BOOL) data is changed from
OFF to ON.
Falling edge: When the specified bit (BOOL) data is changed from
ON to OFF.

a a

Data comparison
match

When the specified data meets the specified conditions
Comparison conditions (=, <>, <, >, <=, >=) a a

Data type Input range Input example Display example after input

BIT (BOOL) 0,1 Cannot be input. –

INT -32768 to 32767 INT#123, 123 INT#123 (INT# is prefixed.) 

DINT -2147483648 to
2147483647 DINT#100, 100 DINT#1000 (DINT# is prefixed.) 

UINT 0 to 65535 UINT#1000, 1000 UINT#1000 (UINT# is prefixed.) 

UDINT 0 to 4294967295 UDINT#1000, 1000 UDINT#1000 (UDINT# is prefixed.) 

REAL Single-precision
floating decimal point REAL#10, 10.0, 1.3E-05 10.0, 1.3E-05 (REAL# is omitted.)

TIME 0ms to 49d17h2m47s295ms
(4294967295ms)

TIME#10s, 10s, 1s500ms,
10000ms

10000ms 
(All values are expressed in millisecond.)

DATE 01-01-1970 to 02-07-2106 DATE#2003-2-1, 2003-02-14 2003-02-14 (DATE# is omitted.)

TOD 0:00:00 to 23:59:59 TOD#17:00:00, 17:00:00 17:00:00 (TOD# is omitted.)

DT 01-01-1970 0:00:00 to
02-07-2106 6:28:15

DT#2003-02-09-4:00:00,
2003-02-09-04:00:00 2003-02-09-4:00:00 (DT# is omitted.)

STRING – Cannot be input. –

WORD 0000 to FFFF H0000, H1234, HABCD, 0, 
1234, ABCD ABCD (H is omitted.)

DWORD 00000000 to FFFFFFFF
H00000000, H12345678,
HABCDEF10, 0, 12345678,
ABCDEF10

ABCDEF10 (H is omitted.)

*	Input values are automatically changed depending on the data type as shown in "Display example after input" in the list above.
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<How to cancel trigger condition>
To cancel a trigger condition, follow the procedure below.

�� Select a blank from the address list of Trigger condition.

�� Uncheck the box.
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�� The trigger is canceled.
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<How to set multi-point trigger condition>
You can set multiple trigger conditions and trigger by combination of AND, OR condition. This is called multi-trigger. Only 
SPH2000/3000 support this function. 

�� Check the address to set for the target of multi-point trigger. Check "Data condition," and click the [Advanced] button.

�� The "Advanced setting" dialog box opens. Select a trigger condition and "Linkage logic" (AND/OR), and then click the [OK] 		
				button.



2-138

Section 2  Menu Reference

�� The multi-point trigger condition is set.
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(3)	 Trace condition setting
Set the sample timing, total number of samples, and trigger points as trace conditions.

<Sampled when: the sample timing>
•	[Scan end]: Sampling is performed when every scanning (default task) is done.
•	[Period of]: Sampling is performed in the set cycle. The setting range is 1 to 32000ms (0.5ms * N), and you can specify 		
		the value that is an integral multiple of SX bus takt.

<Total sample number: total number of samples>
Set the total number of samples. A value equal to or greater than 3 in the range displayed on the right can be set. The value 
displayed on the right changes depending on the number of sampling devices.

<Trigger point>
Move the slide bar horizontally to set a trigger point. The value displayed on the screen is the sampling data number to download 
before operating trigger. When using a manual trigger, this setting is disabled. (The trigger point is fixed to 0.)
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(4)	 Sampling trace execution
<Manual trigger>

�� Click the [Connect the PLC] button, and then the [Manual trigger] button.

�� The message saying "Triggered !" appears, and sampling starts.
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��When the reading of sampling data is done, the message changes to "Online." Sampling data is shown as a graph.

��When the sampling is done, the message changes to "Reading." Reading of sampling data is started.
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<Condition trigger>

�� Click the [Connect the PLC] button, and then the [Execute] button.

�� The message saying "Waiting to be triggered" appears.
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��When the trigger condition is approved, the message saying "Triggered !" appears. Sampling is started.

��When the sampling is done, the message changes to "Reading." Reading of sampling data is started.
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��When the reading of sampling data is done, the message changes to "Online," and the sampling data is shown as a graph.
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<Saving data Icons>

New

Open

Save

Create setting file

(5)	 Displaying the result of a sampling trace
The screen displaying the result of a sampling trace is as follows.

•	[New]: This button is used to clear a sampling trace setting and a data list of sampling.
•	[Open]: This button is used to open a file saved by "Save" or "Create setting file." (Either file is Extension. swfa)
•	[Save]: This button is used to save the data of sampling data list, and the setting of sampling trace. (Extension. swfa)
•	[Create setting file]: This button is used to save the setting of sampling trace.

<Sampling data list>
Every time when sampling trace is completed, temporary data is created. This data can be created up to 50. When exceeding 50, 
sampling trace cannot be done. To avoid that, delete it by using the <Del> key as needed.

Saving data Icons

Sampling data list
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<Save sampling data as csv>
Sampling data can be saved as csv. Check data to save as csv in the sampling data list, right-click it, and then select "Export as 
CSV file" from the menu. 
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•	[Vertical]: You can adjust the fineness of scale on the vertical axis and specify the color of the graph.
•	[Horizontal]: You can adjust the fineness of the scale on the horizontal axis.
•	[Cursor]: Move the vertical cursor on the graph and click the [Measure] button. The value of the coordinate is displayed.

<Graph view settings>
Click the [Graph view settings] tab. The "graph view settings" screen is displayed. Click the device to change settings.
To show or hide the graph, check or uncheck the box of the device.

"Zero level check" icon

"Default" icon
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2-5-10	 Online - Program Operation
This command is used to select and perform one or more programs assigned in one resource (CPU module). Debugging work 
can be done for each program using this function.
Note: 	The program operation function cannot be used during execution of other test functions (break point, step execution, 		
									condition monitor). However, other test functions can be used after execution of the program operation function.
									Before using this function, execute [Online] menu > [Monitor] to place the program window into a monitoring state.

	Click [Online] menu > [Program operation]. The [Program Operation] dialog box opens. The programs whose box is checked  	
				are valid. Uncheck the box of the program to be invalid, and click the [OK] button.

Note: The invalid program is canceled when the power of the CPU module is reset (OFF to ON). All programs become valid, and 	
									all programs assigned to the resource start to work.
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2-5-11	 Online - Task execution time measurement
This command is used to display the execution time of all working tasks, and the current/minimum/maximum value of the 
execution cycle. (Unit: µs)

Current time / Min time / Max time: These are the execution times of the program.
Current cycle / Min cycle / Max cycle: These are the cycles where the program is performed. The program is executed in 
synchronization with the bus tact; It is same as scan time.

The target of Min time, Max time, Min cycle, and Max cycle is a period from the execution of "task execution time measurement" 
to the present. 
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Binary display

Decimal display
Hexadecimal display  

Display by user 
definition form 

2-5-12	 Online - Data monitor
This command is used to monitor PLC devices.

�� Click [Online] menu > [Data monitor] > [Data monitor 1]. The data monitor screen opens.
* Up to four data monitor screens can be opened: Data Monitor 1 to 4 

�� Place the cursor on the address row, enter [X1.0], and then press the <Enter> key. The status of X1.0 is displayed. 
				(A value of 0 indicates ON; a value of 1 indicates OFF.)

�� Enter an addresses to monitor by following the above procedure. 

* The following addresses can be monitored. Check the status of timers and counters on the program screen.
•	Bit address: X, Y, M, L, SM, S, ENO
•	Word address: WX, WY, WM, WL, WSM, WS
•	Double word address: DX, DY, DM, DL, DSM
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Icons on the data monitor screen

								[Display next address]: Displays an address added +1 to the address below the cursor.

								[Display data fill]: Displays continuous addresses starting from the address below the cursor.

								[Clear data]: Deletes an address below the cursor.

								[Clear all data]: Deletes all displayed addresses.

								[Bit ON]: Executes Overwrite ON for bit.

								[Bit OFF]: Executes Overwrite OFF for bit.

								[Force ON]: Executes Force ON for bit. The target is the area of X, Y.

								[Force OFF]: Executes Force OFF for bit. The target is the area of X, Y.

								[Force reset]: Resets Force ON/OFF.

								[Force setting detail]: Displays the status of Force ON/OFF as a list.

								[Save data display setting]: Saves data display setting specified by the user. 
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2-6	 Conversion menu
The "Conversion" menu contains the following commands:

•	Conversion a Converts only the changed part of a program. The conversion time is short compared with that  "Conversion
				All" command. Use this command to make the conversion time shorter when you make a small program change to a program.

•	Conversion All a Converts the whole program. Usually use this command.
				*	Do not use the "Conversion" and "Conversion All" commands when you change a program online. If you execute either, a 		
						machine code (code for PLC operation) is created.

•	Program Check a Checks the syntax of the whole program. No machine code is created. Use this command to check the 		
		syntax of a program before changing it online.
•	ST Syntax Check a Checks only the syntax of a program created in ST language.
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2-6-1	 Conversion menu - Conversion / Conversion All
These commands are used to convert programs.
The syntax of a program and the consistency of I/O and addresses set in the system definition are checked, and then program 
data to load to the PLC (machine code) is created. Make sure to execute "Conversion" or "Conversion All" before loading a 
program to the PLC.

�� Click [Conversion] menu > [Conversion] or [Conversion All]. The program is converted. Whether the conversion is completed 	
				normally is indicated in the status bar on the bottom of the screen.

<When conversion is normally completed>
When the status bar shows "Error : 0," the conversion is normally completed. If warning is not 0, see the contents of the warning 
and check whether the system has any problem.

<When conversion is abnormally completed>
If the program has some errors, the "Error" window appears as shown below. The program cannot be converted and needs to 
be corrected. Double-click the row of the explanation part, and the corresponding line is displayed.

When the conversion is normally completed, information on the program such as program steps, the number of timers/counters 
used can be checked on the "Information" window.  (If the conversion is failed, this window does not appear.)
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2-6-2	 Conversion menu - ST Syntax Check
This command is used to check the syntax of a program created in ST language. An active program is checked.

2-6-3	 Conversion menu - Program Check
This command is used to check the syntax of the whole program. No machine code is created. Use this command to check the 
syntax of a program before changing it online. ST syntax is also checked.

Active program
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2-7	 Tools menu
The "Tools" menu contains the following commands:

•	User ROM utility a Initializes a user ROM (CF/SD card), or reads and writes a program.
•	Address Assignment a Creates the address conversion rule to convert a program for MICREX-F or FLEX-PC to SX.
•	SX Control Utility a Starts SX Control Utility software.
•	Shortcut key a Changes the assignment of shortcut keys. 
•	Customize Instruction Jog a Changes the Instruction Jog.
•	Options a Makes optional settings about the loader software operation.



2-156

Section 2  Menu Reference

2-7-1	 Tools menu – User ROM Utility
This command is used to initialize a user ROM (CF card), or read and write a program. Connect a user ROM to the computer 
using a commercial card reader and writer.

�� Click [Tool] menu > [User ROM utility]. The following dialog box opens.

Operation items of a user ROM are as follows:
•	Load to User ROM: Transfers a program from the loader to a user ROM.
•	Load from User ROM: Transfers a program from a user ROM to the loader
•	Verify with User ROM: Compares the currently open program with a program in a user ROM.
•	Maintenance: Initializes a user ROM.
•	Security: Sets a password on a user ROM
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(1)	 Download to User ROM
This function transfers a program from the loader to a user ROM.

�� Check items to download (usually check all items.), select a drive to download (a drive to which the user ROM is assigned), 		
				and then click the [Load to User ROM] button.

�� The confirmation dialog box appears. Click the [OK] button.

�� The dialog box showing download completion appears. Click the [OK] button.

*Only one program can be saved in a user ROM.
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�� The confirmation dialog box appears. Click the [OK] button.

�� The dialog box showing loading completion appears. Click the [OK] button.

(2)	 Load from User ROM
This function transfers a program saved in the user ROM to the loader.
Select the transfer source drive (the drive to which the use ROM is assigned), and then click the [Load from User ROM] button.
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�� The confirmation dialog box appears. Click the [OK] button.

(3) 	Verify with User ROM
This function compares a loader program with a program of a user ROM.

�� Check items (usually check all items.) to verify, select the drive of the use ROM (the driver to which the user ROM is assigned), 	
					and then click the [Verify with User ROM] button.

�� The verification result is displayed.

The verification result is classified by color.
			White : Common
			Orange : Modified
			Gray : Not exist
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Explanation of Icons 

System Definition

Program

Common

Modify

Filter character string

Filter

Update the latest status

*	To check mismatched lines, follow the same procedure as in project verification. Refer to "2-4-5 Project Menu - Verify" for more 	
		details.

Icon Explanation

System Definition Used to show/hide "System definition" in the "Data Type" column.

Programs Used to show/hide "Circuit" in the "Data Type" column.

Common Used to show/hide "Common" in the "State" column.

Modify Used to show/hide "Modified" in the "State" column.

Filter line strings Used to enter a filter keyword.

Filter Enter a filter keyword, and then click this button to filter the list. Only the items that 
includes the entered keyword are shown. Click this button again to cancel the filter.

Update the latest status Used to verify one more time
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(4)	 Maintenance
This function formats a user ROM, clears projects in the user ROM and sets a password. Select the drive of the user ROM and 
click the operation item button.

(4)-1 		Format
This function formats the user ROM. When you execute formatting, the contents in the user ROM are deleted all, and the CPU 
creates a folder and file to recognize programs.
* When using SPH300 software version earlier than V59, the OS of the computer used for formatting must be Windows 2000. 		
		A user ROM formatted by Windows XP or Vista computer cannot be recognized.

�� Select the drive of the user ROM (the drive to which the user ROM is assigned), and then click the [Format] button. The 		
				warning dialog box appears. Confirm the contents and click the [OK] button to proceed to the next screen.
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�� The "Format" dialog box appears. Confirm the contents and click the [Start] button to proceed to the next screen.

When using SPH 300, select “FAT” for File system.

�� The warning message appears. Confirm the contents and click the [OK] button to start formatting.

��When the formatting is completed, the following dialog box appears.
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(4)-2 		Clear
This function clears a program saved in a user ROM.

�� Select the items to clear, and click the [Clear] button.

��When the program is cleared, the following dialog box appears.
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(4)-3 		Password
This function sets a password on a user ROM. If a password is set, the password is required to access to the user ROM. (The 
password is not required to format the user ROM. If the user ROM is formatted, both the program and password are cleared.) 

<New registration of password>
�� Click the [Registration] button on the following dialog box.

�� The password entry dialog box appears. Enter a password, and then click the [OK] button.

* The password must be between 6 and 32 alphanumeric characters and symbols (+, -, =, /).

�� The password is set.
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<Entering the password>
To access (read/write/verify/clear/set as Read only) the user ROM where a password is set, you need to enter the password in 
the following dialog box.

�� Enter the password in the following dialog box, and then click the "[OK] button.

*	If you enter a wrong password and try to access to the user ROM, the following message appears.
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<Changing the password>
This function changes the password registered for the user ROM to new one.

�� Enter the registered password and a new password, and then click the [OK] button.

�� The password is changed.
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<Canceling the password>
This function cancels the password registered for the user ROM.

�� Click the [Cancel] button on the following dialog box.

�� The password entry dialog box appears. Enter the password, and click [OK].

�� The password is canceled.
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(5)	 Security
This function sets read only for the user ROM.

�� Select the drive of the user ROM (the drive to which the user ROM is assigned), and check "Read only." The dialog box to set 	
				a password appears. Enter a password, and then click the [OK] button.

* The password must be between 6 and 32 alphanumeric characters and symbols (+, -, =, /).

Even when "Read only" is set, data writing by application 
program (F_WRITE) is permitted by checking this box.
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To permit writing to the user ROM, uncheck "Read only," and cancel the password.
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2-7-2	 Tools menu - Address Assignment
This command is used to define the address assignment rule to convert MICREX-F or FLEX-PC programs. For more details, 
refer to the user's manual "Replacement Manual MICREX-F to MICREX-SX <Convert> (FEH038)."
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2-7-3	 Tools menu - SX Control Utility
This command is used to start the SX Control Utility software. For more details, refer to Appendix 1.
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2-7-4	 Tool Menu- Shortcut key
You can customize shortcut keys that are assigned to each menu of the loader.
For the shortcut keys, the combinations as shown below can be used.

* When the shortcut key you select has been already assigned to a function, and if you assign the key to another function, the 		
		originally assigned function has no shortcut key function.

(None) F11

Shift Ins, Del

Ctrl A to Z, F1 to F3, F5, F7 to F12, Ins, Del, -

Alt A to Z, F1 to F3, F5, F7 to F12, Ins, Del, -

Ctrl + Alt A to Z, F1 to F12

Ctrl + Shift A to Z, F1 to F12
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<Setting a shortcut key>
Set a shortcut key following the procedure below.

�� Select a command to register from the "Command" list.

�� Select a "control key" to use, select a shortcut key from the list, and then click the [Apply] button.

�� A shortcut key is set.
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<Deleting a shortcut key>
To delete a shortcut key, select a command, and then click the <Del> key.
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<Saving/reading a shortcut key>
This function is used to save the shortcut key setting as a file or read the saved setting.

* Shortcut key settings saved by Standard loader V2 cannot be used in Standard loader V3.



2-176

Section 2  Menu Reference

The table below shows the predetermined shortcut keys.

Function Shortcut Key

New Project Ctrl + N

Open Ctrl + O

Save Ctrl + S

Print Ctrl + P

Undo Ctrl + Z

Redo Ctrl + Y

Cut Ctrl + X

Copy Ctrl + C

Paste Ctrl + V

Find Ctrl + F

Find Output Device Ctrl + Alt + F

Insert Row Shift + Ins

Delete Row Shift + Del

Insert Column Ctrl + Ins

Delete Column Ctrl + Del

Project View Ctrl + F1

Find Result Ctrl + F2

Cross Reference Window Ctrl + F3

Output Window Ctrl + F5

Error Window Ctrl + F7

Information Window Ctrl + F8

Make Cross Reference Ctrl + R

Trace Back Cress Reference Ctrl + -

Trace Forward Cross Reference Ctrl + Shift + -

PLC Operation Ctrl + F10

Monitor Ctrl + M

Data Modify Alt + D

Forcible On/Off Alt + S

Forcible Reset Alt + R

Breakpoints Window Ctrl + F9

Sampling Trace Ctrl + T

Task Execution Time Measurement Ctrl + E

Conversion F11

Syntax Check Ctrl + F11
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2-7-5	 Tool Menu- Customize Instruction Jog
This command is used to customize the "Instruction Jog" bar.

�� Click [Tools] > [Customize Instruction Jog]. The following dialog box opens.

•	Up: Selected group moves up.
•	Down: Selected group moves down.
•	Add Row: New group is added.
•	Delete Row : Selected group deleted.
•	Apply: Selected instruction is applied. Alternatively, you can select instruction and double-click it.
•	Delete: Selected instruction is deleted. Alternatively, you can select instruction and press the [Del] key.
•	Branch: Contact or Coil instruction is changed with branch (OR).
•	Default: Goes back to the default setting.
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<How to make new group>
�� Click the [Add Row] button. A new group is added. Enter a group name.

�� Assign [R_READ] to [F2] key.  Select [R_READ] from the Instruction list, and double-click it or click the [Apply] button.
			 [R_READ] is assigned to the [F2] key.
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�� Using the same procedure, assign other function keys.

*	Default Group name and function key setting can also be changed.
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2-7-6	 Tools - Option
This command executes the option settings of the loader shown below.

•	General a Makes the general settings of the loader.
•	Directories a Sets the folder to open by default.
•	Project a Makes the setting about projects.
•	Online a Sets online operations.
•	Conversion a Sets operations of conversion.
•	Backup a Sets backup operations.
•	System Definition a Sets operations for system definition registration

(1)	 General
You can make general settings of the loader.

•	Language: 
				You can change the language of the loader. Choose Japanese or English.

•	Address display mode:
    If MICREX-F is selected, word addresses are expressed in decimal.
    If FLEX-PC is selected, word addresses are expressed in hexadecimal.

•	Last project is opened at the time of starting:
     If this option is checked, the last opened project is opened when the loader is started.

•	Reset the window layout:
    The following items of the window layout are initialized.
       Sub window size and layout in the main window.
       Tool bar layout
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(2)	 Directory
You can make settings of the file to open by default.

Click these buttons and set 
the folder to open by default.
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(3) 	Project
You can make settings of projects.

•	Hide protected programs on the project view:
 				Check this option to hide protected programs (where a password is set by executing [Project] Menu > [Security] > [Protection 	
				Programs])

•	Support non compressed project file: 
				Usually, a project is saved as a compressed type file (*.Zpj3). If this option is checked, you can also choose non compressed 	
				type (*.Spj3 file and folders) when saving a project.
				When you use a PID expansion FB and set parameters, you need to choose non compressed type.

•	Hide program name in the caption:
				Choose whether or not to display a program name in the caption.

Caption
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(4) 	Online
You can make settings of online operations.

•	Show the failure analysis automatically:
     When you open the failure diagnosis window, the failure analysis screen automatically opens if the PLC detects an error.
					Only SPH300 supports this function.

•	Permit the use of Initial Run:
     "Initial Run" of the "PLC operation" command is enabled. Note that the retain memory is cleared when "Initial Run" is 		
					executed.

•	Verify before the monitor is started:
     Before monitoring the PLC, the loader program is compared with the PLC program.

•	Allow editing of being monitored:
				A program can be edited during the monitoring. Instead, force setting operation of contacts and coils that can be made by 		
				double-click is disabled. To make force setting, use the right-click menu.

•	Monitor is started automatically after load program:
				After a program is loaded (all program transfer), monitoring is automatically started.

•	Permit load to PLC only the program:
     When a program is loaded to the PLC, the program and system definition are usually loaded in combination. If this option is 	
				checked, only a program can be loaded. When you change the system definition, make sure to load both the program and 		
				system definition.

•	Show the confirmation before download to PLC:
     When [Load the changed program into PLC] is executed, the confirmation dialog is shown.

•	Permit to download Zip file:
				When [Load the changed program into PLC] is executed, a Zip file (tag and program name information) is also loaded to the 	
				PLC.
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•	Automatic import of the Ex. FB:
     When standard expansion FBs or CSV interface FBs are used in the PLC or user ROM card, select whether or not to import 	
				them automatically.

•	[Don't import automatically]: Import is not performed automatically.
•	[Import automatically]: The import confirmation message is shown, and then import is performed automatically.
•	[Import without a confirmation message automatically]: Import is performed automatically without a confirmation message.

(5) 	Conversion
You can make setting of conversion operations.

•	Restore the project name based on the Zip file:
				Select whether or not to read the project name when a program is read from the PLC.

Project name
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•	Program size: 
				Set the size of a program.

•	FB instance size:
				Set the data size of a user function block.
 				If the size set here is exceeded, an error occurs when the [Conversion] command is executed.
 				When “Maximum” is selected, the program and FB instance sizes are checked according to the maximum size of the target 		
				CPU.
 				The table below shows the maximum size of each CPU.

Series Type Program size FB instance size

SPH2000
NP1PH-08

4096   *1
2048

NP1PH-16 4096

SPH300

NP1PS-32/32R

8192   *2
4096     *3NP1PS-74/74R

NP1PS-117/117R

NP1PS-245R 4096

SPH2000
NP1PM-48R/48E 16384 16384     *4

NP1PM-256E/256H 16384 16384

SPH3000
SPH3000MM

NP1PU-048E/128E/256E 
NP1PU2-048E/256E 16384 16384

SPB
NW0P20/NW0P30 2048

256

NW0P40/NW0P60 4096

Board (SPB)

NW3P08-41C

8192NW3P16-42C

NW3P32-42C

*1	When the CPU version is earlier than V**30, the maximum size is 2048.
*2	When the CPU version is earlier than V**62, the maximum size is 4096.
*3	When the CPU version is earlier than V**63, the maximum size is 256.
*4	When the CPU version is earlier than V**02, the maximum size is 4096.

•	Permit use of step control: 
				Check this option to use SC (step control) instructions. In this case, the last 100 words of the retain memory (WL) is used for 	
				SC.

•	The duplication of the timer / counter assumes it warning: 
				If timer/counter coil addresses are overlapped in the same program instance, it is handled as a warning. If this option is 		
				unchecked, it is handled as an error.

•	Display a confirmation when running the conversion:
				When you execute [Conversion] menu > [Conversion] or [Conversion All], the following message to confirm that "Load the 		
				changed program into PLC" command is disabled is displayed. 

•	Disable the conversion and conversion all:
				The [Conversion] and [Conversion All] commands are disabled.
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(6) 	Backup
You can make settings of backup operations.

•	Backup project when load from PLC or load the changed program into PLC:
				The project is automatically backed up when "Load from PLC" or "Load the changed program into PLC" is executed. 
				In addition, when "Load the changed program into PLC" is executed, changed contents are saved as a log.

•	AutoSave
				The currently open program is automatically saved at certain intervals. You can set the interval between 1 to 99 minutes.

<Default save folder>
			<My Document>/Fuji Electric/SX-Programmer Standard
			The save folder can be changed.

<File name>
   	-UPLC001.Zpj3 (When "Load from PLC")
   	-DPLC001.Zpj3 (When "Load the changed program into PLC")
   	-DL001.Log (Log file)
			-AUTO_SAVE001.zpj3 (AutoSave file)
The number prefixed to a file name is incremented like 001, 002, 003 by every saving. The file with the largest number is the 
oldest. "001" is the latest file.
"Quantity (1-99)" specifies the number of backup files. If the number of backup files exceeds this value, the oldest file is deleted.
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(7) 	System Definition
You can make setting of operations for system definition registration.
If "Select the last insert module" is checked, the same type module that you inserted last time is automatically displayed when 
inserting a module in the system definition. This function is convenient to define multiple same type modules.
If unchecked, the module at the top of the list is displayed when inserting a module.
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2-8	 Window menu
In the [Window] menu, select a program or function block to bring to the front of other windows that are currently opened. 
Alternatively, you can click the tab.

•	[Close All Document]  a Closes all opened documents.
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2-9	 Help menu
The "Help" menu contains the following commands:

•	User Manual a Opens the user's manual of the loader software.
•	About a Shows the version of the loader.
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In the system definition, set entire system operations, register modules to be used under the configuration, and set parameters.

3-1	 System Definition of SPH Series
The following items are specified in the system definition of SPH series.

3-1-1	 Registering Modules
(1)	 Module registration
With the MICREX-SX, you need to register all the modules to be used under one configuration.
The following explains module registration procedures using the sample system configuration below.

<Sample system configuration>

Module registration

� Explained in “3-1-3 System property”.

Running definition, Memory size

I/O group setting

Fail-soft setting

System properties System running definition

System fail-soft activation

System redundancy definition

� Explained in “3-1-2 CPU parameter setting”. 

Registration of modules to be used

CPU parameters 

Explained in “3-1-1 Registering modules”.

Power supply
CPU

I/O
16

point
input

I/O
32

point
input

I/O
16

point
output

I/O
32

point
output

Empty slot (reserved for future installation of modules)

<System configuration registration screen>
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�� Double-click “System Definition” in the project tree. The system definition screen opens.

�� Change the base board to a 8-slot base that is actually used. Select the base board, and then click the [Properties] button. 		
				The “Module property” dialog appears.

[Properties] button

You can give the power supply module and 
base board any name up to 63 characters.

�� Select “NP1BS-08 8slots Base” from the [Outline specification] list box, and then click the [OK] button. The base board 		
				changes to the 8-slot base.
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�� Register modules sequentially from the left of a base board. Since a power supply and a CPU module are registered by  		
				default, register the 16-point input module. To register (add) the module below the CPU module, select the CPU module, and 	
				then click the [Insert] button. The “Module insert” dialog box opens.

[Insert] button

Inserted below the selected module.

�� Select the module (NP1X1606-W DC/AC Input 16points) according to the actual configuration. For the SX bus station No., 		
				any number from 1 to 238 can be specified. However, in general, 1, 2, 3, ... are assigned from the one on the right of the CPU 	
				module in order.	Select a module, and then click the [OK] button. The module is registered.

Select the SX bus station number.
For a CPU and processor link module, 
select the CPU number.

Select a module.

Select the module
attribute.

Select the module type. Select the insertion position of the module. Set module parameters.
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�� Register modules in the same manner. If you want to mount a module in the future and leave the slot unused as shown in the 	
				system configuration, specify the SX bus station number and the module to be mounted in the same manner as other modules, 	
				check “No equipment,” and then click the [OK] button.

The module is registered with “No equipment” mark.

[No equipment batch setting] button

[No equipment batch release] button

*	No equipment setting of modules/units registered in the system definition can be made or canceled in a batch on the system 		
		definition screen. To make or cancel the no equipment setting of the entire system, select “System structure,” and then click 		
		the “[No equipment batch setting] button or [No equipment batch release] button. Likewise, to make or cancel no equipment 		
		setting of 	modules/units on a base board, select the base board, and then click each button. For units connected to a remote 
		I/O master module, select the remote I/O master, and then click each button.

[No equipment] button
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(2) 	Module parameter setting
The following describes the procedure for setting parameters of MICREX-SX series modules, using input and output modules 
as an example. Refer to “3-1-2 CPU Parameter Setting” for parameter setting of CPU modules. For other modules, refer to the 
manual of each individual module.

�� Select the module for parameter setting on the system definition screen, and then click the [Properties] button. The “Module 	
				properties” dialog box appears.

[Properties] button

Click here.

�� Click the [Parameter] button. The parameter setting screen for the module appears.
				The parameter setting screen differs depending on the module type. The following shows the setting screen for the input 		
				module.

Set the input filter time.

�� Set each item and then click the [OK] button to return to the “Module properties” dialog box. Click the [OK] button to complete 	
				the registration.
Note:		Parameter setting for each module can also be performed at the time of module registration.
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<Parameter setting for output module>
Two parameters can be set for the digital output module.

1)		HOLD Definition
				If the system fails and the CPU module stops, this setting is used to retain the output condition immediately before the failure 	
				occurs or retain, while the CPU stops, the output condition immediately before the CPU stops.

2)		System DO (Output) Definition
				A bit which outputs the operating status of the system regardless of the application can be defined in each configuration.
				It is set to ON when the entire system is operating normally and OFF if a fatal fault occurs in the system or the system stops. 	
				When a nonfatal fault occurs in the system (the system is operating), it is not set to OFF. Only bit 0 of the output module can 	
				be set.

<Operating procedure>
�� Select the digital output module for parameter setting on the system definition screen and then click the [Properties] button. 		

				The “Module properties” dialog box appears.
�� Click the [Parameter] button. The “Direct I/O parameter setting” dialog box appears.

�� To perform HOLD definition, select “HOLD mode.”
�� To perform System DO definition, check “Select system digital output.”
�� After setting parameters, click the [OK] button.
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(3)	 Module deletion
The following describes the procedure for deleting a registered module.

�� Select a module to be deleted on the system definition screen and the click the [Delete] button.

[Delete] button

Select the module to be deleted.

�� Click the [Yes] button. The selected module is deleted.
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3-1-2	 CPU Parameter Setting
Parameter settings for the CPU module include “CPU running definition”, “Memory allocation setting”, “I/O group Setting”, “Fail-soft 
operation setting” and “Constant scanning setting (only for SPH2000/3000)”.

(1)	 CPU running definition
	Select a CPU on the system definition screen and then click the [Properties] button. The “Module properties” dialog box for 		
				the CPU appears.

[Parameter]
button

�� Click the [Parameter] button. The “CPU parameter” dialog box appears.
				The dialog consists of four tab pages. The “CPU running definition” tab page opens first.

Note:		“CPU parameter” dialog box differs depending on the CPU type 		
					  because each CPU has the different functions.
					  For more details, refer to the user’s manual “Instruction (FEH588).”
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(2)	 Memory allocation setting
Set the size of the data memory in the CPU module.
The default size of the data memory is predetermined for each CPU module, but you can change the size of individual memory 
area in 0.5-k word steps as needed. For more details of the memory of individual CPU modules, refer to the user’s manual 
“Instruction (FEH588).”

1)		SPH200/300 series
�� Click the [Memory allocation setting] tab on the [CPU parameter] dialog box. The [Memory allocation setting] tab page opens.

�� Enter the size of each memory in the text box, and then click the [OK] button.  
				Click the [Default] button when you want to reset to default values.

For SPH300, all the remainder
after setting these 3 memory 
capacities becomes the capacity 
of non-retain memory.
For standard CPU modules, the 
user can set the capacity of 
non-retain memory, and the 
remainder becomes the memory 
capacity for initial data.

Edge detection, counter, addition
timer and timer can also be set 
for system FB.  The remainder 
becomes the area for other FBs.
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2)		SPH2000 series (NP1PM-48R/48E)
	Click the [Memory allocation setting] tab on the [CPU parameter] dialog box. The [Memory allocation setting] tab page opens.
				Make the settings for non-retain memory and other types of memory.

�� Enter the size of each memory in the text box, and then click the [OK] button.  
				Click the [Default] button when you want to reset to default values.

*	If inter-CPU memory access is performed using a processor bus on a SPH2000/3000 series multi-CPU system, the following 		
		memory area needs to be reserved.
				For general memory: memory area must be reserved in multi-CPU non-retain memory.
				For retain memory: memory area must be reserved in multi-CPU retain memory. 

If memory other than non-retain 
general memory is changed, 
the non-retain general memory 
and memory selected via the 
automatic calculation button 
become a buffer, increasing or 
decreasing in size.

In the example of the right figure, 
when the multi-CPU non-retain
memory, retain memory,
multi-CPU retain memory, or 
user FB memory is changed, the 
system FB memory selected via 
the automatic calculation button 
automatically grows or shrinks.

If the number of edge detection, 
counter, or addition timer points 
is changed, the system-FB 
capacity other than that grows or 
shrinks.

Set whether to make a buffer when
changing each memory, etc.



3-11

Section 3  System Definition

2)		SPH2000 series (NP1PM-256E)
�� Click the [Memory allocation setting] tab on the “CPU parameter” dialog box. The [Memory allocation setting] tab page opens.

				Make the settings for non-retain memory and other types of memory.

�� Click the [Default] button on the [Memory allocation setting] tab page when you want to reset to default values.

If the memory size is changed, 
the non-retain general memory 
and memory selected via the 
automatic calculation button 
become a buffer, increasing or 
decreasingin size.

In the example of the right figure, 
when the normal memory size, 
multi-CPU non-retain memory, 
multi-CPU retain memory, or 
user FB memory is changed, the 
system FB memory selected via 
the automatic calculation button 
automatically grows or shrinks.

In the example of the right figure, 
when the size of the retain 
memory, or user FB normal 
memory is changed, the system 
FB normal memory selected via 
the automatic calculation button 
automatically grows or shrinks.

Set whether to make a 
buffer when changing 
each memory, etc.

�� To change the number of edge detection, counter, addition timer or timer points, click the [Detail] button. The “Detail of system 
				FB memory” dialog box opens. By clicking the corresponding tab, display the “Detail of system FB memory” screen or “Detail 	
				of system FB normal memory” window.
				On this dialog box, change the number of points of each item. When you change the number, the value of “Other system FB 	
				area” on the lower part of the screen is changed. Click the [OK] button to complete the setting.
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<Note>
With V07 or later software version of NP1PM-256E, the memory arrangement has been changed for high-speed access of the 
system FB memory.
In the user FB memory and system FB memory, the user FB normal memory and system FB normal memory are accessible at 
high speed. When using user FBs, the user FB normal memory and system FB normal memory are used first.

��When using V6 or earlier software version of NP1PM-256E, check “A CPU before V06 is used.” 
				If checked, the following dialog box appears.

�� Click the [OK] button to complete the setting.
Note:		When using V6 or earlier software version of NP1PM-256E, be sure to check this option. Otherwise, programs cannot be 	
									loaded to the CPU.

Software version of NP1PM-256E

V06 or earlier Not supported (conventional mode)

V07 or later High-speed access supported
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(2)	 I/O group setting
Specify which task in which CPU controls input/output modules in the configuration.
This setting is important for the CPU module to access the input and output of the modules.
		* When system definition is finished without I/O group setting, the I/O modules are automatically registered in the default task 	
				and a warning message appears.

�� Click the [I/O group setting] tab in the “CPU parameter” dialog box. The “I/O Group Setting” tab page opens.

Specify output as reference input. For details, 
refer to <Input for referring output value>.

Click this button to register the 
modules selected in the I/O List.

Module output can be registered on a point basis. 
For registration procedure, refer to <Output detail setting>.

�� Select (click) a module from the I/O List and then click the register button. The selected module is registered.

�� Register all the modules to be controlled and then click the [OK] button.
*	It not possible to assign the same output to more than two CPUs or tasks.

Registered module

Only the modules occupying the input and output areas out of the modules 
registered on the system definition screen are displayed in the “I/O List.”

Select a task. Only the tasks under “Tasks” in the project tree are displayed.



3-14

Section 3  System Definition

<Standard setting>
When only one CPU is registered in the configuration and only the “DEFAULT” task controls I/O, modules can be registered in a 
batch.

�� Select “DEFAULT” for Level and then click the [Standard setting] button. The modules are automatically registered to the 		
				Input select box and the Output select box.

Note 1:		Modules having input/output area, such as a high-speed counter and a positioning module, need to be registered in both 	
												the [Input select] list box and the [Output select] list box.
Note 2: 	In a multi-CPU system configuration, to reference output modules registered for other CPU modules, register the output 	
												modules in the [Input select] list box. Output modules that have already been registered in the [Output select] list box of 	
												another CPU module cannot be registered.

[Input select] list box

[Output select] list box
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<Output detail setting>
In a multi-CPU system configuration, which CPU controls the module output can be specified on a bit or word basis.

�� Select a module for “output detail setting” from [Output select] and then click the [Detail] button.

��When the digital output module is selected, the “Port mode IO Detail Setting” dialog box opens.

All bits are selected by default.

�� Click and set OFF the button corresponding to the bit to be controlled by another CPU.
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Note 1:		The dialog box displayed when you click the [Detail] button differs according to the selected module.

<When the digital output module with pulse train output is selected>

<When the analog output module is selected>

Note 2:	If you select a module that does not support “output detail setting,” the dialog box for detail setting does not appear even 	
											if you click the [Detail] button.
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<Input for referring output value>
In a multi-CPU system configuration, if you want to use the output of an output module used by another CPU as “Input” in an 
application program of the local CPU, register the bit or word to “Input select” for the I/O group of the local CPU.
Note:	This function can be used only for an output module that is actually mounted. For output modules registered as “no 		
								equipment,” the output memory (Y) does not work on a program of the local CPU. 	

�� Select the output module to be referenced, click the [>>] button to register it to “Input select”.  

�� Click the [Input for referring output value] button. The “Port mode IO Detail Setting” dialog box appears.

All bits are selected by default.

�� Click and set OFF the button corresponding to the bit without output value reference..

Bit with output value reference

�� Click the [OK] button.
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Note:		When referencing analog output or other output values, setting on a word basis is required.
									In this case, the “Memory mode IO Detail Setting” dialog box appears.
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(3)	 Fail-soft operation setting
Even if a failure occurs in a module or unit on the SX bus and remote I/O (such as T-link), operations of other normal modules 
and units are continued. This operation is referred to as “fail-soft” operation

�� Click the [Fail-Soft Operation Setting] tab in the “CPU parameter” dialog box. The “Fail-Soft Operation Setting” tab page opens.

�� Select a module for fail-soft operation setting and then click the [Register] button.

For example, when RT1:TLINK-00 is registered, 
all modules on the extension unit are registered.

�� After registering the modules for fail-soft operation setting, click the [OK] button.
Note:		For expansion units on a remote I/O, fail-soft operation is registered for each unit. Fail-soft operation cannot be registered 	
									in units of modules.

[Register] button

[Batch registration] button

[Reset] button

[Batch reset] button



3-20

Section 3  System Definition

3-1-3	 System Property
On the System properties dialog box, “System Running Definition”, “Redundancy setting”, and “Fail-soft operation setting” can 
be specified. The following describes the procedure for setting system running definition and fail-soft operation setting.

(1)	 System running definition
The system running definition includes SX bus tact time setting, configuration check wait time setting, and initialization mode 
selection.

1)		SX bus tact time
				The SX bus tact time refers to the interval of data communication with modules (such as an I/O module) connected to the SX 	
				bus.
				For SX bus tact, select 0.5, 1, 1.5, 2, 2.5, ... 9.5, and 10ms. The default value is 1.0ms.

2)		Waiting time for structure check
				When the power of the system is turned on, the CPU module starts configuration check of all modules on the SX bus.
				When all the modules has been activated within the time specified as “Waiting time for structure check”, the system starts. 		
				When the system consists of multiple bases and the power of each base is turned on at different timing, adjust the tact time 		
				with “Waiting time for structure check.”
				(The default value of “Waiting time for structure check” is 20 seconds. It can be specified within a range from 1 to 180 seconds.)

3) 	Waiting time mode for structure check
    	Wait structure agreement : Wait structure matches to actual system until “Waiting time for structure check” time.
    	Wait specified time : Wait until “Waiting time for structure check” time.
    * This item is enabled in SPH200/300 only.

4)		Initialization method
				When the power of the system is turned on, the CPU module is initialized. This setting allows you to specify whether CPU 		
				module internal memory diagnosis is performed or not.

5) 	Start up system without CPU “0”
				This setting allows you to specify whether the system is started up when “0” station does not exist in a system such as a 		
				redundant system.
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Set the SX bus tact time.

Set the waiting time for structure check.

Select the initialization method.

�� Set each item and then click the [OK] button.

Specify whether to start up the system without CPU “0”.

�� Select “System properties” in the system definition screen and then click the [Properties] button.
				The “System Running Definition” tab page of the “System properties” dialog box opens.
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(2)	 Fail-soft operation setting
Even if some modules (modules under fail-soft operation, such as a servo module) cannot be powered on at the startup of the 
MICREX-SX system, the system can start up excluding such modules after the configuration check waiting time has elapsed. In 
this case, the system starts operation in the nonfatal fault condition.

�� Click the [Fail-soft operation setting] tab in the “System properties” dialog box. The “Fail-soft operation setting” tab page opens.

�� If there is any device under system fail-soft operation, select “Partial Fail-soft start up” and then enter the SX bus station 		
				number from which fail-soft operation is to be started.

�� Click the [OK] button.
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(3)	 System redundancy definition
If a failure occurs in a working CPU module, the standby CPU operates to continue PLC system operation. This configuration is 
referred to as CPU redundancy.

<Overview of redundant system>
1-to-1 redundant system
1-to-1 redundant CPU system has one standby CPU for one working CPU. Each of CPU0-CPU1, CPU2-CPU3, CPU4-CPU5, 
and CPU6-CPU7 indicates a pair of a working CPU and a standby CPU. Therefore, when building a multi-CPU 1-to-1 redundant 	
system, up to four pairs of CPUs can be installed. The same application program must be downloaded to a working CPU and a 
standby CPU.

<Example of redundant system configuration>
Generally, the working CPU and standby CPU are mounted on different base boards and other modules to be controlled by 
the CPU are mounted on another base board, as shown below. If the working CPU fails and the standby CPU starts operation 
instead, this 	configuration enables you to replace the failed CPU while the standby CPU is operating.

Note:		It is also possible to build a redundant system with an working CPU and a standby CPU mounted on the same base 		
									board. In this case, however, the standby CPU module cannot be replaced during system operation.

CPU 0 CPU 1

Empty slot
* On the base board mounting the CPU, only the power supply and CPU are mounted.
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<System redundancy definition>
1)		Module registration
Register modules and units that are actually mounted in the same manner as usual systems.

�� Register modules according to the actual system configuration, as shown below.

For the CPU module that functions as Standby CPU 
by default, select “Standby CPU” for Resource name.
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2)		System redundancy definition
On the “Redundancy setting” screen of the “System properties” dialog box, select ON or OFF of redundancy and set details of 
redundancy.

�� Select “System properties” on the system definition screen and then click the [Properties] button. The “System properties” 		
				dialog box appears.

[Properties] button

�� Click the [Redundancy setting] tab on the “System property” dialog box. The “Redundancy setting” tab page opens. Set each 	
				item and then click the [OK] button.

Select redundancy ON or OFF.

Make detail setting for redundancy.
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<Settings for redundancy system>
Settings for 1-to-1 redundant system are shown below. In a 1-to-1 redundant system, which CPU is paired with which one is 
predetermined and up to four pairs can be specified.

Select a pair of CPUs for 1-to-1 redundancy. 
Which CPU is paired with which one is 
predetermined as shown below.

Specify the memory copy range for the case of warm standby 
system with 1-to-1 redundancy. The range from the top of the  
memory area to the size specified here is the copy range.

Specify whether interlock selection is made or 
not in a multi-CPU system configuration.

Select the standby mode.
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3-1-4	 Address inversion setting
This function inverses I/O addresses and P/PE-link bit addresses (0 bit n F bit) displayed in the program or data monitor window.
<Use example 1>
When a MICREX-F series I/O is connected to the SX series T-link and you want to match the bit numbers of the I/O (terminal) 
with those of the CPU (program).
<Use example 2>
When SX and MICREX-F series are mixed in a P/PE-link system and you want to match the bit addresses viewed from 
MICREX-F with those in SX.

<Setting example>
On the system definition screen, click [Edit] menu > [Bit Inversion Setting].

The “Bit Inversion Setting” dialog box opens.
When “The background of the device is inversion display.” is checked, the device addresses are inversely displayed. In the 
following example, this option is checked.
•	Example of “Bit Inversion Setting” screen of I/O

Check the modules the address of which you want to inverse.
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•	Example of “Bit Inversion Setting” screen of P-link
The target is high-speed 1 area. Select block Nos. that you want to inverse assuming that 1 block equals to 32 words. In the 		
following example, the bit memory (M8.0 to M8.31F) of the block 0 (WM8.0 to WM8.31) is inversed.

•	Example of “Bit Inversion Setting” screen of PE-link
The target is high-speed 1 area. Select block Nos. that you want to inverse assuming that 1 block equals to 8 words. In the 		
following example, the bit memory (M9.0 to M9.7F) of the block 0 (WM9.0 to WM9.7) is inversed.
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<Example of address inversion>
When address inversion setting has been made, the target I/O memories and P/PE-link memories are inversely displayed as 
shown below.

•	Example of inversion display of ladder

•	Example of inversion display of data monitor
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<Special notes>
The address inversion function only inverses the display of addresses on the ladder screen and data monitor screen of the 
loader. Note that the actual memory addresses are not inversed.

MSB LSB
Actual bit address X1.0.F X1.0.E ·  ·  · X1.0.1 X1.0.0
Address inversion is not set X1.0.F X1.0.E ·  ·  · X1.0.1 X1.0.0
Address inversion is set X1.0.0 X1.0.1 ·  ·  · X1.0.E X1.0.E

Enter actual bit addresses on the ladder screen and data monitor screen.
When you enter a contact address “X1.0.F” for which address inversion is set, “X1.0.0” must be entered actually as shown 
below.
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3-1-5	 Bus tact Time check function
This function calculates a bus tact recommendation value in the loader according to the configuration set in the system definition.

�� On the system definition screen, click [Tool] menu > [Bus tact Time check].

�� The check result is displayed.

•	Apply a Applies the check result to the SX bus tact of the system property.
				Note:		When using a periodic task, make sure that the period time must be a multiple of the bus tact. 
													When using the constant scan function, make sure that the set scan time must be a multiple of the bus tact. 

•	OK a Closes the check result window.
•	Memo a Starts the note pad and pastes the check result in it. 
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3-2	 System Definition of SPB Series
The following items are specified in the system definition of SPB series.

*	This subsection describes the procedure of setting system definition. For more details of setting items of system definition, 		
		refer to the user’s manual “Instruction (FEH202).”

3-2-1	 Registering Units
(1)	 Unit registration
With the MICREX-SX, you need to register all the units to be used under one configuration.
The following explains module registration procedures using the sample system configuration below.

<Sample system configuration>

Units registration 

CPU running definition 

Memory allocation 

I/O group setting 

High-speed counter 

I/O running mode 

� Explained in “3-2-2 Basic unit parameter setting”. 

Registration of units to be used 

Basic unit parameters 

Explained in “3-2-1 Registering units”.

MEM/BAT

ALM

RUN

PWR

RS‑232C

SND

RCV

Basic unit with 40 I/O points Analog unit

RS-232C communication adapter

Expansion unit with 16 I/O points
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�� Double-click “System Definition” in the project tree.  The system definition screen opens.

	Register units sequentially from the right of the basic unit in their connected order.					   
				Select the basic unit and then click the [Insert] button. The [Module insert] dialog box opens.

[Insert] button

Select a unit.

Select the module type.

Set module parameters.

Select the insertion position of module.



3-34

Section 3  System Definition

�� Select the unit (NW0AX04-MR: Analog Input 4CH) according to the actual configuration. Units’ station numbers are 		
				automatically determined according to their connected order. When you select a unit and then click the [OK] button, the unit 		
				is registered.

�� Register units in the same manner. 
				Since only one communication adapter can be connected on the left side of the basic unit in a single SPB system, its station 	
				number is fixed to “8”.

* The communication adapter is registered at the bottom of the system definition screen regardless of the registered order.
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3-2-2	 Basic unit parameter setting
The basic unit parameter setting includes five setting items: “CPU running definition,” “Memory allocation setting,” “I/O group 
setting,” “HI Counter Definition,” and “I/O Running mode”.

(1)	 CPU running definition
	Select the CPU for parameter setting on the system definition screen and then click the [Properties] button. 			 
				The “Basic unit parameter” dialog box opens.
				The dialog box consists of five tab pages. Click the corresponding tab to open.
				The “CPU running definition” status opens first. Set all necessary items.
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(2)	 Memory allocation setting
��When you click the “Memory allocation setting” tab, the screen opens. Set all necessary items.

(3)	 I/O group setting
��When you click the “I/O group setting” tab, the following screen opens. 

				Each unit registered in the system definition is automatically assigned to “DEFAULT” task. 
				Set all necessary items.
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(5)	 I/O running mode
��When you click the “I/O Running mode” tab, the following screen opens. 

				Set all necessary items.

�� After setting each parameter of the basic unit, click the [OK] button to complete the setting.

(4)	 High-speed counter setting
��When you click the “HI Counter Definition” tab, the following screen opens. 

				Set all necessary items.
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This section explains the functions associated with print. 
The print commands are as follows.

•	[Page setup]: Sets a page to print a project.
•	[Print]: Prints a project.
•	[Print preview]: Previews to print a project.

* 1	 Install the printer driver to use the print function
* 2		It is not possible to print “I/O device list”,  “Device usage”, “Device Cross reference” and “Initial setting list” with this function. 	
					To print them, output a text file (csv format) by using the [Export] command in the [Project] menu, and open the file in Excel, 	
					and then print it.

4-1	 Page Setup
	Click [File] menu > [Page Setup]. The following dialog box opens. Set paper size, orientation, margin, etc.
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4-2	 Print
	Click [File] menu > [Print]. The following dialog box opens.
				Choose a printer, print items, the range, and the number, and then click the [OK] button to start printing. 
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(1)	 Print items
Print items are as follows.

•	Program
•	System definition
•	Project tree
•	Project properties
•	AFB ladder

If you click the [Detail] button, you can perform the detailed settings.

(1)-1			Program
Items checked in the “Program List” are printed.

•	[Monochrome Printing]: 
							Forcibly performs monochrome printing of a program. When “black and white” is selected in the printer settings and a 		
							program is printed, X and Y addresses, which are displayed in red on the screen, are difficult to see when printed. By 		
							selecting “Monochrome Printing,” the character color is forcibly changed to black to make a program easier to see when 		
							printed.

•	[Protect Line Breakup]:
						 A line is printed on the next page to avoid printing on the current and next pages.

•	[Print Line number in each section]:
						 If this option is unchecked, for line numbers (line number displayed to the left of each row), serial numbers starting with “0” 	
							are printed for each program, regardless of “SECTION” instructions. If this option is checked, serial numbers starting with “0” 
							are printed for each part delimited by “SECTION” instruction.
							Regardless of whether this option is checked, when there is “SECTION” instructions in a program, the program is delimited  
							by them and each part is automatically printed on different pages.							     

•	[Include Cross Reference]:
							Adds cross reference to every line and print it. Choose “Grid style” or “In-circuit style.”

•	[Address Rows] : 
							Select Hide or 1 to 12 Rows.

•	[Tag Rows] : 
							Select Hide or 1 to 12 Rows. By switching between “Display Tag” and “Display Description,” description can be printed 		
							instead of tags.
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<Printing cross reference>
An example of printing cross reference is shown below.

•	When “Grid style” is selected and “Print Line number in each section” is unchecked

•	When “Grid style” is selected and “Print Line number in each section” is checked

In the example above, “N1” indicates the No. 
of SECTION instruction and a number after “:” 
indicates line No. in the SECTION.
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•	When “In-circuit style” is selected and “Print Line number in each section” is unchecked

•	When “In-circuit style” is selected and “Print Line number in each section” is checked

Target for printing on the input side Target for printing on the output side

In the example above, “PG(0)” indicates the 
program No. displayed in the project view and 
a number in the lower row indicates line No.

In the example above, “PG(0)” indicates the 
program No. displayed in the project view, the 
number in the lower row “N1” indicates the No. 
of SECTION instruction, and a number after “:” 
indicates line No. in the SECTION.



4-6

Section 4  Print

(1)-2 		System definition
There is no setting item for system definition.

(1)-3 		Project tree

•	Calling relationship of Functions / Function Blocks: When using FBs, the interaction between the program and FB is printed.
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(1)-4 		Program property
The program properties of the items whose box is checked in the “Program List” are printed. The program properties include the 
following information.

•	Program Name
•	Program No.
•	Type (Kind)
•	Use of enable flag (ENO)
•	Local device setup information
•	Parameter list (only functions and function blocks)
•	Array/structure declaration
•	Information on memory in function blocks (only function blocks)
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(1)-5 		AFB Ladder
The items checked in the AFB ladder program list are printed.

(2)	 Page (print range)
Choose “All” (print all pages) or “Page appointment” (specify the target range to print). When you choose “Page appointment,” 
use the preview function to confirm the print image.

For these setting items, refer to “(1)-1 Program.”
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4-3	 Print Preview
�� Click [File] menu > [Print Preview]. The “Print preview” screen opens.

 				Icon

•	[Print]: Executes printing.
•	[Zoom]: Zooms in the preview screen.
•	[Consolidation]: Chooses the number of screens from 1/2/3/4/6. 
•	[Close]: Closes the print preview screen.

Print

Consolidation

Zoom

Close



4-10

Section 4  Print

4-4	 Circuit Print
This function is used to print a program by specifying the print range in units of lines on the screen.

�� Open a program that you want to print, and drag the circuit No. part on the left side to select the lines. Then, right-click and 		
				select “Circuit Print.”

Drag this part.

�� The “Print” dialog box opens. Select a printer, and then click the [OK] button. The selected lines are printed.
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The SX control utility allows MICREX-SX system I/O and internal memory monitoring, data change, and data backup without 
starting the loader. This utility can also be used for I/O check in a system where no project is downloaded to the CPU module.

Appendix 1-1	 Starting SX Control Utility
�� Click [Start] of Windows > [All Programs] > [SX-Programmer Standard V3] > [Tools] > [SX Control Utility].

				* Alternatively, you can click [Tools] menu > [SX Control Utility] on the loader.

��When the SX control utility is started, the following message appears.

�� Click the [OK] button. The dialog box to confirm reading of the system configuration appears.

�� Click the [OK] button to read the system configuration from the connected CPU module.
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	Click the [Yes] button to display the screen and start monitoring.
				Click the [No] button to display the screen without starting monitoring.

Note 1:	For a CPU module with no system definitions registered, the following message appears. The SX control utility recognizes 
											the I/O modules of the connected system, creates system definitions, and downloads them.

�� Click the [OK] button to create and download the system definitions to the CPU. Then, the following message appears.

�� Click the [OK] button, reset the CPU, and then use the SX control utility.

Note 2:	If communications with the CPU are not established when the SX control utility is started, the following message appears. 
											In this case, check the connections with the CPU and communication settings for the SX control utility.
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Appendix 1-2	 SX Control Utility Window

Select the memory type. Menu

1) Mark display area 2) Address display area 3) Data display area

Tool button4)		Monitor status display

1)		Mark display area
•	Displays the mark settings.

				When a mark is set for an address, this area shows a marker (O in light blue).
•	Displays the reference input specification for output address.

				When an output area has been defined as the reference input in I/O group setting of the system definitions, “R” is added to 		
				the address.

2)		Address display area
Displays the addresses in the CPU memory in the order of CPU numbers and addresses. If the corresponding address has not 
been registered to an I/O group, it is not displayed. Modules registered as “no equipment” are displayed regardless of whether 
the I/O group setting is made, however, the binary display area is grayed out.

3) 	Data display area
•	Binary display area

				Displays binary data of the memory related to “Address display area.”
		<Detailed display of I/O group definition> 
				This area also displays detailed information of I/O group settings. Bits for which I/O groups have been set are displayed in the 	
				ordinary character display color (black) and the ones for which no I/O groups have been set are displayed in gray.

•	Forcible set status display (valid only when forcible ON/OFF display is set)
				Bits set for forcible ON/OFF are displayed with an underscore (red).

•	Decimal display area
				Displays decimal data of the I/O module related to “Address display area.”
				(The data type can be selected from signed integer, unsigned integer, or real number.)

•	Hexadecimal display area
				Displays hexadecimal data of the I/O module related to “Address display area.”

•	Time display area
				The data that corresponds to the data in the address display area is displayed in time format (selectable from “T” (ms), 		
				“D” (year, month and day), “TOD” (hour, minute and second) and “DT” (year, month, day, hour, minute and second)).

•	String display area
				The data that corresponds to the data in the address display area is displayed in the form of character string (STRING type).

4)		Monitor status display
Displays the monitor status (stopped or running).
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Appendix 1-3	 SX Control Utility Operations
(1) 	Setting monitor ON/OFF
Start or stop monitoring.

�� Start or stop monitoring by clicking the  [Monitor] button or  [Monitor (force having)] button.

When monitoring is started by clicking the [Monitor (force having)] 
button, the bits that are forcibly set ON/OFF are displayed with an 
underscore in the binary data display area.

(2) 	Setting bit data
You can overwrite or forcibly set/reset (force ON/OFF) bit data in the binary data display area. Force ON/OFF is valid only for 
actually existent I/O memories.

�� Select a bit to set and click one of the following buttons: 
				  [Bits ON],  [Bits OFF],  [Force set], and  [Force reset].

�� To release the forcibly set/reset I/O, select the forcibly set bit and click the  [Force release] button. To clear multiple I/Os 		
				set/reset forcibly, click [Data change] menu > [Force] > [Batch release].
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(3)	 Setting word data (16- or 32-bit data)
You can overwrite data on the word data in the decimal or hexadecimal display area on the “SX Control Utility” window.

�� Click the decimal or hexadecimal display area of the memory to be overwritten, set decimal or hexadecimal data in 		
				accordance with the display area, and press the <Enter> key.

Set data

*	Double-word data can also be set by switching word/double-word display by the  [16-bits display] and  [32-bits display] 		
		buttons.

*
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(4)	 Batch data change
You can change the data in multiple memories in a batch.
Note:		Since data are set in a batch offline and then transferred to the CPU, you need to stop the CPU to use this function.

�� Stop the monitoring on the SX control utility.

�� Set data.

Data set in a batch

�� Transfer the set data to the CPU. Click [Data change] menu > [Move to PLC...]. The “Move to PLC” dialog box appears.

�� Select the data transfer destination CPU and click the [OK] button. The following confirmation dialog box appears. Click the 		
				[OK] button to transfer the data to the CPU.

*	For a multiple-CPU configuration, select the CPU to which the data is transferred.

Click the [OK] button to complete the transfer operation.



App.1-7

Appendix 1	 SX Control Utility

Appendix 1-4	 CPU Memory Backup
The SX control utility can store backup data files (*.bup) for program memory, data memory, system definitions, etc. from the 
CPU into the computer.
Note:		Backup files for programs and system definitions cannot be opened with the loader. Data stored in files are in SX-specific 		
									machine code.

(1)	 Data backup
Transfer the data in the CPU module to the computer.

�� Stop the monitoring and click [Tool] menu > [BackUp]. The [Backup] dialog box opens.
�� Set the transfer source CPU and the transfer destination file, and then select the backup data type from the list box.

Transferring from backup file to the CPU is also 
available by specifying a backup file as the transfer 
source and the CPU as the transfer destination.

Click the [Browse...] button to display 
the [Browse] dialog box and specify 
the transfer destination file.

�� The backup range in the data memory area can be specified. When you select a data memory, the [Range setting...] button 		
				is enabled. Click it to display the “Range setting” dialog box. On this dialog box, specify the range and click the [OK] button.
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�� Select the transfer source, transfer destination, and backup data, and then click the [Execution]. The following confirmation 		
				dialog appears. Click the [OK] button to start data transfer.

��When data transfer is completed, the dialog box appears, showing the transfer results.

(2)	 Data verify
You can compare the contents of the memory in the CPU with those of the backup file.

�� On the [Backup] dialog box, select “Verify,” and then select the verification source file, verification destination CPU, and 		
				data type to be verified. Then, click the [Execution] button.

�� The following confirmation dialog box appears. Click the [OK] button to start verification.



App.1-9

Appendix 1	 SX Control Utility

��When verification is completed, the dialog box appears, showing the verification results.

(3)	 Backup text file input/output function
You can save backup data as text files and display or edit the saved data with a commercially available text editor or spreadsheet 
program.

�� First, read backup files that have been created with the [BackUp] command in the [Tool] menu.
				Click [File] menu > [Open backup file...].  The “Open backup file” dialog box opens.

�� After selecting a backup file, click the [Open] button. The selected backup file is opened.
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�� Then, click [File] menu > [Save as...]. The following dialog box opens. Check “Save the memory area data by the text form,” 	
				enter a file name for the file to be saved, and then click the [Save] button. The backup data is saved in the file, in the “tab 
				delimited text” format.

<Saved file name and folder>
By the operations explained above, a folder and a file are created in the following structure.

Arbitrary folder

Backup file name.bup

Backup file name

SYSDEF01.BDF

SYSDEF02.BDF

MTER_1.TXT

MTER_2.TXT

RMTER_1.TXT

RMTER_2.TXT

SYSDEF03.BDF

SMTER_1.TXT

SMTER_2.TXT

TEXT

Binary data file group
 The binary files that have been created with the 
 backup function are saved in this folder.

Text data file group
 The text files that have been created with the backup function 
 are saved in this (TEXT) folder.
 The following data are created:
  Non-retain memory: MTER_n.TXT
  Retain memory: RMTER_n.TXT
  System memory file: SMTER_n.TXT
If address range exceeds 32k words, the data is divided in units of 
32k words.  Accordingly, the number of files differs depending on the 
size of individual backup memory size.  For example, when the size 
of non-retain memory is 128k words, maximum 4 files can be saved 
in the non-retain memory.
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<Format of created text file>
The created text file is delimited by tabs in the following format.
*	The figure shown below is an example when a file is opened with a text editor.
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The system software utility is used to change the mode of supported programming language to “SX-mode” that conforms to IEC 
61131-3, an international standard, or to update the SPB firmware.
(SPB is set to “N-mode” at shipment.)
* The Board controller (SPB) is fixed to “SX-mode” and does not support “N-mode.”  Therefore, the system software 	 	
		utility is not required.

<Necessary system configuration>

<Operating procedure>
�� Click [Start] of Windows > [All Programs] > [SX-Programmer Standard V3] > [Tools] > [System Software Utility] to start the 		

				system software utility.

Note: Be sure to end other application programs before this utility is executed.

�� Close other application programs, and then click the [OK] button. The currently connected SPB is checked, and then the 		
				following dialog box appears.  (This checking takes approximately 18 seconds at the maximum.)

The status of currently 
connected SPB is displayed.

The system software to be updated is set. 
Set [Mode] to “SPB SX-mode”.

MEM/BAT 
ALM 
RUN 
PWR 

Standard loader V10.** or later versions of SPB 

Loader cable
 Converter: NP4H-CVU (USB connection) or
                     NW0H-CNV (RS-232C connection)
 Cable: Type: NW0H-CA3 (3 m long)

*For loader cable, either NN-CNV1 or NN-CNV3 can be used. 
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�� Click the [System software Update Execution] button. The following confirmation dialog box appears.
				When an application program exists in the SPB, make a backup copy of it as needed.

�� Click the [Yes [Y]] button to start the update of the system software.

��When the update is completed successfully, the following dialog box appears.  
				Click the [OK] button to finish the operation.

*	If the update does not finish successfully, change the setting of the baud rate and re-execute the update.

Note: 	Be careful not to turn off the power switch of 	
									the system or disconnect the power cable 	
									while system software is being updated.
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Appendix 3-1	 Specifications of Simulation Function
The simulation has the following functions:

•	Monitoring function in the ladder screen *
•	Monitoring and data setting functions in data display/setting dialog *
•	Simulation panel function
•	Auto feedback function

*	Operation and display specifications are the same as those of the online monitor.

Appendix 3-1-1	 Screen configuration at simulation
In the following example, the ladder screen and the simulation panel are displayed for simulation.

*	On the simulation panel, you can arrange push buttons for simulation and graphical objects for data setting/display to make 		
		simulation operation easier.

Ladder screen

Simulation panel
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Appendix 3-1-2	 Specifications of simulation function

Note 1:		This simulation function is used to check program logic operations. It does not allow process simulation of the entire 		
												system. 
Note 2:		The accuracy of the timer is not ensured.
Note 3:		About the simulation panel and AFB screen
												(a)		A simulation panel can be used by online connection with PLC actual device. However, it has to follow the actual 		
																	device operation on I/O address (X, Y).
												(b)	 AFB program is only valid during simulating. When programs are transferred to PLC actual device, AFB program is 	
																	not transferred.
Note 4:		Even if simulation is stopped, contents of all memories are hold. If you want to clear them, stop simulation and then 		
												click [Clear] button to clear.

Specification and function Description

Simulation target User program registered to tasks
* User functions and user function blocks need to be used by the user program.

Restrictions on instructions

1) Below FBs have some restrictions.
M_OPEN, M_SEND, M_RECEIVE, R_READ, R_WRITE, F_READ, F_WRITE
For more details, refer to “Appendix3-1-3 Details of instruction operation restrictions.

2) As for expansion FBs provided by Fuji Electric, simulation cannot be performed normally.

Operation at FB monitoring The path currently being used is displayed during monitoring of FBs currently being called
(used) by multiple locations.

Simulation panel
Graphic objects are arranged in the Simulation tab page, allowing easy simulation operation.
Graphic objects which can be arranged include “label”, “button”, “switch”, “lamp”,..
For more details, refer to “Appendix 3-2-2 Using simulation panel.”

Auto feedback screen
Allows creation of a circuit for automatic response to the AFB (auto feedback) tab page.
Only one AFB tab can be used for on project.
For more details, refer to “Appendix 3-2-3 Using auto feedback (AFB).”
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Appendix 3-1-3	 Details of instruction operation restrictions
Since the Standard loader performs the simulation function in the offline mode, operations are restricted with respect to 
communication-related FBs requiring a remote site to communicate with.

(1)	 M_OPEN,  M_SEND, M_RECEIVE, R_READ, R_WRITE
When these FBs are executed, only parameter check is performed. If the parameters have no error, they work properly. (The 
completion bit of the FB is set ON.) No data is transferred.
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Appendix 3-2	 Simulation Procedure
Appendix 3-2-1	 Basic simulation procedure
This subsection describes how to simulate a created program.

�� Click [Online] menu > [Simulation Mode]. “SX Simulator” starts up.

�� Click [Slot 0]. The “Select CPU Module” dialog box opens. Choose a CPU module to use, and click the [OK] button.

�� The CPU is assigned to the simulator.
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�� Click [Online] menu > [PLC Operation]. The following dialog box opens. Transfer programs to the PLC. 
				(The operation is same as online.)

Note1)

Note 1:		In the simulation mode, the retain memory area and FB/SFB memory area are cleared when a program is transferred 		
												even if these options are unchecked.
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�� Click [Online] menu > [Monitor]. The program window is placed into a monitoring state.
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Appendix 3-2-2	 Using simulation panel
Use the simulation panel to make simulation easier.

Label

Button Lamp Slider

(1) Objects which can be used in the simulation panel
Ten different objects can be arranged at any position in the simulation panel.

Label

Timer/Counter

1)		Label
This button is used to create characters. You can specify the character font, size, and color.

<Label setting dialog box>
Main setting items on the label dialog box are shown below.

Timer/counter

Slider

Edit

Indicator

Switch
Button

Ellipse

Rectangle

Line

Set font type and font size.

Set color.

Define label name.
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2)		Line
This button is used to create lines. You can specify the color and width.

<Line setting dialog box>
Main setting items on the line dialog box are shown below.

Specify line color.

Specify line width.

3)	Rectangle
This button is used to create rectangles. You can specify the color and width.

<Rectangle setting dialog box>
Main setting items on the rectangle dialog box are shown below.

Specify color inside frame.

Specify frame color.

Specify frame width.
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4)		Ellipse
This button is used to create ellipses. You can specify the color and width.

<Ellipse setting dialog box>
Main setting items on the ellipse dialog box are shown below.

Specify color inside frame.

Specify frame color.

Specify frame width.

5)		Button
This button is used to create a button which turns on when clicked.
You can specify a bit device (mandatory) to be assigned to the button, button name, button operation (momentary or alternate).

<Button setting dialog box>
Main setting items on the button setting dialog box are shown below.

Specify address of the bit device which turns on when the button is clicked.

Specify operation when the button is clicked. (The default setting is momentary.)

Enter name of the button.

Specify font color. 

Specify font, size etc.



App.3-10

Appendix 3	 Simulator Function

6)		Switch
This button is used to create a slide switch which turns on when clicked and off when clicked again.
You can specify a bit device (mandatory) to be assigned to the button, switch size, button type (horizontal slide or vertical slide), 
and button name.

<Switch setting dialog box>
Main setting items on the switch setting dialog box are shown below.

Specify address of the bit device which turns on when the button is clicked.

Choose  button operation 
    Horizontal 
    Vertical

7)		Indicator
This button is used to create a Indicator which displays the ON/OFF status of the specified bit device.
You can specify a bit device (mandatory) to be assigned to the Indicator, color when ON.

<Indicator setting dialog box>
Main setting items on the Indicator setting dialog box are shown below.

Enter address of the bit device.

Specify color when the lamp is ON (device ON).
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8)		Edit
This button is used to show / enter data  for specific device in word or double-word.
You can specify device address and data type (mandatory).

<Edit setting dialog box>
Main setting items on the edit setting dialog box are shown below.

Enter address of the device. (Word / Double-word)

Specify data type (INT/ DINT/ WORD/ DWORD, etc).

9)		Slider
This button is used to set data to specific device in word or double-word.
You can specify device address, data type (mandatory), minimum value, maximum value, and color.

<Slider setting dialog box>
Main setting items on the slider setting dialog are shown below.

Enter address of the device. (Word / Double-word)

Specify data type (INT/ DINT/ WORD/ DWORD, etc).

Enter Maximum value

Enter Minimum value

Specify color
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10)		Timer/Counter
This button is used to create a display box which displays the setting and current value of a specified timer or counter.
In addition to settings of the timer/counter to be displayed (mandatory), you can specify the display color at the time of time-up 
(count-up). The display box has two rows and the setting is displayed in the lower row and the current value in the upper one.

<Timer/counter setting dialog box>
Main setting items on the timer/counter setting dialog box are shown below.

Specify address of the timer/counter (mandatory).

Specify program using the assigned timer/counter (mandatory).

Specify color of the box at time-up/count-up.

Specify task (Default/ Fixed/ Event)
using the assigned timer/counter (mandatory).
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(2) 	How to create the simulation panel
The following describes how to create a button, indicator, and timer display in the simulation panel as shown below.

Button Indicator Timer display

�� Right-click “Simulation” in the project view window, and click [Insert] > [Insert Simulation Panel].

�� Simulation panel opens.

�� The following dialog box opens. Click the [OK] button.
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�� Create a button first. Click the [Button] button, move the mouse pointer to the simulation panel and left-click it. The button is 	
				arranged 	as shown below.

�� Double-click the arranged button, and properties of the button are displayed. Enter the address of the button and the  		
				characters displayed on the button, and then click the [Close] button.

Enter address

Enter button name

�� The button setting is now complete.

�� To change the size of a button, drag the “Handle” (the square dots) around the button. (Lamp, Timer/Counter etc. can be 		
				changed in the same manner.) 
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�� Then, create a Indicator. Click the [Indicator] button, and move the mouse pointer to the simulation panel, and left-click it. The 	
				indicator is arranged as shown below.

Enter address

�� Double-click the arranged indicator, and properties of the indicator are displayed. Enter the address of the indicator, and click 	
				the [Close] button.

�� The indicator setting is now complete.
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�� Create a timer next. Click the [Timer/Counter] button, move the mouse pointer to the simulation panel and left-click it. The 		
				timer is arranged as shown below.

Enter address

�� The timer setting is now complete.

Choose the program using timer from list

�� Double-click the arranged timer, and properties of the timer are displayed. Enter the address of the timer, and click the [Close] 
				button.
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(3)	 Simulation operation program
The following simple circuit was created for simulation operation check.

(4)	 Simulation operation check
After you create the simulation panel and simulation program, perform simulation.
Following the procedure described in Appendix 3-2-1, start the simulator, transfer the program, and perform monitoring.

��When you click the “Start” button, the indicator goes on (in red) allowing the timer current value to be monitored.

Timer setting value

Timer current value
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Appendix 3-2-3	 Using auto feedback (AFB)
The auto feedback function is used to automate simulation of the created program.
For example, to perform simulation of communications with external devices, when the signal or program turns ON and the 
program created in auto feedback outputs a value to a desired device, simulation can be automated for improved efficiency.

(1) 	Creating an auto feedback circuit
Create an auto feedback circuit that receives the value of a desired device (except local devices) of the program under 
simulation, performs calculation, and returns a value to the simulation program.

�� Right-click the “Simulation” in the project view window. Click [Insert] > [Insert AFB].

��  The following dialog box opens. Click the [OK] button.

�� The AFB screen opens. 
				You can edit the AFB screen is the manner as the general program edit screen.
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�� Here, create the following circuit that receives a signal from “simulation operation program” in Appendix 3-2-2 (3), starts the 		
				timer, then returns the bit signal.

<Operation>
When this circuit receives the ON signal (M0 turns on for one scan) from the simulation operation program, the re-triggerable 
timer (T0) is activated. The re-triggerable timer is a timer that captures a rising edge of the input signal and turns ON the timer 
output bit for specified time interval. With this circuit, when the specified time interval has elapsed, the timer output turns OFF 
and then M2 (feedback signal to the simulation program) turns ON only for one scan.
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(2)	 Changing the simulation program
Change the “simulation operation program” in Appendix 3-2-2 (3) so that the program exchanges signals with the auto feedback 
circuit.

<Changes>
1) 	Add contact M2 so that the on-delay timer (T0) starts when the feedback signal (M2 turns ON for one scan) is received from 	
				the auto feedback circuit.
2) 	Add a line which transfers the count-up signal of timer T0 to the auto feedback circuit.
    	Since on-delay timer T0 is a local device and therefore cannot be transferred to the auto feedback line as it is (T0), T0 is 		
				output to M1 and M1 is transferred to the auto feedback circuit.

(3)	 Checking auto feedback operation
After preparing the circuits (1) and (2) and a simulation panel by following Appendix 3-2-2 (2), execute the following procedure to 
perform simulation.
	1)	 	Start up simulation mode.
	2)		Transfer and reset programs.
	3)		Start up monitor.

Click the button [X1.0] on the simulation panel once.
The on-delay timer (T0) of the program for the simulation and the re-triggerable timer (T0) of the auto feedback circuit operate in 
alternate.

1)

2)
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Array can handle multiple word data (or bit data, or double-word data) as one data block. 
Structure can handle combination of bit, word, double-word as one data block.
To use Array/ Structure, you need to define Array/ Structure. For more details, refer to Appendix 4-2.
Then, declare Array/ Structure.  For more details, refer to Appendix 4-3.
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Appendix 4-1	 Specification of Arrays/Structures

Note 1:	Definitions and declarations of arrays and structures are stored in the program memory of the CPU. The amount of 		
											program memory used by arrays and structures is obtained by the following equation.	
											[Equation]
											(Program memory used by arrays and structures)
											= 4 + (No. of array definitions) x 5 + (Structure 0   No. of steps of definition) + .... + (Structure n  No. of steps of definition)
											+ (No. of declarations of arrays and structures) x 7
											* No. of steps of structure definition = (No. of members) + 3 (steps)
											[Sample calculation]
											Supposing,

•	No. of array definitions: 3,
•	Structure 0 (No. of members: 10)
•	Structure 1 (No. of members: 5)
•	No. of declarations of arrays and structures: 5

												then
												(Program memory used by arrays and structures) = 4 + (3 x 5) + (10 + 3) + (5 + 3) + (5 x 7) = 75 steps
Note 2:	The system memory (SM), timer (T), counter (C), integrating timer (TR) and step control (SC) are not available.
Note 3:	Information about definitions and declarations of arrays and structures is stored in the last user function No. which the 		
											CPU can obtain (SPH300: No. 511) and then in the program memory of the CPU. Therefore, when using arrays and 		
											structures, the last user function No. (SPH300: No. 511) cannot be used.

Item Specification

Nesting depth 1 level (array of arrays, array of structures)

Array

Max. No. of definitions 512 (User program: 256, Expansion FB provided by Fuji: 256) (Note 1)

Max. No. of elements 32767 (16384 for 32 bit data type)

Element No. specification

1 to specified No. of elements
No. of elements: max. 32767 (16384 for 32 bit data type)
* When element No. specification exceeds the range, upper limit or lower limit data is
   accessed.

Max. No. of declarations 583 (Note 1)
* “Declaration” means assigning a defined array to an address.

Data type Bit, word, double word, array (defined by user)

Array name ARY_n   n : array definition No. (from 0 (decimal))

Available memories
(Note 2)

Entire program: I/O memory (W, Y), standard memory (M), retain memory (L)

Inside of user FB: I/O memory (X, Y), standard memory (M), retain memory (L),
                             memory for user FB (F), parameter (V), (I/O parameter only)

Structure

Max. No. of definitions 512 (User program: 256, Expansion FB provided by Fuji: 256)   (Note 1)

Max. No. of members 255

Data type of member Bit, word, double word, array (defined by user)

Structure name STR_n   n : structure definition No. (from 0 (decimal))

Member name specification

Member name indicating sign + member definition No. (from 1)
* The member name definition No. is automatically assigned when the structure is  
  defined.
Member name identifying sign: R (bit), WR (word), DR (Double word ), ARY_n (Array)

Max. No. of declarations 584 (When No. of members: 1 and No. of structure definitions: 1) (Note 1)
* “Declaration” means assigning a defined structure to an address.

Available memories
(Note 2)

Entire program: I/O memory (W, Y), standard memory (M), retain memory (L)

Inside of user FB: I/O memory (X, Y), standard memory (M), retain memory (L),
                             Memory for user FB (F), parameter (V), (I/O parameter only)
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Appendix 4-2	 Definition of Arrays/ Structures
�� Right-click “Arrays/Struct” in the project view, and then click [Open]. The “Arrays/Structures” view and the “Array/Structure 		

			declares” list are displayed.

Appendix 4-2-1	 Array definition
�� Right-click the array in the “Array/Structures” view, and click [Add array definition].

[Array/ Structure] view [Array/ Structure declaration] list

�� The following dialog box opens. Set the number of array elements and data type, and then click the [OK] button.

* When you set array of arrays, choose the defined array from the data type.

�� An array is defined.
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Appendix 4-2-2	 Structure definition
�� Right-click the structures in the “Array/Structures” view, and click [Add structure definition].

�� The structure (STR_0) and the first element (R1) are defined.

�� The following dialog box opens. Choose the data type of the first element of the structures, and click the [OK] button.

�� Define the second element of the structure. Right-click the first element, and click [Insert member of structure].

�� The second element (WR2) is defined.

�� The following dialog box opens. Choose the data type of the second element of the structure, and click [OK].

�� Define the third and later elements in the same manner.
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Appendix 4-3	 Array/Structure Declaration
Assignment of a defined array or structure to an actual address is called “declaration.” Execute array/structure declaration on the 
“Array/Structure declares” list.

�� Enter the top address on the “Array/Structure declares” list. And then, choose the defined array/structure from the “Array/		
				Structure” list. When moving the mouse to another row, the range of the address is calculated and displayed automatically.

*	Setting of the top address:
		When setting arrays of double-word and structures, set the top address as even number.
		When setting arrays of bit, set the top address as 0 bit.
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Appendix 4-4	 Array/Structure Expression on Programs 
On application programs, arrays and structures are represented as shown below.

[Array]

WM100[5]

Top address
Array element No.

[Array of arrays]

WM100[5][WM0]

Top address
Array element No.

Array element No.

[Array of structures]

WM100. WR2[3]

Top address
Member name

Array element No.

[Structure]

WM100. WR2

Top address
Member name
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Appendix 4-5	 Importing Array/Structure Definition
Import the array/structure definition in another project. If there is the definition that has the same name as the one to import, the 
definition is automatically imported under a different name. 

�� Click [Project] menu > [Import] > [Arrays/Structure]. The following dialog box opens. 
				Click the [Select file] button, and select the file to import.
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�� The array/structure declaration is listed. Check the items to import and click the [OK] button.

	When the import is completed, the following message appears.
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*	Users can change definition numbers or delete definitions of expansion FBs.

To change Array/Structure numbers, right-click an array or a structure in the “Arrays/Structures” view.

Appendix 4-6	 Array/Structure Number
A number is assigned to Arrays/Structures.

Array/Structure numbers are classified as shown in the table below to avoid overlap between numbers used in “user program” 
and numbers used in “expansion FB” provided by Fuji.

Item User program Expansion FB

Array/structure No. that can be defined 0 to 255 256 to 511

Array/structure No. that can be used for declaration 0 to 511 0 to 511

Array No. that can be specified for data type of array 0 to 511 0 to 511

Array No. that can be specified for data type of structure member 0 to 511 0 to 511
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<Overview>
There are two types of passwords. You can choose to use either one of them. Password target is PLC. Set a password while the 
loader is connected to the PLC.

1) 	Standard password
				If the standard password is set, the following operations are disabled: reading of a program from the PLC, loading of a 		
				program to the PLC, PLC program change, and PLC program verification.
2) 3-level access restriction
				Depending on the access level set by the user, PLC operations (Start/Stop, Load program, Read program, Change program, 	
				etc.) are restricted. The 3-level access restriction function is supported by SPH300, SPB, and Board controller [SPB]. To set 	
				this function, you need to stop the PLC.

The password for user ROM is also available. For more details, refer to 2-7-1.
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�� Click [Online] > [PLC operation]. The following dialog box opens. Click the [Password] button to open “Password” dialog box.

Authentication: If a password is set to the PLC, click this button to perform authentication by the password.
Registration/Change: This button is used to set a new password, or change the set password.
Clear: This button is used to delete the set password.
Restriction Setting: This button is used to make detailed settings for 3-level access restriction function.

The key icon color shown on the “Password” dialog box indicates the password status.

Gray: Password is not registered.

Orange: Password is registered, and password is not authenticated.

Green: Password is registered, and password is authenticated.
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Appendix 5-1	 Standard password
Appendix 5-1-1	 Registering password
Click the [Registration/Change] button. The “Registration/Change” dialog box opens. Enter a password and click the [OK] button.

* Set the password from 6 to 32 alphanumeric characters and symbols (+, -, =, /).
  	Uncheck “Access level effective.” If this option is checked, the 3-level access restriction function is enabled.

�� The password is registered.

At this moment, the password is authenticated, and program change or other operations are enabled. Once you close the 
project window, authentication is reset, and program change or other operations are disabled. To perform these operations, you 
need to enter the password.
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Appendix 5-1-2	 Password authentication
Password authentication procedure differs depending on whether the project file is opened or not.

(1)	 When the project file is closed
�� Click [Online] menu > [PLC operation]. The following dialog box opens. Click the [Password] button to open the “Password” 		

				dialog box.

 The key icon is shown in orange because the password is registered and not authenticated. Click the [Authentication] button.

�� The “Authentication” dialog box appears. Enter the password and click the [OK] button.

�� If the password is correct, the password is authenticated, and the key icon changes to green. Click the [Close] button.
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(2)	 When the project file is opened
�� Click [Online] menu > [PLC operation]. The following dialog box opens. Click the [Password] button to open the “Password” 		

				dialog box.

�� The key icon is shown in orange because the password is registered and not authenticated. Click the [Authentication] button.

�� The “Authentication” dialog appears. Enter the password and click the [OK] button.

�� If the password is correct, the password is authenticated, and the key icon changes to green. Click the [Close] button.
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Appendix 5-1-3	 Changing password
Before the password is changed, password authentication (refer to Appendix 5-1-2) is necessary. The procedure differs depending 
on whether the project file is opened or not.

(1)	 When the project file is closed
�� Click [Online] menu > [PLC operation]. The following dialog box opens. Click the [Load from PLC] button to read the program.

�� After reading the program, click [Online] menu > [PLC operation]. The following dialog box opens. After this, the procedure is 	
				same as “When project file is opened.”
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(2) When the project file is opened
�� Click [Online] menu > [PLC operation]. The following dialog box opens. Click the [Password] button to open the “Password” 		

				dialog box.

 The “Registration/Change” dialog box appears. Enter a new password and click the [OK] button.

�� The new password is registered.

�� The “Password” dialog box appears. Click the [Registration/Change] button.
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Appendix 5-1-4	 Clearing password
Before the password is cleared, password authentication (refer to Appendix 5-1-2) is necessary. The procedure differs depending 
on whether the project file is opened or not.

(1) 	When project file is closed.
�� Click [Online] menu > [PLC operation]. The following dialog box opens. Click the [Load from PLC] button to read the program.

�� After reading the program, click [Online] menu > [PLC operation]. The following dialog box opens. After this, the procedure is 	
				same as “When the project file is opened.”
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(2) 	When project file is opened.
�� Click [Online] menu > [PLC operation]. The following dialog box opens. Click the [Password] button to open the “Password” 		

				dialog box.

�� The following confirmation dialog box appears. Click the [Yes] button.

�� The password is cleared, and the key icon changes to gray. Click the [Close] button.

 The “Password” dialog box opens. Click the [Clear] button.
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<Differences between standard password and this function>
The standard password function aims to maintain confidentiality and avoid falsification of projects. 
It contains online access restriction function, however, it only protects projects on the loader; the PLC itself cannot be protected.
In addition, only one password can be set, therefore, it is not possible to set multiple access levels.

Appendix 5-2	 3-level Access Restriction Function
Appendix 5-2-1	 Overview
The 3-level access restriction function restricts operations to the PLC at 3 different levels by setting passwords for access 
authentication. Users can change the range of access restrictions.

Level 3
User

Level 3
User

Level 3
User

Level 2
User

Level 2
User

Level 1
User

Level 2 � For maintenance (Rights of level 3 are not given.)

Level 1
(Password authentication is not required.)

Level 3 � For administrator (No restriction)

No password

Level 3 password

Level 2 password
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Appendix 5-2-2	 Specifications of 3-level Access Restriction Function
(1)	 Target CPU
The 3-level access restriction function is supported by SPH300, SPB and Board Controller [SPB].

(2) 	Operating range for each access level
Available operations of Standard loader for each level (default) are shown below.
Note:		For access restrictions that are not on the list below, use the standard password function.

*	For the shaded items (in        ) on the list above, access restriction setting cannot be changed.

Note:		If you clear a program or system definition, all passwords are cleared.

Function Level 3 Level 2 Level 1

Load

Program a a x
System definition / module driver a x x
Data / ZIP file / parameter data a a x

Download changes to PLC a a x

User ROM

Loading of project a a x
Write-protection a a x
Export of user ROM file to text file a a x
Writing of tag project a a x
Import of tag project a a x

Monitor a a a

Data modify a a x
PLC information a a a

Task execution time measurement a x x

Memory clear
(Note)

Program a x x
System definition / data / ZIP file / resource initialization a a x

Memory transfer a a x
PLC calendar display a a a

PLC calendar setting a a x

Debug
Breakpoint / step execution
forcible ON/OFF
Program operation / condition monitor / sampling trace

a a x

Redundancy control Switch between active and standby CPUs a a x
PLC run/stop a a x

SX control utility

Backup - Transfer (PLC to file) a a x
Backup - Transfer (file to PLC) a x x
Backup - Verify a a a

Data change - Transfer to PLC a a x

Password

Level 3   password setting a x x
Level 2   password setting a a x
Password clear a x x
Access restriction setting a x x

Failure diagnosis a a a
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(3)	 Functions to manage password
Operations required to manage the password (“Registration”, “Authentication”, “Change” and “Clear”) and the authority to 
perform them are as follows:

*	Effective duration of password authentication
		Once password authentication is completed, it is effective until the project file is closed.

Function Access level Authority

1) Registration
The password is registered for
the PLC.

Level 3 user or
No password
registered

Allowed to register passwords for level 3 and level 2.

Level 2 user Allowed to register only a password for level 2.

Level 1 user Not allowed.

2) Authentication (logon)
Logon operation to allow 
operations to the PLC.

Level 3 user By performing password authentication for each level,
operations for each level are allowed.
* If password authentication is not performed, access level 1 is provided.Level 2 user

Level 1 user

3) Change
The registered password is 
changed.

Level 3 user Allowed to change passwords for level 3 and level 2.

Level 2 user Allowed to change a password for level 2.

Level 1 user Not allowed.

4) Clear
All registered passwords are 
cleared.

Level 3 user Allowed to clear passwords for level 3 and level 2.

Level 2 user Not allowed.

Level 1 user Not allowed.

5) Restriction setting
Operations for each level can be
individually enabled/disabled.

Level 3 user Allowed to change access restriction.

Level 2 user Not allowed.

Level 1 user Not allowed.
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Appendix 5-2-3	 Operation procedure
Appendix 5-2-3-1	 Registering password

�� Click [Registration/Change] button on the “Password” dialog box. The “Registration/Change” dialog box opens. Check “Access 
				level effective,” and you can enter level 3 and level 2 passwords. After entering passwords, click the [OK] button.
* To register a password, stop the PLC.

* Set the password from 6 to 32 alphanumeric characters and symbols (+, -, =, /).
  	Check “Access level effective.” If this option is unchecked, the standard password function is enabled.
 		It is possible to register only the level 3 password. (impossible to register only the level 2 password)

�� The password is registered.

At this moment, the password is authenticated, and program change or other operations are enabled. Once you close the 
project file, authentication is reset, and the access level is changed to level 1 (Lowest level).
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<Password registration patterns and access level>

Note:		If the same password is set for level 2 and level 3, access is allowed at level 2 after authentication. If you want to access 	
									at level 3, set different passwords for level 2 and level 3.							     

No. Password registration pattern Authentication and access level after authentication

1 No password No restriction (Level 3)

2 Password is registered.
(Access level is not effective.)

Authentication is performed with the registered password.
g No restriction (Level 3)

Password authentication is not performed.
g Access rights when no password is entered in the
    Standard password function

3 Only password for level 3 is registered.
(Access level is effective.)

Authentication is performed with the registered password for
level 3.
g No restriction (Level 3)

Password authentication is not performed.
g Level 2 access right

4 Passwords for level 3 and level 2 are registered.
(Access level is effective.)

Authentication is performed with the registered password for
level 3.
g No restriction (Level 3)

Authentication is performed with the registered password for
level 2.
g Level 2 access right

Password authentication is not performed.
g Level 1 access right
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Appendix 5-2-3-2	 Password authentication
The password authentication procedure differs depending on whether the project file is opened or not.

(1)	 When the project file is closed
�� Click [Online] menu > [PLC operation]. The following dialog box opens. Click the [Password] button to open the “Password” 		

				dialog box.

�� The key icon is shown in orange because the password is registered and not authenticated. Click the [Authentication] button.

�� The “Authentication” dialog box opens. Enter the level 2 or level 3 password and click the [OK] button. (In this example, the 		
				level	3 password is entered.)

�� If the password is correct, the password is authenticated, and the key icon changes to green. Click the [Close] button.

* Indicates “Level 1” when password authentication 	
		has not been completed (initial state).
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(2)	 When the project file is opened
�� Click [Online] menu > [PLC operation]. The following dialog box opens. Click the [Password] button to open the “Password” 		

				dialog box.

�� The key icon is shown in orange because the password is registered and not authenticated. Click the [Authentication] button.

�� The “Authentication” dialog box opens. Enter the level 2 or level 3 password and click the [OK] button. (In this example, the 		
				level	3 password is entered.)

�� If the password is correct, the password is authenticated, and the key icon changes to green. Click the [Close] button.

* Indicates “Level 1” when password authentication 	
		has not been completed (initial state).
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Appendix 5-2-3-3	 Changing password
Before the password is changed, password authentication (see Appendix 5-2-3-2) is necessary. The procedure differs depending 
on whether the project file is opened or not.
* To change the password, stop the PLC.

(1)	 When project file is closed.
�� Click [Online] menu > [PLC operation]. The following dialog box opens. Click the [Load from PLC] button to read the program.

�� After reading the program, click [Online] menu > [PLC operation]. The following dialog box opens. After this, the procedure is 	
				same as “When the project file is opened.”
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(2)	 When the project file is opened
�� Click [Online] menu > [PLC operation]. The following dialog box opens. Click the [Password] button to open the “Password” 		

				dialog box.

�� The “Registration/Change” dialog box opens. Enter a new password and click the [OK] button.

�� If the PLC is running, the following dialog box appears. Click the [Yes] button to stop the PLC and set the new password.

�� The “Password” dialog box opens. Click the [Registration/Change] button.
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Appendix 5-2-3-4	 Clearing password
Before the password is cleared, password authentication at the level 3 is necessary. (Level 2 cannot clear the password.)  The 
procedure differs depending on whether the project file is opened or not.
* To clear the password, stop the PLC.

(1)	 When project file is closed.
�� Click [Online] menu > [PLC operation]. The following dialog box opens. Click the [Load from PLC] button to read the program.

�� After reading the program, click [Online] menu > [PLC operation]. The following dialog box opens. After this, the procedure is 	
				same as “When the project file is opened.”
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(2)	 When the project file is opened
�� Click [Online] menu > [PLC operation]. The following dialog box opens. Click the [Password] button to open the “Password” 		

				dialog box.

�� The “Password” dialog box opens. Click the [Clear] button.

�� If the PLC is running, the following dialog box appears. Click the [Yes] button to stop the PLC and clear the password.
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Appendix 5-2-4	 Changing access restriction setting
The currently set restrictions of online operations can be changed. Only the users with access level 3 can use this function. 
After performing password authentication, follow the procedure below. The procedure differs depending on whether the project 
file is opened or not.
* To change the access restriction setting, stop the PLC.

(1)	 When the project file is closed
�� Click [Online] menu > [PLC operation]. The following dialog box opens. Click the [Load from PLC] button to read the program.

�� After reading the program, click [Online] menu > [PLC operation]. The following dialog box opens. After this, the procedure is 	
				same as “When the project file is opened.”
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�� The “Access Restriction Setting” dialog box opens.

(2)	 When the project file is opened
�� Click [Online] menu > [PLC operation]. The following dialog box opens. Click the [Password] button to open the “Password” 		

				dialog box.

�� The “Password” dialog box opens. Click the [Registration/Change] button.
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�� Select the access level to be changed, and then check functions to enable or uncheck functions to disable.

*	Check the checkbox of
   the functions to access.

�� After completing the setting, click the [OK] button.
		*	The setting contents are transferred to the PLC when the [OK] button is clicked. If the PLC is running, the following dialog box 	
				appears.

<Checking set items>
�� Click the [Confirm Setup] button on the “Access Restriction Setting” dialog box to open the following window. You can check 	

				the current setting status.
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<Initializing set items>
�� Click the [Default] button on the “Access Restriction Setting” dialog box. The following dialog box appears. Click the [OK] 		

				button to reset the access restriction settings.

* For the default setting of the access restriction, refer to the table in “Appendix 5-2-2.”

<Exporting settings>
The settings of the selected access level can be saved under an arbitrary filename. (The extension is “.ARI”.)
You can export the saved file and use it as a kind of template.

�� In the “Access Level” list box on the “Access Restriction Setting” dialog box, select the access level to save in a file, and then 	
				click the [Export] button. The “Export” dialog box opens.

�� Enter a file name and click the [Save] button.
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<Importing settings>
You can import access restriction settings saved by the export function.

�� In the “Access Level” list box on the “Access Restriction Setting” dialog box, select the access level to import, and then click 	
				the [Import] button. The “Import” dialog box opens.

�� Select a file to import and click the [Open] button.
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Appendix 5-3	 Notes on Use
(1)	 When you forget password
If you forget the password, access at level 2 and level 3 is impossible.

(2)	 Position of key switch
Set the key switch of the CPU module to the “TERM” position. If the switch is set at the “RUN” or “STOP” position, you cannot 
register a password.

(3)	 State of PLC
When the PLC is in the following states, you cannot register a password for the access level 2 or 3.

•	When the program and system definition have not been downloaded
•	When the breakpoint function is used
•	When the condition monitor function is used
•	When the sampling trace function is used
•	When a user ROM card is write-protected
•	When in a N-to-1 redundant system

When a function No. where a password is stored has already been used
					The function No. where the password is stored depends on the PLC type.
					SPH300: 510,  SPB: 14,  Board controller [SPB] : 510

(4)	 Consumption of program memory
When registering passwords for access level 3 and level 2, 33 steps of program memory is consumed. If there is not 33 steps or 
more available space in the program memory, you cannot register a password. 
In addition, when a program with maximum steps is downloaded to the PLC in which a password with the access level 2 or 3 is 
registered, the 3-level access restriction function is disabled and changed to the standard password function.

(5)	 Loading program
A project that uses the following No. cannot be loaded to the PLC for which a password of 3-level access restriction function is set:	
				SPH300: 510,  SPB: 14,  Board controller [SPB] : 510

(6)	 Setting password with user ROM utility
You cannot set a password of the 3-level access restriction function for the user ROM with the user ROM utility. To set a 
password for the user ROM, mount it on the PLC, set the key switch to the “UROM-TERM” position, and then set a password for 
the PLC.

(7)	 Setting password in multi-CPU system
In a multi-CPU system, set a password for each CPU. When you want to register the same password for all the CPUs, set it for 
each CPU.
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Appendix 6-1	 Overview of ST Language
Appendix 6-1-1	 ST operators
Operators that can be used in ST language are listed below:

*	Take note of data types available in each operator.

Appendix 6-1-2	 ST statements
The following eight control statements are used in ST language.

No. Operation Operator Example

1 Parentheses (expression)

2
Function Function name 

(parameter)
WM1 := BCD(WM0);
WL100 := BMOV(WL0, 5);

3 Exponentiation ** DM100 := DM0 ** REAL#3.0;

4 Logical not NOT Y2.0 := NOT X1.0;

5 Multiplication * DM10 := DM8 * DINT#1000;

6 Division / DM12 := DM12 / DINT#3;

7 Division remainder MOD WL10 := WM0 MOD 10;

8 Addition + WM2 := WM0 + WM1;

9 Subtraction - WM3 := WM2 - 100;

10 Comparison <, >, <=, >= M0 := WM100 > 100;

11 Equality = M1 := DM100 = DINT#10000;

12 Inequality < > M2 := WL200 <> 1000;

13 Logical Product &, AND M3 := M1 & X1.0;

14 Exclusive or XOR WM100 := WM99 XOR WL100;

15 Logical add OR WM0 := WX1.0 OR 16#00FF;

Format Description

:=
Assignment statement.
Assigns the value of the expression, variable, or numeric value on the right-hand side to the variable on 
the left-hand side.

IF Condition statement.
Executes the executable statement if the conditional expression is true.

CASE Condition statement.
Selects the executable statement to be executed according to the value of the conditional expression.

FOR Iteration statement.
Repeatedly executes the executable statement according to the initial value, final value, and
incremental or decremental value.

WHILE Iteration statement.
Repeatedly executes the executable statement while the loop condition is true.

REPEAT Iteration statement.
Repeatedly executes the executable statement until the loop condition is true.

RETURN Return statement.
Returns control from the called function or function block to the calling POU.

EXIT Exit statement.
Used to exit an iteration loop.
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Appendix 6-1-3	 Basic description specifications
(1)	 Basic syntax of instruction
The describing method in ST language is as follows:

(2)	 Example of describing a multi-operation
In the Standard loader, monomial expressions are used for the representation of expressions. Therefore, a multi-operation that 
uses multiple operators must be described as follows:

Device  :=   Device   or   Constant   or   Expression   ;

Semicolon

<Sample programs>

ST language representation  Ladder language representation

WM0  :=  WM1;
Example of memory address

Y2.0  :=  X1.0;
Example of memory address

WM0  := 1000;
Example of constant

WM7  :=  WM5 + WM6;
Example of expression

WM3  :=  BCD (WM2);
Example of expression (function)

Example of multi-operation 

(WM0 + WM1 + WM2) / 3 = WM3 

ST language representation

WM3  :=  WM0 + WM1;
WM3  :=  WM3 + WM2;
WM3  :=  WM3 / 3;

* To change multi-operation to single-operation, use “Multi operation input wizard.”  Refer to Appendix 6-3-2.
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(3)	 Example of describing a sequential circuit
Sequential circuits can also be described in ST language.

(4)	 Describing a comment
A comment is created above an instruction line.

ST language representationSample sequential circuit

Example of AND circuit

Example of OR circuit

Example of latching circuit

M2 := M0 & M1 ;(     )
M0 M1 M2

M2 := M0 OR M1 ;(     )
M0

M1

M2

MF := M0 OR M2 ;

ME := NOT M1 ;

M2 := MF & ME ;

(     )
M0 M1

M2

M2

MF ME

Auxiliary relay

��

(*Execute processing when M0 is turned ON*)

IF  M0 = TRUE THEN 

  WL100 := WL101 + 100 ;

END_IF ;

IF  M0 = TRUE THEN 

  

WL100 := WL101 + 100 ;

END_IF ;

Note: When creating a comment on the right of an instruction line:

(*Execute processing when M0 is turned ON*)

� A comment is created above an instruction line.

� When a comment is created on the 
    right of an instruction line, by confirming 
    the edit of the ST editor, the comment is 
    relocated below the circuit.
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Appendix 6-2	 How to Use Control Statements
Appendix 6-2-1	 Condition statements
The condition statement is a control statement to execute the selected instruction (executable statement) if certain conditions 
are met. Two types of condition statements, the IF statement and CASE statement, are provided.

(1)	 IF statement
For the IF statement, three types of syntaxes are provided according to the option to be executed.
<1) IF...THEN structure>
When the value of the conditional expression is TRUE, the executable statement is evaluated (executed). When the value of the 
conditional expression is FALSE, nothing is executed.

* 	For the “conditional expression”, a monomial expression whose operation result is a BOOL type value can be used. If you 		
			want to designate an operation result of a multi-operation as the condition, program as shown in the sample program 4. 

IF <conditional expression> THEN 

  <executable statement>;

END_IF;
Conditional
expression

Executable
statement

FALSE

TRUE

<Basic syntax> <Flowchart>

IF  M0 = FALSE THEN 

  WL100 := WL101 + 100 ;

END_IF ;

IF  WL101 < 99 THEN 

  WL100 := WL101 + 100 ;

END_IF ;

IF  M0 = TRUE THEN 

  WL100 := WL101 + 100 ;

END_IF ;

<Sample program 1>
When M0 is ON, the conditions are met and 
the operation of “WL101 + 100 = WL100” is
executed.

<Sample program 2>
When M0 is OFF, the conditions are met and 
the operation of “WL101 + 100 = WL100” is 
executed.

<Sample program 3>
When WL101 is less than 99, the conditions 
are met and the operation of “WL101 + 100 
= WL100” is executed.

<Sample program 4>
When WL101 is “50 < WL 101 < 99”
the conditions are met and the operation 
of “WL101 + 100 = WL100” is executed.

M0 := WL101 > 50 ;

M1 := WL101 < 99 ;

M2 := M0 AND M1 ;

IF  M2 = TRUE THEN 

  WL100 := WL101 + 100 ;

END_IF ;

,
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< 2) IF...ELSE structure (choice between two) >
When the value of the conditional expression is “TRUE”, the executable statement 1 is evaluated and when the value is “FALSE”, 
the executable statement 2 is evaluated.

< 3) IF...ELSIF structure >
When the value of the conditional expression 1 is “TRUE”, the executable statement 1 is evaluated. When the value is “FALSE”, 
the next conditional statement 2 is evaluated. Then, when the value of the conditional expression 2 is “TRUE”, the executable 
statement 2 is evaluated. When the value is “FALSE”, the conditional statement 3 is evaluated next. Thus, selectively branched 
processing can be realized.

IF <conditional expression> THEN 

  <executable statement 1>;

ELSE 

  <executable statement 2>;

END_IF;

Conditional
expression

Executable
statement 1

Executable
statement 2

FALSE

TRUE

<Basic syntax> <Flowchart>

IF <conditional expression 1> THEN 

  <executable statement 1>;

ELSIF <conditional expression 2>  THEN

  <executable statement 2>;

ELSIF <conditional expression3>  THEN 

  <executable statement 3>; 

    

        

ELSE

END_IF;

Conditional
expression 1

Conditional
expression 2

Conditional
expression 3

Executable
statement 1

Executable
statement 2

Executable
statement 3

FALSE

FALSE

FALSE

TRUE

TRUE

TRUE

<Basic syntax>

<Flowchart>
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(2)  CASE statement
The condition expression of the CASE statement is used when the executable statement is selected by a single INT type value.

<Method of expressing INT-type selection value>
INT-type selection values can be expressed by numeration or range.

•	Expression by numeration  Delimit the selection values with commas (,) to register.
•	Expression by range  Express the range with “..”.

CASE <conditional expression> OF

<INT type selection value 1>  :  

  <executable statement 1>;

<INT type selection value 2>  :  

  <executable statement 2>;

   

 

ELSE     

  <executable statement 3>;        

END_CASE;

=Selection
value 1 ?

=Selection
value 2 ?

=Selection
value n ?

Executable
statement 1

Executable
statement n

Executable
statement n+1

Executable
statement 2

YES

YES

YES

NO

NO

NO

<Basic syntax>

<Flowchart>

Example of selection values 
expressed by numeration

Example of selection values 
expressed by range
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Appendix 6-2-2	 Iteration control statements
The iteration statement is used to execute one or more instruction repeatedly according to a certain condition.

(1)	 FOR statement
The FOR statement repeatedly executes the instruction (executable statement) according to the iteration count (word address).

(2)	 WHILE statement
The WHILE statement repeatedly executes the executable statement while the value of the condition expression whose 
operation result is a BOOL type value is “TRUE”.

FOR <iteration count (word address)>  :=  <initial value>  TO  <final value>  BY  <incremental value>  DO

    <executable statement>;

END_FOR;

Iteration count
> final value

Iteration count (initial value)

Executable statement

Iteration count +
incremental value

FALSE

TRUE

* A determination whether the iteration count has reached the 
  final value or not is made before the executable statement. 
  Therefore, at the instant when the iteration count has exceeded 
  the final value, the next process begins.

Note: “-” (minus) cannot be used for the incremental value of the
          FOR statement. Be sure to prevent the result of the expression
          becoming a minus.

<Basic syntax>

<Flowchart>

WHILE <loop conditional expression>  DO

    <executable statement>;

END_WHILE;

Loop 
Conditional
expression

Executable statement

FALSE

TRUE

* Due to a loop, a determination is made before the executable 
statement. Therefore, if the value of the conditional expression
has been “FALSE” from the beginning, the executable statement 
is never processed.

<Basic syntax>

<Flowchart>
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(3)	 REPEAT statement
The REPEAT statement repeatedly executes the executable statement until the value of the final conditional expression 
becomes “TRUE”.

(4)	 EXIT statement
The EXIT statement is only used in the iteration control statement (FOR, WHILE, and REPEAT statement). If the EXIT statement 
is executed, the loop processing can be terminated halfway through.

Appendix 6-2-3	 RETURN statement
The RETURN statement is used in a user function or a user function block.
When the RETURN statement is executed, control is immediately returned from the user function or user function block to the 
main program.

<Flowchart of RETURN statement processing>

REPEAT

    <executable statement>;

    UNTIL  <final conditional expression>

END_REPEAT;

Final
conditional
expression

Executable statement

FALSE

TRUE

* In the REPEAT statement, a determination of the loop condition 
is made after the executable statement. Therefore, even if the 
final conditional expression is “TRUE” the executable statement 
is inevitably executed at least once.

,

<Basic syntax>

<Flowchart>

Processing time

User FB call Executing user FB

If M0 becomes “TRUE” 
in the user FB internal 
processing, the RETURN 
statement is executed and 
control is returned to the 
user FB calling program. 

If the RETURN statement 
has not executed, control 
is returned to the user FB 
calling program after the 
program in the user FB is 
executed until it is completed. 

IF M0 = TRUE THEN
    Y2.0 := TRUE;
    RETURN;
END_IF;

The processing time is shortened
by this length.
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Appendix 6-2-4	 Nesting structure of control statements
When another control statement is used in the control statement (condition statement or iteration statement), up to eight levels 
of nesting are allowed. (nesting structure)
<Example of nesting>
The following is an sample program of a function block operation that stores data in the INT-type array data from 1 to 100.

Note:		Although up to eight levels of nesting are allowed (guaranteed operation), the program may become complicated if the 		
									nesting is deep. Therefore, when you program, it is recommended that the nesting depth should be four of five levels at 		
									the deepest.

IF WM0=0 THEN
  M0 := TRUE;
END_IF;

IF M1=FALSE THEN
  WL100 := WL100 + 1;
  WL101 := WL101 + 2;
  M0 := FALSE;
 
  IF WL100 >= 100 THEN
     M1 := TRUE;
  END_IF;
END_IF;

IF X1.0 THEN
  WL100 := 1;
  
  FOR WL100:=1 TO 100 BY 1 DO
   WM100 := 0;
  END_FOR;

  (*File empty*)  
  M0 := TRUE;
  (*File full*)
  M1 := FALSE;
  WL100 := 0;
END_IF;

This is a nesting structure where another 
IF statement is used in a IF statement. 
(This is counted in the nesting depth.)

This is a nesting structure where a FOR 
statement is used in a IF statement. 
(This is counted in the nesting depth.)
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Appendix 6-3	 Operations of ST Language Editor
Appendix 6-3-1	 Basic operations
(1)	 Adding a program
To create a program in ST language, select “ST” for the language type when the program is inserted.

�� Select the position to insert a program in the project view window, and click [Edit] menu > [Insert Program]. The “Insert 		
				Program” dialog box opens. Enter a name, choose “ST” for the language, and then click the [OK] button.		
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(2)	 Programming
The basic operations for creating a program in ST language is explained below.

��Write a program in ST language on the program editing area.

	After writing a program, click [Conversion] menu > [Conversion]. The program is converted, and syntax check of ST language 	
				is also performed. If there is any syntax error, the error is displayed.

�� The program is added in the project view window.

Row No.

Program worksheet
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(3)	 Monitoring
A program created in ST language is monitored as shown below.

		*	For ST language programs, the device on the left of the assignment statement (:=) and, in the case of IF statement or WHILE 	
				statement, the leftmost device are monitored. In addition, for an FB or a function, the value of the device that is designated as 	
				the first operand is displayed.

Monitored value
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Appendix 6-3-2	 Applied operations
(1)	 Inserting an instruction using the wizard function
Control statements, FBs, functions can be inserted by using the wizard function.

�� Place the cursor on the row to insert an instruction and then press the <F10> key, the “Instruction Enter” dialog box opens. 		
				Select a instruction and click the [OK] button to insert it as shown below. In “(* *)”, the data type of the device to be entered is 	
				displayed.

Rewrite these with actual devices.
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(2)	 Multi operation input wizard
In ST language, multi operators cannot be described; however, it can be changed to monomial expression if you use “Multi 
operation input wizard.”

�� After entering multi operators on a worksheet, place the cursor on the row of multi operators. Click [Edit] menu > [Multi 		
				operation input wizard]. The “Multi operation input wizard” opens.

�� Assign the place displayed as “Tmp” to unused memory and then click the [OK] button.
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�� Multi operators are changed to monomial expression. The original multi operators are left as a comment.
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Appendix 6-3-3	 Restrictions on program creation in ST language
(1)	 Display and Edit

•	The indent is automatically adjusted to the fixed width.
•	Blank lines are cut down and not displayed.
•	A comment in a statement is displayed on another row.
•	A multi-operation using two or more operators cannot be created on a single row. Use multi operation input wizard.
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When using SPH2000/SPH3000 for replacement of MICREX-F series, various dedicated instructions (suffixed with “_MF”) are 
provided. Therefore, you do not need to read this section. Refer to “Convert Instructions (FEH588-1).
SPH200/SPH300 series do not support instructions with “_MF.” Refer to the following proposals for the instructions that cannot 
be converted by program conversion.

Also when replacing FLEX-PC, refer to the refer to the following proposals for the instructions that cannot be converted by 
program conversion.
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< MICREX-F series alternative proposal >

[Conversion Instructions]
		Character String

[File Instructions]
		Data Table Definition
		Data
		Data End
		File Information

[Program Control Instructions]
		Program Entry
		Program End
		Function Module Call
		Function Module Start
		Function Module End

[Index Register Control Instructions]
		Push
		Pop
		Load Effective
		Index Register Addition
		Index Register Subtraction

* Instruction without alternative method
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Character String

"Character String" instruction is not supported in SX-Programmer Standard. The alternative solution is explained.

1. The address is set by “PLC functions -> Initial data List”. The character string is input to the initial value.
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Data Table Definition/Data/Data End

"Data Table Definition/Data/Data End" instruction is not supported in SX-Programmer Standard. The alternative solution is 
explained.

"Data Table Definition/Data/Data End" is an instruction by which the user file used by the file instruction is registered as a data 
table, and data is set.

The data table differs from the file, and is an area only for reading.

In the alternative solution, it considers that the usual memory area is a data table, and the data between "Data Table Definition" 
and "Data End" is set.

Please transfer data by using "Move" instruction for a consecutive area in a usual memory area.

The characteristic only for reading has been achieved by always executing "Move" instruction.
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Data Table Definition/Data/Data End Program Alternative
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File Information

"File Information" instruction is not supported in SX-Programmer Standard. The alternative solution is explained.

"File Information" instruction" is an instruction to acquire the value of the changed file pointer if "FIFO" and "FIFO" instructions is 
executed.

The file pointer (word) is stored in the address of file area size +1 in the file area specified in First-In First-Out (FIFO) and first in 
last out (FILO), and acquire it in the transfer command, please.
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Program Entry/Program End

"Program Entry/Program End" instruction is not supported in SX-Programmer Standard. The alternative solution is explained.

<<MICREX-F>>
					|-------[PROG  N1: N2: N3 ]

"Program Entry/Program End" is an instruction to declare program initiation and the end.
The program is registered in the project window in SX-Programmer Standard. Right-clicks by the program composition of the 
project tree displayed in the project window. "Insert" is selected, and the program is registered.

It is necessary to allocate to the task of the project tree to execute the registered program.
Please register in the way according to the parameter of the program entry as follows.

N1=0:
		Please allocate in the default task.

N1=50:
		Please allocate in the fixed cycle task. at that time, please set the value of N2 in setting at the cycle.

N1=60 - 67:
		Please allocate in the event task.

N1=510:
		It is a block management division declaration not supported in SX-Programmer Standard. It is not possible to register.

N1=511:
		It is a block definition declaration not supported in SX-Programmer Standard. It is not possible to register.
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Function Module Call/Function Module Start/Function Module End

"Function Module Call/Function Module Start/Function Module End" instruction is not supported in SX-Programmer Standard. 
The alternative solution is explained.

1. "Function Module Call" can be substituted as a part call of the FB instance. Please set up the parameter set up by the DATA 	
				instruction of "Function Module Call" as parameter of part call of FB instance.

2. "Function Module Start" - "Function Module End" (Function module execution part) can be substituted as body section of the 	
				FB instance.
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Push/Pop

"Push/Pop" instruction is not supported in SX-Programmer Standard. The alternative solution is explained.

In "MICREX-SX", the memory cannot be designated index.

In alternative solution, the offset based on the address stored by load effective address is stored as virtual index register. The 
address is not stored. Therefore, it is necessary to understand the address which the user stored.

It is possible to use only up to five of I, j, k, l, m in MICREX-F. Therefore, processing by which the content of the index register is 
saved is needed. But, there is no necessity in MICREX-SX only it is to memorize the offset in a usual memory area.

Therefore, even if "Push instruction" is used, the content of the index register need not be saved. Please newly set and use a 
virtual index register for the memory area which can be used.

Please use a virtual index register before "Push instruction" is used if "Pop instruction" is used.

Virtual index register

Nothing is done.

New virtual index

Nothing is done.

Virtual index register before push

<<Example>>
<<MICREX-F>> <<Alternative solution>>
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Load Effective Address

"Load Effective Address" instruction is not supported in SX-Programmer Standard. The alternative solution is explained.

In "MICREX-SX", the memory cannot be designated index.
Therefore, a user needs to understand the address set as the index register.

1. 	At instruction alternatives, the memory area used as a virtual index register is initialized by 0.

2.		Please understand the address set in the index register by "MICREX-F".
				(When referring to the index register, it is needed.)
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Index Register Addition

"Index Register Addition" instruction is not supported in SX-Programmer Standard. The alternative solution is explained.

In "MICREX-SX", the memory cannot be designated index.
Therefore, a user needs to get to know the address set as the index register.

1.		At instruction alternatives, the memory area used as a virtual index register is added.
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Index Register Subtraction

"Index Register Subtraction" instruction is not supported in SX-Programmer Standard.
The alternative solution is explained.

In "MICREX-SX", the memory cannot be designated index.
Therefore, a user needs to get to know the address set as the index register.

1.		At instruction alternatives, the memory area used as a virtual index register is subtracted.
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Index Register Control Instructions Program Alternative
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Instruction without alternative method(MICREX-F)

There is not an alternative method of the following instructions.
•	Block Diagram
•	Conversion to Seconds (SEC)
•	Conversion from Seconds (TIM)
•	Disabled/Enabled interrupted (DI, EI)
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< FLEX-PC series alternative proposal >

[Basic Control Instructions]
		Direct Input/Output

[Program flow Instructions]
		Interruption pointer/End of Interrupt program
		User Macro Commands

[Comparison Instructions]
		Comparison
		Double Comparison

[Range Comparison Instructions]
		Range Comparison
		Double Range Comparison

[Transfer Instructions]
		8Bit Transfer
		Digit Transfer

[Rotate/Shift/32Bit Rotate Instructions]
		Rotate Right Carry n
		Rotate Left Carry n
		Double Rotate Right Carry n
		Double Rotate Left Carry n

[Step Control Instructions]
		Step Control

[Real Instructions]
		Real Comparison
		Real Range Comparison

[Time Instructions]
		Time Comparison
		Time Range Comparison

[Some instructions]
		Some instructions which can not be pasted

* Instruction without alternative method
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Direct Input/Output

"Direct Input/Output" instruction is not supported in SX-Programmer Standard. The alternative solution is explained.

1. 	The fixed cycle task is made according to the procedure of “Make of the fixed cycle task.”

2. 	In this case, please set the priority of the task setting as high as possible (cyclic 0>3>task).

3. 	Program made by processing 1 is arranged in the fixed cycle task according to the procedure of "Registration of the program".

4. 	The time of the SX bus baton is set according to the procedure of "Set of the time of the baton".
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Interruption pointer/End of Interrupt program

"Interruption pointer/End of Interrupt program" instruction is not supported in SX-Programmer Standard. The alternative solution 
is explained.

1. 	Make a program from "Interruption pointer" to " End of Interrupt program " into program. 

[In case of fixed-cycle interrupt]
2. The fixed cycle task is made according to the procedure of “Make of the fixed cycle task.”

3. Program made by processing 1 is arranged in the fixed cycle task according to the procedure of “Registration of the program.”

[In case of interrupt by an interrupt module or counter count-up]
2. The event task is made according to the procedure of “Make of the event task.”

3. Program made by processing 1 is arranged in the event task according to the procedure of “Registration of the program.”
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User macro commands

User macro commands instruction is not supported in SX-Programmer Standard. The alternative solution is explained.

1. 	The I/O parameter is set, and user macro commands caller program is converted into the call part of the FB instance.

2. 	The I/O parameter is set, and user macro commands executor program is converted into the body part of the FB instance.
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User macro commands Program Alternative
[User macro commands caller program is alternative into the call part of the FB instance]
<< FLEX-PC N >>

<< MICREX-SX >>
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<< MICREX-SX >>

[User macro commands executor program is alternative into the body part of the FB instance]
<< FLEX-PC N >>
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Comparison

"Comparison" instruction is not supported in SX-Programmer Standard. The alternative solution is explained.

1. 	New program(FB) is made, and the input parameter(origin of comparison, destination of comparison) I/O parameter 		
				(comparison result flag1, 2) is set.

2. 	When it is “origin of comparison > destination of comparison,” comparison result flag1 and comparison result flag2 are set in 	
				“OFF.”

3. 	When it is “origin of comparison = destination of comparison,” comparison result flag1 is set in "ON" and, comparison result 		
				flag2 is set in “OFF.”

4. 	When it is “origin of comparison < destination of comparison,” comparison result flag1 is set in "OFF" and, comparison result 	
				flag2 is set in “ON.”

The following figures show the relation between the above-mentioned comparison result flag 1, 2.

Big and small relation Comparison 
result flag1

Comparison 
result flag2

Origin of comparison > destination of comparison OFF OFF

Origin of comparison = destination of comparison ON OFF

Origin of comparison < destination of comparison OFF ON

Seizing signal

S1: Origin of comparison 

S2: Destination of comparison

<< FLEX-PC N >>
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<<Call processing when making to FB with SX-Programmer Standard>>
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Comparison Program Alternative
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Double Comparison

"Double Comparison" instruction is not supported in SX-Programmer Standard. The alternative solution is explained.

1. 	New program(FB) is made, and the input parameter (origin of comparison, destination of comparison) I/O parameter 		
				(comparison result flag1, 2) is set.

2. 	When it is “origin of comparison > destination of comparison,” comparison result flag1 and comparison result flag2 are set in 	
				“OFF.”

3. 	When it is “origin of comparison = destination of comparison,” comparison result flag1 is set in "ON" and, comparison result 		
				flag2 is set in “OFF.”

4. 	When it is "origin of comparison < destination of comparison,” comparison result flag1 is set in "OFF" and, comparison result 	
				flag2 is set in “ON.”

The following figures show the relation between the above-mentioned comparison result flag1, 2.

Big and small relation Comparison 
result flag1

Comparison 
result flag2

Origin of comparison > destination of comparison OFF OFF

Origin of comparison = destination of comparison ON OFF

Origin of comparison < destination of comparison OFF ON

<< FLEX-PC N >>

Seizing signal 

S1: Origin of comparison 

S2: Destination of comparison
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<<Call processing when making to FB with SX-Programmer Standard>>
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Double Comparison Program Alternative
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Range Comparison

"Range Comparison" instruction is not supported in SX-Programmer Standard. The alternative solution is explained.

1. 	New program(FB) is made, and the input parameter(origin of comparison1, 2, destination of comparison) I/O parameter 		
				(comparison result flag1, 2, 3) is set.

2. 	When it is “origin of comparison1 > destination of comparison,” comparison result flag1 is set in "ON" and, comparison result 	
				flag2, 3 is set in “OFF.”

3. 	When it is “origin of comparison 1 <= destination of comparison,” and “destination of comparison <= origin of comparison2,” 		
				comparison result flag2 is set in "ON" and, comparison result flag1, 3 is set in “OFF.”

4. 	When it is “destination of comparison > origin of comparison2,” comparison result flag3 is set in "ON" and, comparison result 	
				flag1, 2 is set in “OFF.”

The following figures show the relation between the above-mentioned comparison result flag1, 2, 3.

Big and small relation Comparison 
result flag 1

Comparison 
result flag 2

Comparison 
result flag 3

Origin of comparison1 > destination of comparison ON OFF OFF

Origin of comparison1 <= destination of comparison and
destination of comparison <= Origin of comparison2 OFF ON OFF

Destination of comparison > Origin of comparison2 OFF OFF ON

<< FLEX-PC N >>

Seizing signal 

S1: Origin of comparison1

S2: Origin of comparison2

S  : Destination of comparison
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<<Call processing when making to FB with SX-Programmer Standard>>
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Range Comparison Program Alternative
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Double Range Comparison

"Double Range Comparison" instruction is not supported in SX-Programmer Standard.
The alternative solution is explained.

1. 	New program(FB) is made, and the input parameter(origin of comparison1, 2, destination of comparison) I/O parameter 		
				(comparison result flag1, 2, 3) is set.

2. 	When it is “origin of comparison1 > destination of comparison,” comparison result flag1 is set in "ON" and, comparison result 	
				flag2, 3 is set in “OFF.”

3. 	When it is “origin of comparison1 <= destination of comparison,” and “destination of comparison <= origin of comparison2,” 		
				comparison result flag2 is set in "ON" and, comparison result flag1, 3 is set in OFF.”

4.	 When it is "destination of comparison > origin of comparison2", comparison result flag3 is set in "ON" and, comparison result 	
				flag1, 2 is set in “OFF.”

The following figures show the relation between the above-mentioned comparison result flag1, 2, 3.

Big and small relation Comparison 
result flag 1

Comparison 
result flag 2

Comparison 
result flag 3

Origin of comparison1 > destination of comparison ON OFF OFF

Origin of comparison1 <= destination of comparison and
destination of comparison <= Origin of comparison2 OFF ON OFF

Destination of comparison > Origin of comparison2 OFF OFF ON

<< FLEX-PC N >>

Seizing Signal

S1: Origin of comparison1 

S2: Origin of comparison2

S  : Destination of comparison
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<<Call processing when making to FB with SX-Programmer Standard>>
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Double Range Comparison Program Alternative
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8Bit Transfer

"8Bit Transfer" instruction is not supported in SX-Programmer Standard. The alternative solution is explained.

1. 	The logical product of the eight high-order bits or the eight low-order bits of origin of transfer is done.
				* This processing extracts the origin of transfer eight high-order bits or eight low-order bits.

2. 	After the logical product is done, shifts left or right by 8bits.

3. 	The logical product of the eight high-order bits or the eight low-order bits of destination of transfer is done.
				* This processing delete the destination of transfer eight high-order bits or eight low-order bits.

4. 	The logical add to data which did shift processing and destination of transfer is done.
				* This processing is origin of transfer high rank byte or the eight low-order bits is forwarded to destination of transfer the eight 	
						high-order bits or the eight low-order bits.
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8Bit Transfer Program Alternative
Example 1) When it is a origin of transfer is the eight high-order bits and destination of transfer is the eight 	
		              low-order bits
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8Bit Transfer Program Alternative
Example 2) When it is a origin of transfer is the eight low-order bits and destination of transfer is the eight 	
		              high-order bits
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8Bit Transfer Program Alternative
Example 3) When it is a origin of transfer is the eight high-order bits and destination of transfer is the eight 	
		              high-order bits
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8Bit Transfer Program Alternative
Example 4) When it is a origin of transfer is the eight low-order bits and destination of transfer is the eight 	
		              low-order bits
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Digit Transfer

"Digit Transfer" instruction is not supported in SX-Programmer Standard. The alternative solution is explained.

1. 	The logical product is done to digit of data which transfer a origin of transfer.
				*	This processing extracts necessary data from digit of the transfer data.

2. 	Right or left shifts to digit where data which did the logical product is transfer

3. 	The logical product is done to destination of transfer digit in the destination of transfer
				*	This processing delete destination of transfer digit.

4. 	The logical add to data which did shift processing and destination of transfer is done.
				*	This processing is forwarded to specified digit in the destination of transfer.
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Digit Transfer Program Alternative
Example 1) The first digit from the third digit transfer from origin of transfer to the first digit of the         	 	
                    destination of transfer
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Digit Transfer Program Alternative
Example 2) Two digits from the second digit transfer from origin of transfer to the fourth digit of the 		
		              destination of transfer
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Rotate Right Carry n

"Rotate Right Carry n" instruction is not supported in SX-Programmer Standard. The alternative solution is explained.

1. 	“Rotation data” is stored in “Temporary.”

2. 	The 0th bit of “Temporary” is stored in “Carry flag.”

3. 	“Temporary” is shifted right by 1 bit.

4. 	When “Carry flag” is “ON,” the 16th bit of “Temporary” is turned on.

5. 	When “Carry flag” is “OFF,” the 16th bit of “Temporary” is turned off.

6. 	Processing 2-5 is repeated the number of times of “No. of rotate bits.”

7. 	Data which did the shift processing is stored in “Rotation data” again.

<< FLEX-PC N >>

Conditional contact

D : Device in which data is to be rotated

n : A number of bits by which data is to be rotated



App.7-43

Appendix 7	 Alternative Proposal

<<Call processing when making to FB with SX-Programmer Standard>>

[Variable Explanation]
	DF000A: Temporary
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Rotate Right Carry n Program Alternative
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Rotate Left Carry n

"Rotate Left Carry n" instruction is not supported in SX-Programmer Standard. The alternative solution is explained.

1. 	“Rotation data” is stored in “Temporary.”

2. 	SLC instruction is done to “Temporary.”

3. 	The 16th bit of "Temporary" is stored in “Carry flag.”

4. 	Processing 2-3 is repeated the number of times of  “No. of rotate bits.”

5. 	Data which did the shift processing is stored in “Rotation data” again.

<<FLEX-PC N>>

Conditional contact

D : Device in which data is to be rotated

n : A number of bits by which data is to be rotated
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<<Call processing when making to FB with SX-Programmer Standard>>

[Variable Explanation]
	DM000A: Temporary
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Rotate Left Carry n Program Alternative
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Double Rotate Right Carry n

“Double Rotate Right Carry n” instruction is not supported in SX-Programmer Standard.
The alternative solution is explained.

1. 	“Rotation data” is stored in “Temporary1.”

2. 	SRC instruction is done to “Temporary1,” and it is output to “Temporary2.”

3. 	“Carry flag” of “Temporary1” is output.

4. 	“Temporary2” is stored in “Temporary1.”

5. 	Processing 2-4 is repeated the number of times of “No. of rotate bits.”

6. 	Data which did the shift processing is stored in “Rotation data” again.

<<FLEX-PC N>>

Conditional contact 

D : Device in which data is to be rotated

n : A number of bits by which data is to be rotated



App.7-49

Appendix 7	 Alternative Proposal

<<Call processing when making to FB with SX-Programmer Standard>>

[Variable Explanation]
	DF000A: Temporary
	DF000C: Temporary
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Double Rotate Right Carry n Program Alternative
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Double Rotate Left Carry n

"Double Rotate Left Carry n" instruction is not supported in SX-Programmer Standard. The alternative solution is explained.

1. 	“Rotation data” is stored in “Temporary1.”

2. 	SLC instruction is done to “Temporary1,” and it is output to “Temporary2.”

3. 	“Carry flag” of “Temporary1” is output.

4. 	“Temporary22 is stored in “Temporary1.”

5. 	Processing 2-4 is repeated the number of times of “No. of rotate bits.”

6. 	Data which did the shift processing is stored in “Rotation data” again.

<<FLEX-PC N>>

Conditional contact

D : Device in which data is to be rotated

n : A number of bits by which data is to be rotated
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<<Call processing when making to FB with SX-Programmer Standard>>

[Variable Explanation]
	DF000A: Temporary
	DF000C: Temporary
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Double Rotate Left Carry n Program Alternative
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Step Control

"Step Control" instruction is not supported in SX-Programmer Standard. The alternative solution is explained.

"Step Control" instruction is achieved by "S" device in SX-Programmer Standard.

The group number and the step number which wants to control are set to "S" device of the step control instruction.
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Step Control Program Alternative
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Real Comparison

"Real Comparison" instruction is not supported in SX-Programmer Standard. The alternative solution is explained.

1. 	New program(FB) is made, and the input parameter(origin of comparison, destination of comparison) I/O parameter 		
				(comparison result flag1,2) is set.

2. 	When it is “origin of comparison > destination of comparison,” comparison result flag1 and comparison result flag2 are set in 	
				“OFF.”

3. 	When it is “origin of comparison = destination of comparison,” comparison result flag1 is set in "ON" and, comparison result 		
				flag2 is set in “OFF.”

4. 	When it is “origin of comparison < destination of comparison,” comparison result flag1 is set in "OFF" and, comparison result 	
				flag2 is set in “ON.”

The following figures show the relation between the above-mentioned comparison result flag1, 2.

Big and small relation Comparison 
result flag1

Comparison 
result flag2

Origin of comparison > destination of comparison OFF OFF

Origin of comparison = destination of comparison ON OFF

Origin of comparison < destination of comparison OFF ON

<<FLEX-PC N>>

Seizing signal

S1 : Origin of comparison

S2 : Destination of comparison
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<<Call processing when making to FB with SX-Programmer Standard>>
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Real Comparison Program Alternative
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Real Range Comparison

“Real Range Comparison” instruction is not supported in SX-Programmer Standard. The alternative solution is explained.

1. 	New program(FB) is made, and the input parameter(origin of comparison1, 2, destination of comparison) I/O parameter 		
				(comparison result flag1, 2, 3) is set.

2. 	When it is “origin of comparison1 > destination of comparison,” comparison result flag1 is set in "ON" and, comparison result 	
				flag2, 3 is set in “OFF.”

3. 	When it is “origin of comparison1 <= destination of comparison,” and “destination of comparison <= origin of comparison2,” 		
				comparison result flag2 is set in "ON" and, comparison result flag1, 3 is set in “OFF.”

4.	 When it is “destination of comparison > origin of comparison2,” comparison result flag3 is set in "ON" and, comparison result 	
				flag1, 2 is set in OFF.”

The following figures show the relation between the above-mentioned comparison result flag1, 2.

Big and small relation Comparison 
result flag 1

Comparison 
result flag 2

Comparison 
result flag 3

Origin of comparison1 > destination of comparison ON OFF OFF

Origin of comparison1 <= destination of comparison and
destination of comparison <= Origin of comparison2 OFF ON OFF

Destination of comparison > Origin of comparison2 OFF OFF ON

<<FLEX-PC N>>

Seizing signal

S1 : Origin of comparison1

S2 : Origin of comparison2

S   : Destination of comparison
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<<Call processing when making to FB with SX-Programmer Standard>>
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Real Range Comparison Program Alternative
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Time Comparison

"Time Comparison" instruction is not supported in SX-Programmer Standard. The alternative solution is explained.

1. 	New program(FB) is made, and the input parameter(origin of comparison(Hour, Minute, Second), destination of comparison 	
				(Hour, Minute, Second)) I/O parameter(comparison result flag1, 2) is set.

2. 	When it is “origin of comparison(Hour) > destination of comparison(Hour),” comparison result flag1 and comparison result 		
				flag2 are set in “OFF.”

3. 	When it is “destination of comparison(Hour) > origin of comparison(Hour),” comparison result flag2 is set in "ON" and, 		
				comparison result flag1 is set in “OFF.”

4. 	It is set that result1 of the comparison between “origin of comparison(Minute)” and “destination of comparison(Minute)” at “origin 
				of comparison(Hour) = destination of comparison(Hour)” referring to processing1, 2. And it is set that result1 of the comparison 
				between “origin of comparison(Second)” and “destination of comparison(Second)” at “origin of comparison(Minute) = 		
				destination of comparison(Minute)" referring to processing1, 2. As a result, when it is "origin of comparison(Hour, Minute, 		
				Second) = destination of comparison(Hour, Minute, Second)", comparison result flag1 is made "ON", and comparison result 	
				flag2 is made “OFF.”

The following figures show the relation between the above-mentioned comparison result flag1, 2.

Big and small relation Comparison 
result flag1

Comparison 
result flag2

Origin of comparison > destination of comparison OFF OFF

Origin of comparison = destination of comparison ON OFF

Origin of comparison < destination of comparison OFF ON

<<FLEX-PC N>>

Seizing signal 

S1 : Origin of comparison (Hour)

S2 : Origin of comparison (Minute)

S3 : Origin of comparison (Second)

S   : Destination of comparison
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<<Call processing when making to FB with SX-Programmer Standard>>
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Time Comparison Program Alternative
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Time Range Comparison

“Time Range Comparison” instruction is not supported in SX-Programmer Standard. The alternative solution is explained.

1. 	New program(FB) is made, and the input parameter(origin of comparison1- 1, 2, 3(Hour, Minute, Second), origin of 		
				comparison2- 1, 2, 3(Hour, Minute, Second), destination of comparison(Hour, Minute, Second)) I/O parameter(comparison 		
				result flag1, 2, 3, 4) is set.

2. 	Comparison result flag1 is set in “OFF.”

3. 	Comparison result flag2 is set in “OFF.”

4. 	Comparison result flag3 is set in “OFF.”

5. 	Comparison result flag4 is set in “OFF.”

6. 	When it is “origin of comparison1- 1(Hour) > destination of comparison2- 1(Hour),” comparison result flag1 is set in “ON.”

7. 	When it is “origin of comparison1- 1(Hour) = origin of comparison2- 1(Hour)” and “origin of comparison1- 2(Minute) > origin of 	
				comparison2- 1(Minute),” comparison result flag1 is set in “ON.” And when it is "origin of comparison1- 2(Minute) = origin of
				comparison2- 2(Minute),” “origin of comparison1- 3(Second) > origin of comparison2- 3(Second)" is compared. When the 		
				result is “True,” comparison result flag1 is made “ON.”

8. 	When comparison result flag1 is “ON,” FB is ended.

9. 	When it is “origin of comparison1- 1(Hour) > destination of comparison(Hour),” comparison result flag2 is set in “ON.”

10.		When it is “origin of comparison1- 1(Hour) = destination of comparison(Hour)” and “origin of comparison1- 2(Minute) > 		
						destination of comparison(Minute),” comparison result flag1 is set in “ON.” And when it is “origin of comparison1- 2(Minute) 	
						= destination of comparison(Minute),” “origin of comparison1- 3(Second) > destination of comparison(Second)" is compared. 
						When the result is “True,” comparison result flag2 is made “ON.”

11. 	When comparison result flag2 is “ON,” FB is ended.

12. 	When it is “destination of comparison(Hour) > origin of comparison2- 1(Hour),” comparison result flag3 is set in “ON.”

13. 	When it is “destination of comparison(Hour) = origin of comparison2- 1(Hour)” and “destination of comparison(Minute) > 		
						origin of comparison2- 2(Minute),” comparison result flag3 is set in “ON”. And when it is “destination of comparison(Minute) 	
						= origin of comparison2- 2(Minute),” “destination of comparison(Second) > origin of comparison2- 3(Second)” is compared. 	
						When the result is “True”, comparison result flag3 is made “ON.”

14. 	When comparison result flag3 is “ON,” FB is ended.

15. 	Comparison result flag4 is set in “ON” * Comparison result flag1, 2, 3 becomes “OFF” it and “ origin of comparison1(Hour,
						Minute, Second) <= destination of comparison(Hour, Minute, Second) <= origin of comparison2(Hour, Minute, Second)” 		
						because of current processing.
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The following figures show the relation between the above-mentioned comparison result flag1, 2, 3, 4.

Big and small relation Comparison 
result flag1

Comparison 
result flag2

Comparison 
result flag3

Comparison 
result flag4

Origin of comparison1(Hour, Minute, Second) > origin
of comparison2(Hour, Minute, Second) ON OFF OFF OFF

Origin of comparison1(Hour, Minute, Second) >
destination of comparison(Hour, Minute, Second) OFF ON OFF OFF

Origin of comparison1(Hour, Minute, Second)
<=destination of comparison(Hour, Minute, Second)
<=origin of comparison2(Hour, Minute, Second)

OFF OFF ON OFF

destination of comparison (Hour, Minute, Second) >
origin of comparison2(Hour, Minute, Second) OFF OFF OFF ON

<<FLEX-PC N>>

Seizing signal

S1 : Origin of comparison1 (Hour, Minute, Second)

S2 : Origin of comparison2 (Hour, Minute, Second)

S   : Destination of comparison (Hour, Minute, Second)
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<<Call processing when making to FB with SX-Programmer Standard>>
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Time Range Comparison Program Alternative
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Some instructions which can not be pasted

When the connection and comparison instructions are included in a ladder line where the following instructions are included and 
for a parallel output, the instructions are not pasted.

•	Increment on Rising Edge (INCP)
•	Double Increment on Rising Edge (DINCP)
•	Decrement on Rising Edge (DECP)
•	Double Decrement on Rising Edge (DDECP)
•	Output rising differential (PLS)
•	Output falling differential (PLF)
•	Transfer Message (MSGT)
•	Receive Message (MSGR)
•	Stores a file (FFST)
•	First-in first-out control (FIFO)
•	First-in last-out control (FILO)
•	Pulse Train Output 1 (PLS1)
•	Double Pulse Train Output 1 (DPLS1)
•	Pulse Train Output 2 (PLS2)
•	Double Pulse Train Output 2 (DPLS2)
•	Pulse Width Modulation 1 (PWM1)
•	Pulse Width Modulation 2 (PWM2)

When it is possible to paste it, it replaces with the following instructions. Please edit the program referring to this.
Note:		The operation execution result might be different from the original Line's. So modify the pasted line referring to the original 	
									line.

FLEX-PC MICREX-SX

Increment on Rising Edge (INCP) Addition

Double Increment on Rising Edge (DINCP) Addition

Decrement on Rising Edge (DECP) Subtraction

Double Decrement on Rising Edge (DDECP) Subtraction

Output rising differential (PLS) Rising edge trigger

Output falling differential (PLF) Falling edge trigger

Transfer Message (MSGT) Send message

Receive Message (MSGR) Receive message

Stores a file (FFST) Sequential file store

First-in first-out control (FIFO) Sequential file load first

First-in last-out control (FILO) Sequential file load last

Pulse Train Output 1 (PLS1) Pulse output

Double Pulse Train Output 1 (DPLS1) Pulse output

Pulse Train Output 2 (PLS2) Pulse output

Double Pulse Train Output 2 (DPLS2) Pulse output

Pulse Width Modulation 1 (PWM1) Pulse output

Pulse Width Modulation 2 (PWM2) Pulse output
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Please refer to the following examples.

[Example of pasting the Increment on Rising Edge]

[FLEX-PC]

[MICREX-SX]

[Example of pasting the Output rising differential]

[FLEX-PC]

[MICREX-SX]
The case of using M000030 as a start signal.
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Instruction without alternative method (FLEX-PC)

There is not an alternative method of the following instructions.

•	HEX to ASCII (ASCI)
•	ASCII to HEX (HEX)
•	Convert to Secs (SEC)
•	Convert to HMS (HMS)
•	Option Init (OPDF)
•	Data instruction (DATAB, DATAM)
•	Status set/reset (SLT, SLTR)
•	Trace set/reset (STRA, STRAR)
•	Real Bin to Decimal (EBCD)
•	Real Decimal to Bin (EBIN)
•	Read Time/Write Time (TRD, TWR)
•	Pulse Train Output I (PLSI, DPLSI)
•	Pulse Train Output A (PLSA, DPLSA)
•	Zero Return (ORG, DORG)
•	Ramp Output (RAMP)
•	PID Calculation (PID)
•	Manipulates the bit data (ABSD, INCD)
•	Matrix Read (MTR)
•	Digital Switch (DSW)
•	7 Segment Displays (SEGL)
•	SFC instructions
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In the “Project View” window, the entire SX project is structured and displayed.
This section explains each item displayed in the Project View window.

Project:		
			This is the parent folder of a project. The name of a currently opened project is displayed.
System Definition:
			When you click this, the system definition screen opens. For more details, refer to “Section 3 System Definition.”
Resource:
			The is the CPU module. When you right-click this, you can make settings about conversion. For more details, refer to “Appendix 
			8-1 Resource.”
Programs: 
			This is the parent folder of programs. Register tasks directly under this folder.
Default:
			This is the folder for the default task. Programs assigned under this folder (ladder0 in the above figure) are cyclically executed.
Fixed:
			This is the folder for the periodic task. Programs assigned under this folder are executed at a specified period. Right-click this 	
			and then select “Properties” to set the cycle and priority.
Event:
			This is the folder for the event task. Programs assigned under this folder are executed at the rising edge of the specified event 	
			address. Right-click this and then select “Properties” to set the event address and priority.
Device:
			You can open the list of devices, on which tags, description, initial values can be edited and use status of the devices can be 	
			listed. For more details, refer to “Appendix 8-2 Device.”
Unassigned Programs:
			Programs assigned here are invalid and not loaded to the PLC.
Function Blocks:
			Function blocks (FB) created by a user are registered here. You can also import and register expansion FBs provided by Fuji 	
			Electric. When converting a MICREX-F program, the loader system automatically registers FBs for conversion.
Simulation:
			This folder is used for the simulation function. For more details, refer to “Appendix 3 Simulator Function.”
Array/Struct:
			Arrays and structures are defined. For more details, refer to “Appendix 4 Arrays/Structures.”
File Defines:
			Used in pairs with a file instruction (incl. FFST_MF, FIFO_MF, and FILO_MF). If a file instruction is included in a MICREX-F 		
			program that is converted, they are automatically defined.
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Appendix 8-1	 Resource
Right-click the Resource icon to open the “Resource Properties” or “Optimization setting” dialog box.

(1) 	Property
When converting a MICREX-F program, the optimum settings are made automatically on the “Resource Properties” dialog box. 
The “Resource Properties” dialog box is only supported by SPH2000/SPH3000 series. (Not usable in SPH200/SPH300 series.)

•	Permit the use of index register a Check this option to use index register instructions.
•	Bit reverse a Specify the bit operation when the pointer of an index register is added or subtracted.

						When checked:	The same bit operation as MICREX-F. In the case of index register addition, the offset address is moved to 	
																						  the right (to the low-order).
						When unchecked:	The same bit operation as MICREX-SX. In the case of index register subtraction, the offset address is 		
																							   moved to the left (to the hight-order).

•	Permit the use of Timer/Counter MF a Check this option to use timer and counter instructions suffixed with “_MF.” The 		
		operation of these instructions is same as MICREX-F. 11072 (approx. 11K) words of the user FB memory is used.
•	Permit the use of temporary area and save area for task switch a This option is automatically checked when a MICREX-F 		
		program is converted. The temporary area is reserved to make the program operation same as MICREX-F.
•	Step control treated as a BCD value a Check this option to treat data as BCD when the step control memory is used as a 		
		word (WS). When unchecked, data is treated as decimal.



App.8-3

Appendix 8	 Project View

(2)	 Optimization setting
The “Optimization setting” dialog box is only supported by SPH3000 series.
SPH3000 is provided with two types of POU execution areas (high-speed/default). You can choose an area to which each POU 
is assigned. Programs assigned to the high-speed area are executed faster than those assigned to the default area. In addition, 
if you select “Valid,” the program code is optimized to enable faster program execution.
The default setting is “Invalid.” In this case, program optimization is not performed. Programs are automatically assigned to the 
high-speed program area in order from the top.
When you change this setting, you need to execute [Conversion] > [Conversion All] to load the program to the PLC. (Stop the 
PLC and transfer the program.)
It is not possible to optimize programs that have instructions suffixed with “_MF” (incl. TON_MF and MOVE_MF) that are 
automatically used for conversion of a MICREX-F program. Select “Invalid” for such programs.

How to make optimization settings
�� Right-click the Resource icon, and then select [Optimize]. The following dialog box opens. 

				Select an “Optimize Option.”

•	Valid a All the programs (including function blocks) are optimized.
•	Individual a You can select which program to optimize.
•	Invalid: (default) a None of the programs (including function blocks) are optimized.

When you select “Valid” or “Individual” for optimize option, the execution time of the “Conversion All” command is three to ten 
times longer than when “Invalid” is selected. The warning message appears on the loader screen.
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�� Click the [Setting] button. The “Option setting” dialog box opens.

Calling structure of programs 
and FBs is displayed.

Select “Valid” or “Invalid”
of optimization.

Select an area to assign the program:
“High-speed” or “Default”  (See *1 and *2.)

*1		To change these settings, uncheck “The placement of all POU are automatic setting” in the [Setting] menu. It is checked by 	
					default.
*2		The program is automatically assigned to the high-speed area within the range of the memory size. If there is not enough 		
					memory size, the program is assigned to the default area.

�� On the dialog box above, you can choose “Valid” or “Invalid” for optimization and “High-speed” or “Default” area for placement 
				for each program.
				After setting each item, click [File] menu > [Exit] to return to the “Optimization setting” dialog box. Click the [OK] button there. 	
				The following dialog box appears.

Click the [OK] button to complete the setting.
Make sure to execute [Conversion All] in the [Conversion] menu before loading the program to the PLC. Stop the PLC to load 
the program to it. (A program cannot be changed while the PLC is running.)
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Appendix 8-2	 Device
Double-click the Device icon to open the device window. Tags and descriptions edited on this window are reflected in the ladder 
circuit. Devices displayed here are common devices of the programs in a project and called “global device.” They are used to 
edit the tags in a batch.
You cannot check the ON/OFF status of the devices on this window. To check it, use the monitoring function; click [Online] menu 
> [Data Monitor] > [Data Monitor 1].

[Device Type] selection button

[Use status display]

[Filter] button

[Update] button

[Use map] button

<Character limit on a tag>
A tag can be up to 32 characters. The following symbols and character strings cannot be used: 
		Symbols “#,” “\” (backslash), “,” (comma), and “.” (period) 
		A character string consisting only of numerical values (including  a decimal number, a hexadecimal number, and a number 		
		starting with a plus (+) or minus (-) sign
		The same character string as the device address
		The same character string as the array expression (e.g. DATA[1])

<Character limit on description>
A description can be up to 50 characters. A comma (,) cannot be used.

•	[Device Type] selection button a This button is used to switch the displayed devices.
						X, WX, DX: Input memory
						Y, WY, DY: Output memory
						M, WM, DM: Internal memory (non retained)
						L, WL, DL: Internal memory (retain)
						SM, WSM, DSM: System memory
						T: 	Timer
										The target are TON, TOF, TP and MR. The range is T8192 to T16383.
						C:	Counter
										The target are CTU, CTD, and RCT. The range is C8192 to C16383.
						TR: Integrating timer
											 The target is TMR.
						N:	Section instruction
						S, WS: Step control
						GM: Global memory
												 	The target are the processor-link memory of P-link, PE-link, or FL-net.
						TM: 	MF timer
													The target are the timer instructions with the suffix “_MF.”
						CT:		MF counter
												The target are the counter instructions with the suffix “_MF.”
						RI/RJ/RK, WRI/WRJ/WRK, DRI/DRJ/DRK: Index register (excluding timer and counter)
						RL/RM:	 Index resister (dedicated to timer and counter)
						WFL, DFL: File memory
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<Selecting device address>
The device screen shows 2038 lines from the top of the selected device by default.
To display the lines after them, click the “Next page” button on the bottom right.

[Next page] button[Previous page] button

The [Search] function is also available.
For example, when you want to display “M3000,” place the cursor on the device window and press the <Ctrl> + <F> keys. The “Find 
Tag” dialog box appears. Enter “M3000,” and then click the [Find] button. The device window shows 2048 lines, in the middle of 
which is “M3000.”
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<Local device of program>
Right-click on a program in the project view and select [Device]. The device screen opens. The devices shown there are valid 
only in the selected program (Ladder0 in the example below) and called “local device.”
The local device includes T (timer), TR (integrating timer) and C (counter) and the target address is as follows.
			T0 to T8191, TR0 to TR8191, C0 to C8191
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<Local device of user FB>
Right-click on an FB in the project view and select [Device]. The device screen opens. The devices shown there are valid only in 
the selected program (FB0 in the example below) and called “local device.”
The local device includes T, TR and C, as in that of a program, and F/WF/DF (user FB memory) and V/WV/DV (I/O parameter).
For F/WF/DF and V/WV/DV, only the defined memories are displayed.
WF can be retained during a power failure by checking the box of “Retain.”
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•	[Filter] button a This button opens the “Filter” dialog box. You can filter the devices displayed on the device window. Multiple 	
		filter conditions can be specified.

				Perform filter setting for each device type. The following screen shows filter setting of M device.

Use: If “in use” is checked, only the devices used in the program are displayed. If “not in use” is checked, only the unused 		
							devices are displayed.
Tag: 	If “has tag” is checked, only the devices that have tags in the program are displayed. By entering characters in the “Tag” 		
							box, only the tags that contain the entered characters can be displayed. By using “*”,  the devices that partially match the 		
							entered characters can be displayed.
							Example)  If you enter “Mem*”, the tags starting with “Mem” are displayed.
							If “no tag” is checked, only the devices without tags are displayed.
Initial value:		If “has an initial value” is checked, only the devices in which an initial value is set in the program are displayed. If “no 
																		initial value” is checked, only the devices without initial value setting are displayed.
Address range: You can specify the address range to be displayed.
Ignore IO config: If this option is checked, only the I/O devices that have tags are displayed.

•	[Update] button a This button updates the contents of the device screen.
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•	[Use map] button a When you select a device on the device screen and click this button, the use status of the selected 		
		device is shown in map form. The bit addresses used in the program are colored. “W” in the word column indicates that the 		
		device is used as word in the program.

•	[Use status display] a When the selected device is used in the program,
							For bit device: a symbol of a contact or coil is shown.
							For word/double-word device: “*” is shown.
				If the devices is also used as another bit length, “!” is shown.

In the screen above, symbols of a contact and a coil are shown for M20, which indicates that M20 is used as a contact and a coil 
in the program.
“!” is also shown, which indicates that M20 is also used as another bit length (WM2 or DM2).



App.8-11

Appendix 8	 Project View

Appendix 8-3	 Unassigned Programs
When you delete a program folder in the project view, it is moved into the “Unassigned Programs” folder. The programs assigned 
in the “Unassigned Programs” folder are not loaded to the PLC.

<Example of an unassigned program>

Select “Ladder2” and click the <Del> key to delete it.

“Ladder2” has moved into “Unassigned Programs.”
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Appendix 8-4	 Function Blocks
“Function Blocks” is a folder to which user FBs (function blocks) are assigned. When expansion FBs provided by Fuji Electric 
are imported, they are assigned here.
For more details of how to create a user FB, refer to the user’s manual Introduction (FEH597) “4-2 User FB.”

Appendix 8-5	 Simulation
“Simulation” is a folder used to create a simulation panel.
For more details, refer to “Appendix 3 Simulator Function.”

Appendix 8-6	 Array/Structure
“Array/Struct” is a folder used for the array/structure function.
For more details, refer to “Appendix 4 Arrays/Structures.”

Appendix 8-7	 File Defines
“File Defines” is automatically created when a MICREX-F program that contains a file instruction or a table instruction is 
converted.



App.9-1

Appendix 9	 USB Driver Installation

To connect a CPU module with a built-in USB port and a computer using a USB cable, you need to install the USB driver for 
MICREX-SX in the computer. You can install the USB driver either offline (without connecting the computer to the PLC) or online 
(by connecting the computer to the PLC).

Appendix 9-1	 Offline Installation
This function is supported by Standard loader V3.0.10.19 or later versions and Windows Vista or later operating systems. For 
older versions of Standard loader and Windows XP or earlier operating systems, follow the procedure explained in “Appendix 
9-2 Online Installations.”

�� Click [Start] of Windows > [All Programs] > [SX-Programmer Standard V3] > [Tools] > [USB Driver For MICREX-SX].
				The following dialog box opens. Click the [Next] button.



App.9-2

Appendix 9	 USB Driver Installation

�� A message appears saying “The drivers are now installing.” If the screen saying “Windows can’t verify the publisher of this 		
				driver software” appears, click “Install this driver software anyway.”

�� The screen appears saying “Would you like to install this driver software?” Check [Always trust software from “Fuji Electric 		
				Co., Ltd.”], and then click the [Install] button.
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Appendix 9	 USB Driver Installation

�� The screen appears saying “Completing the Device Driver Installation Wizard.” Click the [Finish] button. The offline installation 
				is now complete. 

The actual setup of the driver in the computer is executed when connecting the PLC to the computer using a USB cable. The 
progress of the setup is displayed on the bottom right of the computer screen.

In the Device Manager, the installed driver software is shown as “MICREX-SX” under “Loader USB device” as shown below.
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Appendix 9	 USB Driver Installation

Appendix 9-2	 Online Installation
Connect the computer to the PLC using a USB cable. A message saying “Installing device driver software” appears on the 
bottom right of the computer screen. The Windows standard USB driver is installed in this step, therefore, a message saying 
“Device driver software was not successfully installed” appears next. Perform overwrite installation of the USB driver following 
the procedure below.

�� Click [Start] of Windows > [Control Panel]. Select “Large icons” for View by,” and then click “Device Manager” from the list.
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Appendix 9	 USB Driver Installation

�� On the “Device Manager” screen, right-click “Unknown device,” and then select “Update Driver Software.”

�� On the following screen, click “Browse my computer for driver software.”



App.9-6

Appendix 9	 USB Driver Installation

�� On the following screen, click the [Browse] button to specify the location of the USB driver. The USB driver is located in the 		
				folder where Standard loader is installed. The default folder where Standard loader is installed differs depending on the 		
				computer.
							32-bit computer
										C:\Program Files\Fuji Electric\SX-Programmer Standard\Driver\MICREXSX
							64-bit computer
										C:\Program Files(86)\Fuji Electric\SX-Programmer Standard\Driver\MICREXSX
				After specifying the folder, click the [Next] button.



App.9-7

Appendix 9	 USB Driver Installation

�� A message appears saying “Installing driver software.” If the screen saying “Windows can’t verify the publisher of this driver 		
				software” appears, click “Install this driver software anyway.”

�� The screen appears saying “Would you like to install this driver software?” Check [Always trust software from “Fuji Electric 		
				Co., Ltd.”], and then click the [Install] button.
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Appendix 9	 USB Driver Installation

�� The message appears saying “Windows has successfully updated your driver software.” Click the [Close] button. The online 	
					installation is now complete. 

In the Device Manager, the installed driver software is shown as “MICREX-SX” under “Loader USB device” as shown below.
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Appendix 9	 USB Driver Installation

Appendix 9-3	 When USB Communication Fails
If USB communication fails although the USB driver has been successfully installed, perform the following steps.

(1)	 Check the status of the PLC
Connectors (IN and OUT) for SX bus expansion are provided on the left end of a PLC base board. Make sure to connect SX 
bus terminating plugs there. Without them, the loader communication may not be performed normally. In the case of an SX bus 
expansion system, connect terminating plugs at both ends of the SX bus after connecting an SX bus expansion cable. 
In the case of a single CPU system, set the CPU No. selection key switch at “0.”

CPU No. selection key switch

SX bus terminating plug

(2)	 Check the status of the computer
If communication cannot be established even after the step (1) is performed, restart the computer. 
If still not established, try to use another USB port of the computer.
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